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CAMMaster Release Notes 

This document covers CAMMaster, CAMMaster Designer and CAMMaste64. Not all new features are available 

in CAMMaster Designer. 

New Features 

11.22.21 

• Gerber Export of Non-standard Apertures 

They are now exported in different formats, depending on whether Gerber Extended V1 or V2 is selected 

in the Options dialog. If V1 opetion is selected only aperture macro (AM) features that existed in V1 are 

used. 

11.22.16 

• More Efficient Export of Rounded Rectangle D Codes in Gerber 

• Import ODB++ 

Added fonts: “simplex” and “datecode”. Dynamic text $WW (week number) and $YY (year). 

11.22.12 

• Components Text Rendering for Rotated/Mirrored Components 

New option added to show text horizontally regardless of component rotation or mirroring. “Compo-

nents > Show Text Horizontally“. 

11.22.10 

• D Codes Table – Rounding Values 

Additional rounding option added. 

• Macro > Run 

Replaced shortcut F11 with Ctrl+F11 to prevent users pressing F11 accidentally when trying to press F10. 

11.22.1 

• Rotated D Codes 

D Codes can now be rotated. 

The Setup D Codes dialog now shows an “Angle” that can be set. 
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You can set this angle by double clicking on the cell, or selecting any number of D Codes and doing “Op-

erations > Rotate”. 

 
 

When saving a .bin file, rotated D Codes are converted to custom (M) shapes, to make the output back-

ward compatible with previous versions of the CAM software. When opening these files in the current 

version, the customs will be converted to rotated built-in shapes. 

One can also convert selected rotated D Codes to custom (M). 
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• New built-in D Code Shape 

“Bullet“ (single character designator “L”). Also known as hal-obround. Same as the obround shape (O), 

but with only one rounded end (to the right). Other orientations can be achieved using the “Angle” fea-

ture (see above). 

 

 

• Select by Range of Values 

“Select > Special > Pads in Size Range“ and “Select > Special > Area Range” 

Selects elements with size values in a range of two values. 

11.20.29 

• Insert Rotated Rectangle 

“Insert > Rectangle“. 

If Shift is pressed when picking the first corner, the user will be asked to click on 2 more corners. These 

will define a possibly rotated rectangle. 

• Consolidate Scratch Holes 

“Edit > Paint And Scratch > Scratch Holes To Polygons“. 

In many cases, when data comes from Gerber files, holes in plane surfaces are represented as scratch pol-

ygons. This result in groups of paint and scratch data, 

This new command tries to consolidate the holes as part of the polygons thus eliminating scratch ele-

ments. 
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11.20.25 

• DFM Hole Spacing 

The drill violations check now has rules for checking edge to edge spacing between drill holes. 

• DFM > Save XML Report 

Save an XML file with the violations found in the last operation. 

11.20.19 

• Setup > Save Parameters to File 

Saves the parameter values of some of the commands. These can be restored later from the saved file. 

A preliminary set of parameters are now saved. More will be added later. 

• View > Selection > D Codes 

In visible layers only. 

• Select Drill Holes and Routing Paths 

“Select > Drill And Rout”. Use this to select elements of chosen tool numbers in a set of layers. 

The command works on visible layers only. So, to restrict selection to certain layers turn off the others. 

Tools numbers can be picked from the dialog that is displayed. 

• Option to Control Info to Clipboard 

“Setup > Preferences > Info To Clipboard When Selecting”. 

• Last Used Option for Transcode D Code Dialog 

Allows quick usage for the last D Code used for transcoding. 

• Added Centroid Info 

“Components > Save Centroid File” also saves the width and height of the component (non-rotated). 

11.20.16 

• Extra Info When Selecting a Pad or Polygon 

When selecting just one pad or one polygon, the following info is saved in the Windows clipboard: 

width, height, perimeter, area. 

This can then be pasted into a text document. 

• Import ODB++ 

Better handling of complex jobs. 

• Connector Arcs for Routing Paths 

The setting was global for all routing paths. Now changed to be specific for individual routing paths. Ap-

plies to compensated paths only. 

11.20.10 

• New Layer Visibility Action 

For the layers toolbar. The new action is Ctrl+Shift+Double-click. This will make visible ONLY the range 

of layers between the previous active layer and the layer double-clicked. 

This is in addition to the previously available actions: 
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- Double-click: toggle visibility of current layer 

- Shift+Double-click: make visible range 

- Ctrl+Double-click: turn range visibility off 

• Optional Tolerance Text 

In “Insert > Loc and Dim Setup”. If tolerance text is entered it will be added to the dimension text. 

• Concentric Pocket Routing 

An option has been added to “Tools > Routing > Pocket Routing to allow concentric routing with a single 

path, starting from the center of the shape and going outward. 

• Selecting SMD Components 

“Components > Select SMD Components” will select components from CMU or CML layers that appear 

to be SMD components, by checking against corresponding paste, mask and drill layers. 

If a paste layer is present, components with matching paste pads are considered SMD. 

If a paster layer is not present, the mask layer will be considered. Components will be considered SMD if 

paste pads correspond but no plated through holes (holes of type VIA will be ignored). 

11.20.7 

• Boolean Operations on Layers 

“Edit > Layer Boolean Ops”, This will execute a Boolean operation (OR, AND or MINUS) on two layers. 

The result will replace the first layer. The resulting elements will be polygons. 

• Insert Barcode 

“Insert > Text” now has a number of barcode “fonts”. Their name includes (Barcode). 

The only relevant items for inserting a barcode are “Height” and “Aspect Ratio”. For barcode types that 

are square (like QRCode), “Aspect Ratio” will be ignored and “Height” will be the size of the generated 

barcode. For the others height will be given by “Height” and width by “Aspect Ratio” X “Height”. 

• New Clipping Operation 

“Edit > Break Using Line”. Similar to “Break Traces and Clip Polygons”, but uses a line segment to break 

instead of a frame. For polygons, the line segment needs to completely cross the polygon (cannot start 

from inside the polygon). 

11.20.4 

• Layer Organizer 

Now supports up to 24 layers, 

• Select Text Based on Content 

“Select > Special > Text”. This will select all text blocks that match the regular expression you enter. 

It uses regex, which is a bit more complicated than regular text, but allows for flexible searches. 

You will need to lean just a few patterns. For instance: 

- ABC will match all the text blocks that are exactly ABC 

- ABC.* will match all text blocks that start with ABC. The dot character in regex matches any character 

and star means one or more. 

- .*ABC.* will match all text blocks that contain ABC anywhere. 

Be careful when you want to match an actual dot or star or any other character that has meaning to regex. 

In cases like these you need to escape the character with a backslash. 

For instance ABC\. will match all blocks that are exactly “ABC.”. 
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There are many regex tutorial on the web, 

• Clip One Layer by Another 

“Edit > Region Clipping”. Elements in the first layer will be clipped by elements in the second layer. 

The result in the first layer will be the clipped data as polygons. Elements that do not intersect the second 

layer will be deleted. 

 

 

• Tombstone DFM 

“DFM > Tombstone Violations”. The concept of tombstone violations is described here: 

https://www.eurocircuits.com/pcb-assembly-guidelines-tombstoning/. 

Note that these will only be found if the job has component layers (CMU/CML). 

These are usually imported from ODB++, IPC-2581 or Gerber X3. One can also generate then manually in 

the CAM software. 

When the silkscreen option is also selected, components that have silkscreen under them will also be 

flagged as violations. 

• Time Added to Rout Length Statistics 

“Tools > Routing > Length Statistics”. In addition to the length, the time to rout the length is also shown. 

This applies only to tools that have the “Table Feed” parameter non-zero in the Tools Setup dialog. 

• Routing Plunge Point 

New command “Tools > Routing > Set Plunge At Mid Edge”. Adds the plunge point at the middle of the 

edge (segment) close to the click. 

11.20.1 

• Import IPC-2581 

Files in IPC-2581 format can now be imported. 

• Reset All Routing Path Precedences 

“Tools > Routing > Precedences”. Sets all precedences for the selected routing paths to “don’t care”. Use-

ful before sorting the routing paths for export if existing precedence should be disregarded. 

11.18.52 

• Zoom on Selection 

“View > Zoom > On Selection” or “Ctrl + Shift + Home”. 
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• Double Hits DFM 

Drill DFM now has a double hits check for finding duplicate drills with the same tool at the same posi-

tion. 

11.18.51 

• Support for Gerber Job Files (.gbrjob) 

Gerber job files contain info a set of Gerber files that constitute a job. The main info is the mapping of file 

names to layer numbers. 

If a .gbrjob file is present, one should import (or open) that file. The corresponding Gerber files will then 

be loaded. 

Gerber job files can also be exported. For this you need to pick the “Layer by layer” mode and X2 as the 

Gerber dialect (in Options). 

11.18.49 

• Enforce Min Spacing for Mask/Paste Pads 

“Tools > Soldermask/paste > Enforce Min Spacing”.  Select a group of pads for a component and specify 

the min desired spacing between pads. If the spacing is less, it will be corrected with scratch elements. 

This can be applied to pads on any layer, but is most useful for paste layers. 

  

11.18.46 

• New Component Operations 

“Component > Select”. Can select/deselect CAM components and pads with component info. 

“Component > Add Component Info to Pads” can be used to add component info from component layers 

(CMU and CML) to the corresponding layers with pads: copper, soldermask and solderpaste (CPU/CPL, 

SMU/SML, SPU/SPL). Only visible layers will be processed. 

• Support for Gerber X2 Component Info 

Support for “TO.C” (reference designator) and “TO.P” (pin name)”. 

• Shortcut for “Go > Center of Selection” 

Ctrl+Shift+K. 

• “Go > Coordinates” improvement 

One can now type arithmetic operation in the X and Y boxes. For instance: “10.2+0.25” or “230.1 / 1.25”. 

Only two terms allowed an no units in this case. 

• Ratio Validation 

“Tools > Validate Ratios”. Useful for stencil and paste layers. Works on current layer by selecting pads or 

polygons that satisfy the requested rule. 
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Computation of ratio is based on thickness and the bounding box of each element. 

If dim is the dimension of the bounding box the formulas are: 

Aspect ration = (smallest of dim.x and dim.y) / thickness 

Area ratio = (dim.x * dim.y) / (2 * (dim.x+dim.y) * thickness) 

11.18.44 

• Converting Pad Patterns to Components 

The “Components” menu has new items: “Convert Footprints to Components”, “Change Reference Des-

ignator Tool” and “Change Orientation Tool”. 

To see how to use this feature read the document “Convert Pads to Components.pdf” included in the 

“Documents” folder of the installation. 

11.18.40 

• Changing Date in Text 

“Edit > Edit Selection > Text > Change Date”. 

This applies to selected text blocks that contain a date. The new operation allows changing the date to the 

current date (today). 

The date needs to contain year, month and day, but the order is arbitrary. 

The user is prompted with the format: “YYYY-MM-DD”. The string can be changed if the order in the 

text does not match. For instance one could input “DD-MM-YYYY”. 

Note that the separator (“-“, in this case) does not need to be the same in the text, but the new replace-

ment date will use it. 

For instance: “YYYY-MM-DD” will match “2021-03-02” or “2021 03 02” or “2021:03:02”. Any separator as 

long as it is the same. However, the replacement date will use “-“. 
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• Insert > Chamfer 

Reverted to previous behavior where traces that are not really part of the chamfer can be moved. 

• Import Gerber Autoconvert C to N 

This was previously the default for DRI layers or when importing files with the “.dri” extension. 

Not this feature can be turned on or off: 

 

 

11.18.37 

• New Delete Vertex Operation 

“Edit > Edit Traces > Delete Vertex”. A tool to delete the vertex common to two straight traces. Clicking 

on the vertex deletes the two traces and replaces them with a spanning trace (endpoints equal to the other 

endpoints of the removed traces). 

11.18.36 

• Improved Display of Selected D Codes and Tool Codes 

“View > Selection > D Codes” and “View > Selection > NC Tools“ now includes a count of elements also. 

• Edit Custom Font 

Read the document “Font Editing.pdf” in the installation folder. 

11.18.31 

• New Shave Pads Command 

“Edit > Shave Pads > Shave Pads vs Trace”. Select a trace and any number of pads next to it. 

This new command will shave the pads to insure the desired gap. 

Before: 



©PentaLogix, Inc., 1985-2023.  All rights reserved Page 10 of 135 

 
 

After: 

 

11.18.28 

• “Select > Connected” 

Added “add” (Shift key) and “remove” (Ctrl key) modes. 

11.18.26 

• New Functionality in “Go > Coordinates” 

Several new buttons have been added. 
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The “Paste” button will paste the text currently in the Windows clipboard into the X/Y fields. 

This is useful mostly for copying a pair of coordinates, for instance from an Excel spreadsheet. The pair 

should be separated by spaces. The two items will be pasted into to X and Y fields. 

The “Origin” buttons will move the cursor to the absolute origin (0,0) or relative origin (if set). 

• Improved Display of “Elements Overlapping Crosshair” 

11.18.20 

• Mirror X Option for Print 

Useful for printing images for the bottom side of a board. 

11.18.19 

• Elements Overlapping Cursor 

The dialog showing info on the elements that overlap the cursor now show more detailed information. 

• Import GDS-TXT 

Now allows for several files to be imported in one operation. 

• Pin 1 Display Options for Components 

“Components > Pin 1 Rendering”. Has 3 options: Text, Filled, None. Previous way of rendering was 

None. 

Examples are shown below for the 3 modes: 
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11.18.12 

• Select Invalid Polygons 

“Select > Special > Invalid Polygons”. Selects polygons that are not valid according to the Gerber or ODB 

standard (are self-intersecting). 

• Replicate To More Than One Layer 

“Edit > Edit Selection > Replicate” now allows selecting more than one layer to replicate to. This is possi-

ble only if the selection to replicate is in one layer only. 

• Stencils Can Be Generated for Rotated Components As Well 

 

• Netlist Computation Improvements 

Phase nets computation (for Emma testers) has been improved. 

• Footprint Polygons from Component Data 

“Components > Generate Footprint Layers”: if component layers are present (CMU, CML), usually from 

ODB++ data, one can generate polygons for the footprints (pins) in new layers. 

• New Method to Find Component Footprints. 

“Components > Find Similar Footprints”. 

One first needs to selects the pads belonging to a component. Then use the above command. Similar ar-

rangements of pads in the same layer will be selected. 

Note that this works for any pattern of pads, they don’t need to belong to a component. 

An example: Select the pads as shown below from the soldermask layer: 
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After the executing the command, the screen will show: 

 

 
 

12 additional such patterns have been found. 

The silkscreen layer need not be present. Only shown for illustrative purposes. 

11.18.10 

• 3D Board Viewer 

Added menu item to select layers to display. 
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• HomeBase Stencil 

Can now process rotated rectangle pairs. 

11.18.7 

• Select Off Center Pads 

“Select > Special > “Off Center Pads in Two Layers”. Selects pads in two chosen layers. A pad will be se-

lected if it overlaps a pad in the other layer, but has a different center. 

11.18.3 

• 3D Viewer Renders Paste Layers Also 

Layers of types SPU/SPL are also rendered. In addition, only visible layers are rendered, so one can 

choose what is rendered in 3D. 

A new version of the 3D viewer is also needed. 

Download from here: 

http://downloads.pentalogix.com/3DBoardViewer64_Setup.zip 

• Pocket Routing Generates One Path Only 

“Tools > Routing > Pocket Routing” will now generate only one continuous path. 

• Select Pads with Plated Holes 

“Select > Special > Pads With Plated Holes” will select pads in a copper layer that have corresponding 

plated drill holes in the drill layers in the current job. 

11.18.1 

• Import and Export Gerber Components 

Support for the new Gerber components format (called Gerber X3) has been added. 

To export component layers (of type CMU and CML) one needs to pick “X2” as the format from the Op-

tions dialog. 

11.16.73 

• Changing Shapes of D Codes in Different Orientation 

There is a new command in the D Codes Setup dialog that selects all D Codes of the same shape inde-

pendent of orientation. 

 
This can be used to select all D Codes that have the same shape type and dimensions, independent of ori-

entation. 

One common use case is the following. 

Assume you have pads as shown below: 
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and you want to convert the rectangles to obrounds. 

In the Setup dialog you can use the above command to select the two D Codes (or even select them manu-

ally. Then press “O” for Obround. When the dimensions dialog comes up click OK, although you could 

also change the dimensions if you wanted. 

The result will be: 

 

• 3D Viewer Supports Blind Vias 

Previous version ignored blind vias and they did not appear in the 3D view. A new version of the 3D 

Viewer executable is also needed (V3.0 or higher). 

• Export to Zip File 

When several files are exported, an option has been added to export them as a zipped file. 

 

• Export ODB++ 

New options for exporting N shape pads (holes). The options for ODB symbol are “hole” and “round”. 

“round” should be picked when exporting for software that canoe process “hole”. 
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11.16.66 

• Several Files In Open Dialog 

One can now pick more than one file in the “File > Open” dialog. Of course, this is mostly useful for im-

port, not for open. One should open only one .bin file. 

• Improved Phase Net Data 

For Contour netlist extract. The generation of phase test data has been improved. 

11.16.63 

• Larger D Code Numbers Allowed 

Largest legal D Code number has been changed to 99,999. Previous value was 9,999. 

11.16.61 

• Expand or Contract a Closed Loop of Traces 

“Edit > Edit Selection > Special > Expand Closed Trace Contour” 

The selection should contain a closed loop of traces of the same D Code. 

This command will expand or contract this loop, similar to a polygon swell operation, but without the 

need to convert to a polygon and back. 

Useful for changing board boundaries and other boundaries. 

11.16.53 

• File Import Dialogs are Now Resizable 

• Import DXF Splines 

Splines are now approximated with straight segments. However, the rendering may not match exactly 

the one seen in AutoCad in all cases. 

• Custom DFM Soldermask Checks 

More checks have been added: Minimum Web, Inner Pad to Mask and Outer Copper to Mask. To disable 

any of the checks, set the value to 0. 

11.16.46 

• Layer Visibility 

The Layers Toolbar right-click menu has a new entry “Stays Visible” which can be checked for a layer so 

that it remains visible while the “Next” and “Previous” buttons are pressed. 

Useful when one wants one or more reference layers to be always visible while navigating through the 

rest. 

• Routing Path Lengths 

“Tools/Routing/Length Statistics” shows a per tool path length for each tool in visible layers. 

• Pocket Routing Improvement 

“Tools/Routing/Pocket Routing” now handles polygons with holes as well. 

• Vertical Adjacency 

The vertical adjacency determination on netlist extract has been improved. 
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11.16.43 

• Repeating Last Move 

New menu item “Edit/Edit Selection/Repeat Last Move”. 

This will be active once a move operation was done. After that, this command will do a move on what-

ever is selected using the displacement of the last move. 

Useful when one wants to move several separate elements by the same amount. 

• New Arc to Chords Parameter 

For all the operations that convert arcs to chords a new parameter has been added, sagitta. 

It is the distance shown as “ds” in the diagram below: 

 
 

This is a good measure as to how well the chords approximate the arc. 

• Insert Text Aspect Ratio 

The insert text dialog has a new field called “Aspect ratio”. A value of 1.0 will have the nominal text scal-

ing, Values larger than 1 will compress horizontally, while smaller than 1 will expand. 

• Export ODB++ 

Now exports only visible layers. Previously exported all loaded layers. 

• Moving  Center of Custom Shapes  (M) 

Sometimes one needs to move the center of M shapes that have irregular shapes. 

To do this, select one pad with the D Code to change, then move the cursor to the location for the desired 

center. Then do “Edit/Set M Shape Center to Cursor” 

11.16.38 

• Context Menu now shows last two commands 

Right click mouse menu shows on top the two last used commands. Previously only the last one was 

showed. 

11.16.34 

• Rotate and Mirror Transcode Report 

A new option in the dialogs has been added to generate a text file report of the D Codes that were trans-

coded. 

• Job Report 

“File/Report/Generate” now also includes a per layer D Code report. 
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11.16.26 

• Offset Polygons 

“Edit/Edit Selection/Polygons/Offset”. 

New operation to inflate or deflate polygons. Similar to swell, but will avoid generating new arcs. For the 

swell operation the distance from the new contour to the old one is always the specified swell amount. 

For offset this is not case at the vertices. 

11.16.22 

• Select Elements of a Given Tool Number 

“Select / All NC T#”. 

Will prompt for a tool number and then select all elements (pad, trace, routing path) mapped to that tool 

number. The shortcut key for this is Ctrl+Shift+T. 

• New Options for Netlist Extract 

- “Intersecting soldermask allowed”. If checked soldermask openings that intersect a pad (or hole) will be 

considered valid and a default soldermask opening will be assumed. Otherwise the pad or hole will be 

considered covered by soldermask. 

- “Missing Soldermask Layer”. Controls how soldermask is interpreted if a soldermask layer is missing 

(no MSU or MSL layer present). One can pick one of two choices: the corresponding components layer is 

completely open (no soldermask) or completely covered (soldermask everywhere), 

11.16.16 

• New Units and Resolution 

The units selection now allows for “micron” as well as the other previous units. 

When specifying the units with text, one can use “micron” or “um”. 

There is now also a way to specify the internal database resolution. This is independent of the units. 

To do this use “Setup / Units”: 
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Note that for PCB applications, the “1 microinch” resolution is more than adequate. This was the resolu-

tion of previous versions of the software. The new “1 nanometer” resolution is needed when processing 

chip CAD data. 

11.16.12 

• Stencil Ratios Computation 

“Tools/Stencil Apertures/Ratio”. 

These ratios are computed on the selected elements. Need to select a stencil (or part of a stencil first). 

Also, one needs to specify the thickness of the “wall” before getting the ratio (for “Area Ratio” and “Sur-

face Area Ratio”). 

The formulas for “Aspect Ratio” and “Area Ratio” are below: 
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For “Surface Area Ratio” the formula is based on the exact shape of the aperture: area of aperture walls 

divided by the area of the aperture. 

• Polygon Cleanup 

A new command has been added: “Edit / Edit Selection / Polygons / Combine Short Straights”. Given a 

tolerance value, any pair of successive straight edges where each is shorter than the tolerance will be re-

placed with an edge connecting the outside vertices of the pair. 

• Export DXF 

Files with step and repeat will be exported using BLOCK and INSERT, resulting in smaller output files. 

Only top-level step and repeat blocks will be exported this way. 

• Import/Export GDS-TXT 

GDS Binary files are currently not supported. 

Only the flat part of the GDS data is imported (BOUNDARY, PATH, BOX at top-level). 

Data is converted to polygons before export. 

11.16.7 

• Select by Line 

A new selection tool has been added, “Select/Select By Line Tool”. 

This is a tool similar to the “Select/Selection Tool” but will select elements intersecting a dragged line ra-

ther than a frame. 

The usual filters are considered (Only current layer etc.). 

Keyboard modifiers are: “Shift” to add to an existing selection and “Ctrl” to remove from an existing se-

lection. 

• Copy/Paste Coordinates String 

One can now copy the text of the current coordinates to the Windows clipboard. This text can be later 

copied elsewhere, as needed. 

There are two ways of doing this. 

- By clicking on any of the coordinate display boxes in the Position toolbar (normally in the lower left 

corner of the application). 



©PentaLogix, Inc., 1985-2023.  All rights reserved Page 22 of 135 

- By pressing the new “Copy” button in the “Go/Coordinates” box. In this case the text for both coordi-

nates is copied. 

11.16.1 

• New Insert Mode: Polygons 

The “Insert” menu has a new command “Polygons”. This will allow a user to click on a number of con-

secutive edges of a polygon and, when done, insert a polygon element. 

To stop insertion and generate the polygon, double-click or press Enter twice. 

If the point where the insertion was stopped is not the start point, a connecting edge will be added back 

to the start point. 

Previously, the only way to insert a polygon was via a several step operation: 

- first one needed to insert zero width traces (“F” type D Code) 

- then select them 

- and finally run “Edit/Edit Selection/Polygons/F to Polygons”. 

The limitation of this new mode is that one can only generate polygons with straight edges (no arcs). If 

arcs are needed the “F” method shown above should be used. 

Note that it is possible to generate a polygon with holes also, but one need to use overlapping edges to 

travel to the hole and back. These are called cut-in contours: 

 

 
 

To facilitate matching vertices in the pending contour a new shortcut has been added: Ctrl+Shift+J (jump 

to closest vertex of current contour). 

• Round Chamfers for Polygons 

New command to add round chamfers at polygon vertices where two straights meet: “Edit/Edit Selec-

tion/Polygons/Add Round Chamfers”. 

This will replace a vertex where two straights meet with an arc tangent to both straight edges. 

There are two methods for doing this: 

- one can specify the radius of the arc (same radius will be used at all vertices). 

- one can specify the offset from the vertex to the added arc (different radiuses will result depending on 

the angle of the edges) 

• Back Drill Layer Types 

Two new layer types have been added BDU (Back Drill Upper) and BDL (Back Drill Lower). 

These types are only relevant for netlist extraction. 

They should contain back drill pads (starting from the upper or lower component layer). 

Back drilling is also called controlled depth drilling. This is a technique to remove the unused portion, or 

stub, of copper barrel from a through hole because when a high-speed signal travels between PCB layers 

through a copper barrel it can be distorted. 

When netlist is extracted pads on the corresponding copper layer which contain the back drill holes will 

be made midpoints so that they will not be tested. 
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11.14.59 

• Swell By Percentage 

To swell by percentage type in a number followed by a percent sign in the “Edit/Edit Selection/Swell” 

dialog. The amount to swell by will be: 

- the percentage of the width of symmetrical D Codes 

- the percentage of the largest inscribed circle diameter for asymmetrical D Code shapes and polygons. 

11.14.55 

• Stencil Sanity Check 

A user settable parameter has been added – the allowed center offset, as a percentage of the pad dimen-

sions. The smaller the number the more errors will be reported. 

11.14.49 

• New version of Layer Organizer 

This version of the Layer Organizer allows you to quickly set the color of the organized layers. You can 

also quickly control layer visibility to show only the top, bottom or inner layer view of your design. You 

can use the new “Layer Color Manager” to setup “Layer Color Templates” that make it easy for you to 

map each layer to one of the 15 available colors in our CAM editors. 

More information on this is in the “Layer Organizer Release Notes.pdf” file in the “Documents” folder. 

• Components 

Added ability to create stencil outlines for packages and generate stencil layers from component layers. 

• Export ODB++ 

Added panel size option. It is exported in the “attrlist” file as “panel_size”. 

11.14.47 

• Import XNC 

Support for the XNC metadata (layer and tool info). 

11.14.45 

• Export XNC 

This is an NC data format that includes drill and rout data. It is defined as “The PCB CAD to CAM Ex-

change NC Format”. 

The format is described here: 

https://www.ucamco.com/the_xnc_file_format_specification.pdf 

It is based on the Excellon format, but is completely unambiguous. 

No format needs to be provided by the user. 

This export is a bit different from the other PentaLogix exports in that the software picks the file name(s) 

based on the current job name. All visible layers with NC data will be exported. 

Note that this format is designed for CAD data and as such, does not support step and repeat commands. 

It is best to use this to export one-up data. 

However, if the CAM data does contain step and repeats the export will still work, but the data will con-

tain multiple copies in the stepped positions. 

These files can be imported by any software that accepts Excellon data, as it is a subset of Excellon. 

They contain meta information about the layer type and tool types, but these are embedded in comment 

lines, so they will be ignored by readers that do not support XNC. 
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The next release of our software will also interpret this info (on import). 

• Update Available Prompt 

Users who do not want to be prompted when a new version of the software is available can now turn on 

the periodic check with “Help/Update Reminder”. 

11.14.43 

• Setting Folder for Persistence/Configuration 

Software parameters / user preferences are saved in a file named CAMMaster.cfg or CAMMasterDsg.cfg. 

These parameters are then loaded the next time the software starts. 

The default folder where this file is saved is the user’s “home” folder, given by the Windows environ-

ment variables “HOMEDRIVE” and “HOMEPATH”. This folder needs to be writable. 

In some cases IT personnel sets these to folders that are not writable. 

To mitigate this, there are two ways to tell the software which folder to use: 

1. Starting the software with arguments on the command line. 

“/cfg foldername”, where foldername is the path to the folder 

2. Setting the Windows environment variable “PENTALOGIX_HOME” to the path of the folder. 

• Components 

1. New command to select and show a component of a given Reference Designator (“Compo-

nents/Select by Reference Designator”). 

2. Save a centroid file from loaded component information (“Components/Save Centroid File”). 

• Path in Layer Names 

A new option to drop the path part in layer names (“Setup/Drop Path from Layer Names”). During cer-

tain import operations the layer names will contain the full path. When this option is checked, the path 

part is dropped and only the file name is kept. 

11.14.35 

• Setting Layer Colors Based on Layer Type 

“Setup/Layer Colors/Set by Layer Type”. 

Will set the color of loaded layers based on the layer type. There is a default mapping from layer to layer 

color index but it can be modified using “Setup/Layer Colors/Restore Layer Type Map from File”. 

The best way to create such a file is to first save the current one, then modify the generated file with a text 

editor. This is important because the layer type strings in the file are the only allowed values. 

The default file looks like this: 
CopperUpper=10 

CopperLower=9 

PowerGround=7 

Signal=2 

Drill=12 

Via=15 

Rout=4 

BoardOutline=4 

SilkscreenUpper=14 

SilkscreenLower=14 

SoldermaskUpper=7 

SoldermaskLower=7 

SolderpasteUpper=7 

SolderpasteLower=7 

ComponentUpper=14 

ComponentLower=13 
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Note that some of strings refer to a whole set of layer types. For instance “PowerGround”  refers to PW1, 

GD2, P25 etc. 

Currently these are the only strings allowed. More can be added if needed in later versions. 

The number after the equals sign is the color index in the color list that appears when choosing a color in 

the user interface. So, for instance, 1 is dark blue in the default setup, 2 is dark green etc. 

It the colors are mapped to other RGB values, then the indices refer to the new values. 

Once the map is changed, it will be remembered the next time the software starts. 

• Components 

A whole set of operations has been added for dealing with component info. It is in under “Components” 

in the main menu. There are too many new features to describe here. 

Documentation is included in the “Documentation” folder in the installation directory. 

Please look for “Components in CAM Software.pdf”. 

• Raster Mode for Compare Layers 

A new mode has been added to the Compare Layers operation. In addition to “Element by element” and 

“Copper area” there is now a “Raster” mode. In this mode comparison is done by using the raster images 

of the layers. 

The advantage is that this operation is a lot faster. 

The disadvantages: 

-- only one error is reported. This makes this mode useful when comparing two layers that are supposed 

to be identical and one is interested only in a yes/no answer. 

- it may need a lot of memory. If there isn’t enough memory available, the comparison will switch to 

“Copper area” mode. 

• Compare Layers by Name 

A new command has been added “Tools/Compare Layers/Compare by Layer Name”. 

This is useful for comparing job data before and after. Both sets of data need to be loaded. Layer pairs 

with the same name are compared. Only the first error is reported. 

This is most useful for checking two versions of the same data that are expected to be identical as far as 

geometry. It will use Raster Mode, unless the memory needed is too large in which case it will switch to 

copper area. 

• Import Directory Improvement 

For directories that have both Gerber files and drill files, the drill file format, if not specified, will be com-

puted to match the Gerber files rather. 

11.14.25 

• Stencil Tool Sanity Check 

The error markers can now be stored as pads in empty layers. This allows the errors to be printed if 

needed. They are stored as “T” shapes, but can later be remapped to any desired shape. 
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11.14.20 

• NetCompare Report 

Long list of net names is no longer truncated. 

11.14.1 

• Improved ODB++ Import 

The ODB import module has been rewritten. It now supports ODB++ V8. 

The import dialog has a checkbox for using the old (legacy) import module, if needed as a fallback. 

• DFM – Compute All Min Values in One Step 

New menu item “Custom DFM/Find Min All” computes minimum feature size, minimum spacing and 

smallest drill hole in one operation. 

• Text Size in Layers Toolbar 

On high resolution monitors, the text of the Layers Toolbar can be hard to read. 

A new font selector button has been added (“Font”). This allows changing the font and the size of the 

font. 

 

 

• Soldermask Export for ProbeMaster 

The soldermask data exported in .f04 files has been improved to facilitate processing in ProbeMaster. 

• Reviewing Markers from a Previous Operation 

“View/Navigate Markers” will bring up again the navigation dialog from the previous operation that 
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generate one, like polygon corrections, layer compare etc. If you modify the data after the operation that 

the markers applied to, reviewing the markers will still point to the old data locations. 

• Loaded Layer Marker in Layers Toolbar 

The “*” marker for loaded layers has been removed. Users complained that it was hard to differentiate it 

from the “+” marker (multiple polarities). One can see which layers are loaded by the fact that their color 

bar is solid. 

11.12.54 

• Gerber Import – Self-intersecting Polygons 

The handling of self-intersecting polygons has been changed. These are polygons where edges intersect at 

points which are not endpoints of the edges (this includes overlapping edges). 

These polygons are not acceptable according to the Gerber spec. 

Previously the user was prompted to auto-correct these polygons. 

Now a new options has been added to the Gerber import Options dialog: 

 

 
 

When unchecked, polygons will be left as in the import data (without prompting). 

When checked, polygons will be auto-corrected and at the end of the import a dialog will pop up to navi-

gate the places where the corrections took place (only one place per polygons is marked). This allows for 

a quick visual check to make sure the auto-correction behaved as expected. 

Note that if the data is only loaded for viewing, or if one wants to re-export the polygons in the same 

state, leaving the polygons unchanged is an acceptable option. 

• Report Info 

One can now save a report after certain inspection operations, such as the Custom DFM checks, Stencil 

Aperture Sanity checks, Layer Compare etc. The navigation dialog has a new button called “Report”: 
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This will bring up a dialog with the text for all the items which can then be copied and pasted into a file, 

if needed. 

11.12.48 

• New Pad Shave Operation 

In addition to the “Shave Pad Tool” (in “Edit/Shave Pads/Shave Pad Tool”) a new operation has been 

added that shaves a pair of pads or a pad versus an adjoining trace. 

This is “Edit/Shave Pads/Shave Selected”. 

For this you need to select two adjoining pads or a pad and a trace and activate this command. You will 

be prompted for the desired gap between the two. Scratch elements will be inserted to shave the pads to 

create the desired gap. 

An example of before (red) and after (green) is shown below: 

 

 

11.12.46 

• Step and Repeat Visualization 

When picking “Display outlines only” in the “Setup/Visibility and Display” dialog: 
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the behavior has changed to display elements in the first step and repeat block. 

Previously only a box was displayed for this block also. 

This gives a better idea as to what is step and repeated. 

• Drill Proximity Sort 

An new sort method has been added to start sorting from the upper-left corner. 

11.12.43 

• Print Options 

A new option has been added to print only the contents of the frame: 

 



©PentaLogix, Inc., 1985-2023.  All rights reserved Page 30 of 135 

 

• Gerber Export 

Export of wide arcs has been improved to account for loss of accuracy when exporting at resolutions that 

are lower than the internal data resolution (.6 English, .5 metric). 

It is highly advisable to export at the highest resolution whenever possible. 

• Stencils Sanity Check 

A sanity check has been added to the stencils operations. 

 

 
 

One first needs to make visible only two layers: the pads layer and the stencils layer. The check is done 

comparing the two layers. Elements are flagged which are out of place, like below: 
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• 3D View 

Scoring layers are now visible in the 3D view (layers of type “SCG”). 

11.12.40 

• Generate Images in SVG Format 

SVG stands for Scalable Vector Graphics and is a standard web format. 

Files with the .svg extension can be opened in Windows by double-clicking on them. They open in a web 

browser (Internet Explorer, etc.). 

The new feature is at: ‘File/Print to “.svg” File’. 

SVG images are useful because they can be scaled while preserving smoothness. In the web browser use 

the Zoom feature. 

In the “Layer By Layer” mode, one file is generated for each visible layer and then the collection is 

zipped, resulting in a .zip file. 

In the “Combined” mode, the image colors will look different then in the CAM software, because color 

blending is done differently in SVG. 

11.12.36 

• New Option for DXF Import 

DXF files have lines that end with square ends. 

Sometimes this is the desired way of importing them. When that is the case, the “Sketch polylines” option 

shown below should be checked. 

 

 



©PentaLogix, Inc., 1985-2023.  All rights reserved Page 32 of 135 

 

In most cases, when the lines correspond to circuit traces, this option should be left unchecked. 

• Gerber X2 and Netlist Info 

The new Gerber Extended V2 format (known as X2) can contain netlist info for the data elements (the net 

name). This is now implemented for import and export. For export you need to pick “X2” format from 

the “Options” dialog. For import, the netlist data is imported without any extra settings. 

11.12.32 

• Import Gerber 

A warning has been added when generating data for a D Code the shape of which is undefined. Most 

useful for exended Gerber import, when the header does not define all the D Code shapes. 

• 3D Viewer Improvement 

F type contours in rout layers are automatically converted to polygons in the drawn image. 

11.12.28 

• Find Minimum Spacing 

- An option has been added to also consider connected copper areas. 

 

 

• 3D View – Save Image File 

A new command has been added to the “3DView” menu: “Save Image To File”. This will save the 3D im-

age to a file without invoking the 3D viewer. The file can later be opened in  the 3D viewer, with 

“File/Open” or dragging and dropping. 

11.12.26 

• Soldermask DFM 

“Custom DFM” now includes soldermask violations check. These checks work only on soldermask pads. 

If the soldermask contains polygons (for openings) they will not be considered. Checks are made for: 

- Duplicate or covered soldermaks pads 

- Soldermask pads that are smaller that a user specified value 

- Soldermask pads where the center does not match the center of the pad on the copper layer 

- Soldermask pads without a matching pad on the copper layer 
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• Import DXF Improvement 

If the data contains zero-width lines, the user will be prompted with an option to convert the contours to 

filled polygons. 

• 64 bit 3D Viewer 

The 3D Viewer is now a separate install. This way users can choose the 64 bit viewer or the 32 bit viewer. 

The 64 bit viewer can only be used on 64 bit versions of Windows, but it can display larger boards due to 

not having memory limitations. Installer can be downloaded from the PentaLogix FTP site. 

11.12.22 

• Improved Gerber Extended AM Parsing 

Parenthesized expressions are now allowed. 

• Improved Netlist Generated for ProbeMaster 

Better handling of soldermaks opening pads the center of which is slightly offset from the center of the 

copper pad they expose. This works only with ProbeMaster V11.2.1 or higher. 

11.12.18 

• Larger Toolbar Buttons 

Many of the toolbars have buttons that are difficult to see on high resolution monitors. There are now 

new buttons in many of the toolbars and their size can be picked by the user (“View/Toolbars/Button 

Size” or “Setup/Preferences/Toolbar Button Size”). 

11.12.16 

• NC Tool Numbers Range 

When importing NC drill and rout data, tool numbers up to T999999 are now accepted. Internally the al-

lowed ranged is still T1 through T255, so tool numbers larger than 255 will be transcoded during import. 

• Pocket Routing 

Added option for routing in vertical direction. 

11.12.14 

• New Tool for Organizing Layers 

Can be activated from several places, including “Setup/Layer Organizer” and an icon on the layers 

toolbar. It makes it easier to organize and identify the individual layers of the loaded data. Pressing the 

help icon in this add-on gives a complete decription of its capabilities. 

• Pocket Routing 

“Tools/Routing/Pocket Routing” converts selected polygons into routing paths that can be used to cut out 

the area the polygons represent while not cutting through the whole material (this generates pockets). 

• Import .pdf 

“File/Import/PDF As Vector” now imports separate pages of the PDF file into separate layers. 

• 3D Viewer Export to .stl Files 

The 3D Viewer can now export .stl (stereo-lithography) file of the image. One file per image entity is ex-

ported because the .stl files do not contain color info. 
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• New shortcut: Ctrl+Shift+F5 

This is for displaying the NC tools setup dialog. There are two version of it: the legacy and the newer ver-

sion. One can pick which one is diplayed with “Setup/Preferences/Use Old Tool Codes Dialog”. Pressing 

“Shift+F5” will display the one picked by this preference setting. Pressing “Ctrl+Shift+F5” (new shortcut) 

will display the other one. 

11.12.9 

• Visualizing Scratch Elements 

At times it is hard to see where scratch elements exists on a layer. There is now a quick way to select them 

in order to see where they are: “Select/Special/Scratch”. This works only on active elements, the same way 

as the selection commands in “Select/Special”. 

• 3D Viewer Improvements 

11.12.6 

• 3D View of Boards 

The menu bar has a new item called “3D View”. 

This allows starting a 3D viewer of the currently loaded board data. The separate application is a viewer 

only, the board can be viewed but not modified. 

The image data is generated in CAMMaster and relies on layers being correctly labeled with layer type. 

The following layer type will be used to generate the image: 

BOL, CPU, CPL, SKU, SKL, MSU, MSL and DRI. 

At least BOL and CPU must be present in order for an image to be generated. 

The BOL layer (board outline) must contain a valid board outline. Either a set of connected traces or one 

polygon. 

The viewer uses OpenGL to render. Because of this, it will only work on graphics adapters that support 

OpenGL and preferably V6.14 or later. Usually updating the graphics card with the latest driver from the 

card manufacturer or computer manufacturer takes care of this problem. 

A sample view of a simple board is shown below: 

 

*  
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11.12.1 

• Toolbars Positioning 

Toolbar positions and docking are now remembered separately for different screen resolutions. This 

helps users with laptops and docking stations, where resultion can change when docked. 

Toolbars must be arranged again when resolution changes, but once set positions will be remembered. 

Another change is that toolbar positions will not need to be reset when a new major version of the soft-

ware is released. 

• New Stencil Shape 

V shape: 

 

11.10.80 

• Convert a Single Drawn Pad 

“Tools/Convert Drawn Pads/Convert Selection to One Pad”. This new command will take all selected 

data and make a pad out of it (most often a custom shape, “M”). This is useful when a pad is needed at 

that location and the copper area of the item is not connected (made of several fragments). 

11.10.77 

• New DFM Report Viewer 

New module that allows viewing of DFM reports gemerated by the PCB Analyzer product, using “live 

CAM data”. “Tools/EMS Magician/DFM Report Viewer”. For more detailed release notes please read the 

viewer release notes found in the installation folder. 

• Export Routing Path: Finished Routing Function Support 

Excellon M16, Sieb & Meyer G11. 

• Convert Circles to Pads 

Some CAD output contains circles (arcs) where pads are intended. This new operation converts them to 

pads. “Edit/Edit Selection/Special/Convert Circles to Pads”. Only full-circle arcs will be converted. 

11.10.73 

• Import ODB++ 

Support for dynamic text: $$JOB, $$STEP and $$LAYER. 

• Save and Restore DFM parameters 

One can now save sets of parameters to text files. “Custom DFM”: “Save Parameters To File” and “Re-

store Parameters From File”. 

• Select Approximate Duplicates 

A new method to select duplicates that are not identical. They can differ by a user specified tolerance. 

“Select/Special/Approx Duplicate Elements”. 
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• A Strict Method for Finding Routing Paths 

“Tools/Routing/Strict Group to Paths”. This will only continue a path where endpoints meet exactly. No 

intersection or touching is considered. 

• Contour Netlist Extraction 

Endpoint / midpoint computation has been improved. 

11.10.67 

• Transcode from “N” shapes to “C” shapes 

At “Tools/Holes to Pads”. This is the revers of the already existing “Pads to Holes”. 

• IPC-356 from ODB++ file 

When extracting an IPC-356 netlist file from ODB data (“Tools/Netlist/Convert Netlist File/To IPC”) refer-

ence designators are also generated in the IPC-356 file. 

• Vertical Adjacency in Contour Netlist 

An option has been added to compute vertical adjancy also when doing contour netlist. 
Vertical Layer Adjacency: Identified nets from the layers above and below the specified net to be 

included in the isolation test. Each net from one layer above and one layer below is considered as if it 

was on the same layer as the specified net and is included in the vertical layer adjacency list if it lies 

within the vertical layer adjacency distance. This distance can be different than the horizontal layer 

adjacency distance. 

 

 

11.10.65 

• ODB++ Export 

Step and repeat implemented. 

11.10.63 

• Gerber X2 - TF.FileFunction Implemented 

The FileFunction attribute for Gerber X2 has been implemented for export and import. When exporting a 

file set in X2 and importing it using Import/Directory or Import/Zip, the proper layer order is preserved. 

• Gerber X2 – Nested Step and Repeat Implemented 

Both import and export. 
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11.10.56 

• X and Y Options Added for Drill Serpentine Sort 

In “Tools/Drill”. If X is picked the sort will go on the X direction first. 

11.10.54 

• Preliminary Support for Exporting Gerber Extended V2 

Option added for V2 export. More exported items will be added later. 

• Improved ODB++ Export 

Custom D Codes and routing paths are now exported. 

11.10.50 

• Import of PDF files 

“File/Import/PDF”. Note that only pdf files that have vector content, such as fab drawings, will give good 

results. One such example is in the Samples folder. 

11.10.44 

• Sax Basic replaced with WinWrap Basic 

The IDE for Basic scripting was switched from Sax Basic to WinWrap Basic. Sax Basic is no longer sup-

ported and WinWrap Basic is a more modern tool. All previously written scripts should work unmodi-

fied. 

11.10.43 

• Export ODB++ 

The whole loaded data is exported to a ODB++ file. Some features, like routing paths and step and repeat, 

are not yet implemented. Will be added in upcoming versions. 

11.10.40 

• Built with Visual Studio 2013. Does not need .Net V2.0 any longer. 

11.10.24 

• This is the last release built with Visual Studio 2008 

11.10.17 

• New option for exporting rout files 

The “Rout Options” tab has a new item “G in every block”. When checked the exported file will contain a 

G field in every block. Apparently some router need this. 

• Tool Codes Setup dialog improvements 

- The “Swell Drills” operation allows swelling by positive or negative values. 

- A new operation “Merge Tools” allows merging all the tools that have the same type and diame-

ter into one tool. This applies to drill holes as well as routing paths. 
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11.10.14 

• New selection  command for selecting small elements 

“Select/Special/Small Area”. Will select element whose area is smaller that the value specified for the 

user. This is useful for finding very small elements hidden by other elements or just hard to see because 

of their size 

11.10.9 

• Improved computation of midpoints when generating a contour netlist. 

• Faster User Interface for the Tool Codes Setup dialog 

• Improved License Activation Dialog 

11.10.1 

• Improved parsing of Gerber files with modal flashes (D03). 

11.8.24 

• Improved computation of midpoints when generating a contour netlist. 

• Improved parsing of Gerber files with modal flashes (D03). 

11.8.1 

• Improved polygon swelling algorithm 

11.6.41 

• New Tool Codes Setup dialog (Shift+F5) 

With this release, in addition to tool diameter and tool type, you can now set the following drill and rout 

tool parameters: 

✓ FEED – This is the “InFeed” of the tool and determines how quickly the tool is plunged into the 

material. Units are either “in/min” or “m/min”. 

✓ SPEED – This is the tool rotation speed in K-RPM. A value of 100 would mean 100,000 revolu-

tions per minute. 

✓ RETRACT – This is how fast the tool is removed from the material at the end of a cut or a drilling 

cycle. Units are either “in/min” or “m/min”. 

✓ ZOFFSET – This determines how far the tool is plunged into the material (relative to a reference 

plane). Units are either “in” or “mm”. 

✓ TABLEFEED – This is how fast the rout tool is moved along the contour of the rout path. Note 

that this is an optional parameter and only applies for rout tools, not drill tools. 

✓ MAXHITS – Determines how many holes can be drilled with a particular tool before requiring a 

new tool. 

You can save multiple feed and speed profiles and recall them for later use. This allows you to use differ-

ent profiles based upon layer count, material type, etc. You can also use the built-in Column Organizer to 

import existing Feed and Speed files (commonly in Excel .csv format). 
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If your drill file does not contain feed and speed information, you can map the feed and speed parame-

ters by utilizing the loaded “Feed and Speed Profile”. By clicking on the “Find Closest” button, we will 

search the loaded profile and find the closest tool. The new diameter and all associated feed and speed 

parameters will be shown in the Tool Codes menu.  You can setup your feed and speed profiles to con-

tain only the tool diameters that you stock. This way, you can be assured that a selected tool will be one 

that you have available. 

In addition, you can now automatically swell drill sizes to compensate for drill etch factor. You can set 

multiple drill etch factor ranges based upon tool diameter. 

For comprehensive information about how to use the new Tool Codes menu, you can click on the “Help” 

button after you launch the new Tool Codes dialog (Shift+F5). 

If you prefer to use the old, legacy Tool Setup, you can do that by clicking on “Setup/Preferences/Use Old 

Tool Codes Dialog”. 

• New Excellon export option 

It is called "Omit m.n" and it can be used to omit the output of the "00.0000" type m.n format in the 

INCH/METRIC line. This is a newer Excellon format spec and is not recognized by all parsers. 

• New Sieb & Meyer export option 

It is called "Rout tool diameters as negative numbers". When checked, the diameter for tools that are of 

type "Rout" will be exported as negative numbers. 

11.6.35 

• IPC-356 test points imported 

When importing netlist data, "099" records, if present, will be imported as pads on separate layers. These 

records were previously ignored. 

11.6.26 

• Improved Stencil Pattern Search 

When searching for a model a tolerance of 0.1 mils (or 1 micron in metric) is used. This allows for finding 

components that are slightly off due to rounding errors. 

• New DFM Check For Uncovered Plated Holes 

For "DFM/Drill Violations", if one sets the "Clearance" value for plated holes to 0, then plated holes that 

are not covered by copper will be flagged as errors: 
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• NC Rout Path Plunge 

The existing command "Set Plunge at Vertex" has been renamed "Set Plunge" and now allows the plunge 

point to be set anywhere on the path, not only at vertices. 

• New Command to Adjust a Soldermask Layer 

"Tools/Soldermask/Adjust Existing Soldermask". 

This will take an existing soldermask layer and adjust it for purposes of netlist extraction and electrical 

test output. It is most useful for netlists to be used with PentaLogix ProbeMaster. 

It takes any visible MSU and MSL layers and checks for needed adjustments. If adjustments are made, 

new soldermask layers are generated. The original ones are left unchanged. 

The following adjustments are made: 

• If a soldermask pad does not have the same center as the pad it covers, the center will be adjusted 

to match 

• If a soldermask pad covers more than one component pad, each component pad will get its own 

soldermask pad 

• If a component pad is covered by a soldermask area that is not a pad (perhaps drawn traces or 

polygon), a new soldermask pad will be added 

• Existing soldermask pads that do not cover any component layer pads are discarded 

• Pads in the component layer that are not covered by soldermask will get a new soldermask pad. 

These added soldermask pads will go into a separate adjustement layer. The reasong for this is 

that not all uncovered component pads need soldermask. It is up to the operator to inspect this 

layer and decide which new soldermask pads are needed and which are not. 

The resulting adjusted soldermask layers will contain only pads. 

Note that  in the above discussion wherever the term covered by soldermask was used it means that there 

is a soldermask opening on the board. Soldermask layers are usually negatives but the discussion is in 

terms of the CAM pads. 

If a soldermask layer has been adjusted, any newly generated pads or moved pads will be shown as se-

lected on the new layer to make it easier to see the changes. 

11.6.18 

• Convert Obround Pads to Traces  

This command will convert all O-type pads (obbrounds) to geometrically equivalent traces. "Edit/Edit 

Selection/Special/Convert O-type Pads to Traces". This is useful if the destination system does not accept 

arbitrary shaped pads or when one want to export an N/C file. The traces will be exported as nibbles, 

whereas obround pads cannot be exported as N/C. 

• Stencil Aperture: Multiple Models 

One can apply multiple stencil models on the selection with the new command "Tools/Stencil Aper-

tures/Convert From Library". 

• Two Types of Stencil Windows Models 

One can now generate windows-type models that apply to all selected rectangular pads or just to pad of a 

given shape. 

- To generate a model that applies to only one shape, select only one rectangular pad. Do "Tools/Stencil 

Apertures/Windows". The model created this way will apply only to pads of the same dimensions as the 

selected pad. 

- If more than one pad was selected when the windows operations is performed, then the resulting model 

will apply to any rectangular pad. 
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11.6.11 

• Stemcil Aperture Libraries 

The stencil module has been improved to allow for saving and reusing aperture models. This is described 

in an application note: 

v 

• Improved DXF Export 

Two new export options have been added: 

 

 

"Export round pads as CIRCLE" will cause round pads to be exported using the DXF CIRCLE entity. This 

show in AutoCad as a non--filled circle, but it is desirable in certain cases. 

"Export chained traces as one polyline" will cause a chains of traces to be exported as one polyline. If un-

checked each trace will be exported as a separate polyline. 

Chains are groups of traces where one trace's endpoint is the same as the next trace's starting point and 

all traces have the same width. Export as chains makes editing in AutoCAD easier and also results in a 

considerably smaller .dxf file. 

11.6.5 

• Improved Thermal DFM 

"DFM/Thermal  Violations": the algorithm for finding violations has been improved. 

11.6.0 

• Easier access to endpoint alignment option 

When aligning or selecting traces and polygons there is an options to move the cursor to the endpoint 

only. Since this is a frequently needed operation, a new button has been added to Selection Toolbar and a 

new entry in the context menu (mouse right-click). 

• New button to pan up 

A new button has been added in the "Screen" toolbar to supplement the "Next Screen" button. The new 

button is "Next Screen Up" and it will step in the Y direction, rather than in the X. 
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11.4.45 

• Minimum Spacing to Board Outline 

"DFM/Find Minimum Spacing" has an option to also compute the spcaing to the board outline. There 

must be a separate layer of type BOL that containts the traces for the board outline. 

 

 

11.4.42 

• New Layer Type 

New layer type for stencil layers have been added: STU (Stencil Upper) and STL (Stencil Lower). 

• Error Markers for DFM Checks 

Spacing and width violations now have a new option ("DFM/Spacing Violations", "DFM/Feature Size Vio-

lations"). When turned on, it will generate (in addition to the markers for viewing) zero-width traces in 

empty layer for each of the markers. This way data can be saved with the error markers on separate lay-

ers for later viewing. 
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11.4.37 

• Gerber Export: New Option for Polygons 

One can choose to export polygons as filled with traces (of a user picked D Code). 

• DXF Export: New Option  

A new option has been added ("Add pads at trace ends") that controls if round pads are added at the 

ends of traces mapped to round D Codes. If checked, the round pads will be added to make the DXF 

drawing look like the Gerber image. Otherwise the rounded ends will not be added. This is sometimes 

useful when the output is used for routing or other tools where the rounding does not matter and may 

even interfere. 

• Stencil: New Options 

 The "Windows" mode for stencil generation has new options for diagonal splits: 

- crosshatch (this was the only mode before) 

- ascending 

- descending. 

 The inverted homebase has a new geometry rule for rounded (called "Simple": straight feet and 

rounded center). This is only active when "Rounded" is also checked. 

 One can now mix parameters that are given as absolute values and percent, by explicitly entering 

a percent sign or units. If neither is given, absolute will be assumed in the current units. 

An example is shown below with mil units for certain parameters and percent values for others. 
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• Spacing and Width DFM  

Improvements have been made to the spacing and width violations DFM modules. 

11.4.29 

• Option for Transcoding Report 

During import (Gerber and others) D Code numbers may need to be transcoded to preserve the specified 

shape of the D Code. During transcoding a report file is generated. This added option has three choices 

(available under "File/Import"): 

 

 

One can: 

 disable report to file ("None") 

 generate a file called "Transcode Report.txt" in the same folder where the imported file is ("To 

Import Folder") 

 use the file that was picked previously with "File/Report/Set Name" ("In Report File"). 

• Gerber Export User Interface 

The two menu entries for exporting Gerber ("Basic Gerber" and "Gerber Extended") have been combined 

into one. The dialect of Gerber (Extended/Basic) can still be picked from the "Options" dialog. 

This change has been made because exporting Basic Gerber is only needed in very rare occasions. Ex-

tended Gerber (RS-274X) is almost always the preferred output, since it contains format and shape info. 
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• Easier Format Guessing 

The dialog that is shown when one does "File/Import/Guess" (F4)  now includes the board size limits to 

allow for changing them and trying to guess again. Previously one could only set the board size limits on 

which the guess was based in the "File/Import/Directory/Options" dialog. 

• Turn Off Full Path in Print Header 

A new option has been added to the print options called "Full path". If unchecked, only the filename part 

of job names or layer names will be printed in the header. 

11.4.21 

• Stencil Aperture Generation Improvements 

Obround shapes can now be inflated using the "asymmetric" mode. 

• Option to Export Duplicate Pads 

An option has been added for exporting Gerber files with duplicate pads. These are two or more pads at 

the same location in the same layer and of the same D Code. Exporrting more than one makes no sense 

when producing circuit artwork, but it is sometime needed for sending the data to certain other NC ma-

chines. Unless you specifically need it, leave this option unchecked. 

 

 

11.4.15 

• ODB++ V7.0 Support 

Rotation of pads ( by arbitrary angles) in ODB++ files (introduced in V7.0 of ODB++) is now supported. 

• New Option for Aligning Layers 

"Edit/Move Layers XY Position/Align Visible Layers" (Ctrl+Q) now has a new option tab for allowing the 

user to select which layers will be moved and which will be left standing during the alignment. There are 

3 possibilities: 

 

1) "Auto" will work as this command worked before. The software will determine which layers to 
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move and which to keep in place. 

2) "Lowest layer..." will keep in place the lowest layer number among the visible layers. 

3) "Current layer" will keep in the place the current layer. 

11.4.10 

• Rotated Rectangles for Flash Contours 

"Tools/Convert Drawn Pads/Flash Contours in Selection" now converts rotated rectangles as well. 

Prevsiouly only orthogonal rectangles were detected and converted. 

• DXF Export Options 

An "Options" buttons has been added to the export DXF dialog. 

It is shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If "Export all data as polygons is checked, then all the data (traces, pads etc.) will be converted internally 

to polygons and then exported as polygons. This usually results in smaller data files, but they may be 

harder to edit in AutoCad. 

The other option controls how the polygons are exported (this applies whether the "Export all data as pol-

ygons" was checked or not). The options are filled (using the DXF HATCH entities) or  outlined (using 

DXF LWPOLYLINE entities) 

11.4.6 

• Import DXF 

A new options dialog has been added: "File/Import DXF Options". It currently has settings for specifying 

the units for the DXF file. Previously, the current units in the CAM software were used. 

• Export DXF 

Layers that do not contain scratch elements and are not negative are now exported without converting 

everything to HATCH entities. POLYLINE and text entities will be used where possible. 

• .bin File Open by Double-Clicking 

A new command has been added to associate or disassociate the ".bin" file extension with this software. It 

is "Setup/Advanced/Register for .bin files". When checked, one can double-click on a .bin file in Windows 

Explorer to cause it to open with this software. When unchecked CAMMaster does not associate itself 

with the .bin extension. 
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• New Draw to Flash Operation 

"Tools/Convert Drawn Pads/Flash Contours in Selection" will replace contours drawn with F-type D 

Codes with pads. Currently only round and rectangular shapes are supported . 

• Layer Info for Printing 

"File/Print" has a new option for adding a line with layer info (layer name, type, etc): "Add layer info 

line". 

• Improved Feature Size Violations 

The algorithm for finding width violations ("DFM/Feature Size Violations") has been improved. 

11.4.0 

• Import DXF 

One can now import AutoCAD DXF files ("File/Import/DXF"). 

Some features in DXF are not yet fully supported, but the current implementation should be sufficient to 

allow import of most PCB related DXF data. 

DXF files can contain text in a variety of fonts and our CAM software will map them to the PentaLogix 

built-in fonts. Because of this, sometimes text spacing will look different than in the original. SPLINE enti-

ties are currently not supported. 

More support for unimplemented features will be added in upcoming releases. Please send us .dxf files 

that do not import correctly for you. 

• Single Point Net Numbers Listed in Net Count Report 

When extracting netlist using the contour method and "Generate Net Count Report" is checked, the net 

numbers of single point nets are listed at the end of the file in addition to the count of such nets (which 

was the only info generated before in the report file). 

• Contour Netlist and Obround Shapes 

Obrounds are not supported in the IPC-356 format. So, when the CAM data contains obrounds they need 

to be converted to rectangles or rounds. The computation of when to use rounds instead of rectangles has 

been improved. 

• Rout Export: Multi-quadrant Arc Option 

A new option has been added when exporting routing paths in the "Options" dialog in the "Rout Options" 

tab. It is called "Quadrant arcs only" and will control whether arcs that span several quandrant will be 

exported as one arc or several arcs (one per quadrant). The latter was the default mode before, but there 

are more routers now that can accept multi-quadrant arcs. 

11.2.78 

• Picking D Code for Inserting Elements 

A new user selection has been added to allow picking a specific D Code for inserting elements (pads, 

traces etc.). Previously newly inserted elements were using the current D Code (from the Current Ele-

ment toolbar). That is still the default, but the user can now pick a specific D Code for inserting elements. 
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This is useful when during insert operations the current D Code can change (due to aligning or selection) 

but the user wants to insert using a specified D Code. 

The command to pick this option is under "Insert/Using D Code". This is similar to the existing "In-

sert/Into Layers". 

• Screen Toolbar Split in Two 

The Screen toolbar has been split into two toolbars, now called Position and Screen. This is to allow users 

the choice to turn off one or the other independently. The Position toolbar contains the units, X and Y co-

ordinates and zoom, which are the items more frequently used. Users who don't need the other buttons 

can now turn the Screen toolbar off and have more room on the screen. 

• Gerber Coordinates with Decimal Point 

"File/Import/Directory" has been improved to recognize Gerber files with coordinates with decimal point 

notation. This is not standard Gerber, but such files do exists. 

• New Option for Gerber Import 

The new option is in the "File Interpreation" tab of the options dialog and controls the handling of Gerber 

blocks without a D command following a tool change (D Code change). An example is shown below: 

 
X163830Y76835D01* 

D24* 

X161290Y75565* 

X157480Y76200* 

 

The question is how to interprest the block: X161290Y75565* 

According to the Gerber spec this should be a move, but some software outputs it expecting that the D 

command in the previous block should be preserved (D01). 

Because of this a new option has been added: 

It is safest if Gerber files contain a drawing D command in every block (D01, D02 or D03) but this is not 

always the case. 

• Improved Midpoint Computation 

The algorithm for computing which test points are endpoints and which are midpoints has been im-

proved in contour netlist extraction. 
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11.2.74 

• Option for "LN" Directive 

A new option has been added to enable or disable the output of the "LN" (Layer Name) directive in Ger-

ber Extended. It is in the "RS274-X" tab of the export "Options" dialog. Previously the "LN" was written 

for any layer that was named. 

• Trim Traces Improvement 

"Edit /Trim Selected Traces" now has an additional parameter for clipping. It is a percentage number that 

allows a user the set the maximum percent of a trace that will be clipped. A maximum length of the clip 

parameter existed before and it is still present. Only if both are satisfied will a trace be clipped. 

• Improved Plane Nets Classification 

Contour netlist has a user parameter called "Minimum Plane Size". Users can set this value to cause cer-

tain nets to be categorized as "plane nets" (net number less than 200). Previously the value was used to 

compare against the dimensions of the bounding box of the copper. Now, the copper area of the net is 

used for this computation. The area is compared against the square of the value entered and, if larger, the 

net is considered a "plane net". 

11.2.71 

• Check For Updates 

"Help/Check For Updates" will now open in a web browser instead of a child dialog of the application. 

This allows the application to be closed while the update is being done. 

• Import Directory Improvements 

Better guess for format of drill files. 

11.2.64 

• DXF Export 

"File/Export/Autodesk DXF" will export chosen layers in DXF format. One can export layer by layer or 

combined. Layer by layer will generate one .dxf file for each chosen layer, the file name derived from the 

layer name. Combined will export all picked layers into one file, but this is of limited utility when several 

layers are chosen, because the colors are not translucent in DXF. However, this is useful when exporting 

just one layer when one wants to specify the file name during export. 

11.2.60 

• Easier Transcoding 

Transcoding groups of D Codes form the "Setup/D Codes" dialog (F5) has been changed ("Opera-

tions/Transcode"). The destination range (range of D Code numbers to which the existing D Codes are 

transcded) does not need to contain a contiguous range of unused D Codes large enough to accomodate 

the source range. If enough unused D Codes exist in the destination range, the operation will complete. 

Previously the operation would fail if there was no contiguous range available. 

11.2.58: 

• New Parameter for Timming Traces 

A new parameter has been introduced for clipping selected traces. This specifies a maximum length. If 

the clipped portion would exceed this length the trace is not clipped: 
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• New DFM Check for Unplated Holes 

The drill DFM module has a new check for unplated holes: 

 

 

If enabled, it will find non-plated holes that are closer than "Clearance" to copper on any of the conduc-

tive layers and will also flag as errors non-plated holes that go through copper without a clearance. 

• Support for Gerber Extended "LN" Directive 

A new option has been added for importing Gerber Extended data : 
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When the "LN" option is checked, the string that appears in the "LN" directive (Layer Name) in Gerber 

Extended files will set the name of the layer in the CAM software. 

 

11.2.52: 

• New Gerber Export Option 

A new option has been added to the Gerber export dialog. This is to control the data output at the end of 

a plot. Traditionally a plot ends with "X0Y0D02*M02*, but certain devices have problems with the 

"X0Y0D02" part. An option has been added to specify if it should be output or not. It is in the "Fields" tab 

of the options dialog and it is called "X0Y0D02 before end of plot". 

• Selecting Traces By Aperture Size 

"Select/Special/Wide Traces" and "Select/Special/Narrow Traces" have been added. This works similar to 

the existing "Large Pads" and "Small Pads" commands. They will select traces based on the diameter of 

their D Code. Selection is only among active elements (taking into account the other filters, if any). 

11.2.45: 

• Clip to Board Outline 

A new executable has been added. It is called "CAMMasterSampleScripts.exe" and it is located in the 

"Scripts" subfolder. To find out more about what it does click on the "Help" menu after starting it. It cur-

rently provides only one script, which clips data on a layer to the board outline. In the future more such 

useful script modules will be provided. Please contact PentaLogix if you have a specific need for an oper-

ation that can be scripted. 

• New Netlist Export Options for ProbeMaster 

The PentaLogix electrical test software (ProbeMaster and FixMaster) currently only allows for round pads 
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as hole covering pads. If the pads are rectangular they will be processed in the ETest software as SMD 

pads. Sometimes this is not desirable (for instance when one wants to stagger the pads after export to the 

flying probe tester - some tester can stagger pads, but need covering pads for this). To help with this, a 

new option has been added to the contour netlist export dialog in the "padstack" group: "Round cover". 

This will export holes covered by rectangular pads as if the pads were round (inscribed in the rectangle). 

11.2.43: 

• Printing on White Background 

The "Screen colors on white" has been improved to print the exact colors visible on the screen. The "Use 

Raster method when printing" checkmark must be checked for this to work. This  is useful when one 

wants the printed image to have the same colors as the screen but one wants to save ink and not print the 

black background. 

• Selecting Small Pads 

A command has been added for selecting active pads mapped to D Codes with at least one dimension 

smaller than a user specified value. The command is "Select/Special/Small Pads". It takes into account the 

selection filters as well, except for the D Code filter (it always checks all D Codes). If for instance one 

wants to select only small round pads, one can pick the "Shape C" filter iterm in the Selection Toolbar. 

• Polygons Filter Shortcut 

A new shortcut has been added for using polygons as the selection filter: "Ctrl+Shift+Y". This applies to 

the filter box in the Selection Toolbar. 

• New Selection Filters 

The filter combobox that appears in the Selection Toolbar (and other dialogs) now has several new added 

items: "Plated Holes", "Non-plated Holes" and "Via Holes".  This restricts selection and operations that 

work on active elements to just pads of type "N" and mapped to holes of the specified type. 

• D Code Layer Usage Report 

"File/Report/Generate" will now also show on what layers each D Codes is used. 

11.2.35: 

• New Midpoint Option for Netlist Export 

A new option has been added to contour netlist file export. It is called "Padstack midpoint". When 

checked all pads in a padstack (the hole and any covering pads) will be assigned the same midpoint / 

endpoint state. If the netlist computation determined that any of them is an endpoint than all will be set 

as endpoints, otherwise all will be set as midpoints. 

Some testers, like the ATG testers, seem to prefer this mode. 

11.2.31: 

• Turn On and Off a Range of Layers (Visibility) 

A new way of changing the visibility of a range of layers has been added to the layers toolbar. To turn 

ON a range of layers click on the first and Shift+double-click on the last in the range. Similarly to turn 

OFF a range of layers click on the first and Ctrl+double-click on the last. 

• Stretch Traces Orthogonally 

A new option has been added to allow only orthogonal (horizontal, vertical or at 45 degrees) stretch of 

straight traces: "Edit/Orthogonal Stretch Only". 
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• Paint and Scratch Optimize for Layer 

A command has been added to the right-click menu in the layers toolbar: "Paint and Scratch/Optimize". 

This will attempt to minimize the number of paint to scratch transitions on a layer by merging groups 

that do not interfere and adding scratch polygons as holes to containing paint polygons. 

• Guessing Layer Types 

A command has been added to the right-click menu in the Layers Setup (F10) dialog: "Guess layer types 

from name". It will attempt to determine the type of a layer ("CPU", "CPL" etc.) from the layer name and 

extension using CAD software standard naming conventions. 

• Select Dangling Traces 

A new command has been added for selecting dangling traces ("Select/Special/Dangling Traces"). This 

command will look only at active traces, so all the filters and "Only" check marks are taken into account. 

A dangling trace is a trace which has at least one uncovered endpoint. Normally trace endpoints are cov-

ered either by a pad or another trace. If that is not the case, it is usually a problem on circuit layers. 

One can specify areas to exclude from the check using exclusion zones ("Setup/Exclusion Zones/Insert"). 

• Break Intersecting Traces 

This new command ("Edit/Break Intersecting Traces") works on the selected traces (linear or arc) and 

breaks traces that intersect at points other than the endpoints of the traces. Such traces are replaced with 

the resulting fragments. 

• Exclusion Zones for DFM 

One can now specify a set of rectangular regions (exclusion zones) when running DFM. The area covered 

by these exclusion zones will not be processed during DFM. This is useful for avoiding the spurious er-

rors that can be caused by text or targets, etc. on copper areas, but it can be used for excluding from the 

DFM check any unwanted areas. The exclusion zones can be manipulated using "DFM/Exclusion Zones". 

• Spacing Violations Improvements (DFM) 

A new option has been added for checking spacing violations between parts of a connected copper region 

(same net - "Any"). This checks for spacing violations at all points of the region and can be run instead of 

the acid traps check. 

The check between separate copper regions will now report all violations (previously only one was re-

ported per pair of regions). 

11.2.26: 

• Distance to outside edges 

The edge-to-edge measurement tool (right mouse click - "Edge To Edge Measurement Tool") now dis-

plays the distance to the outside edges of the two picked elements, in addition to the distance to the in-

side edges. 

• Dimensions shown on screen 

When running one of the "DFM" tools the results displayed on screen include the numerical value of the 

measurement in addition to the arrow. 

• Starved Thermals DFM check 

A new check has been added to the "DFM/All Violations" module. It checks for starved thermals (ther-

mals that do not have a wide-enough connecting path to the rest of the plane). For this check one needs to 

pick the circuit layers to be checked and the corresponding drill, via or soldermask layers. Only locations 

on the circuit layers that have a crossing drill hole or a soldermask opening are checked.  Problems like 
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the one shown below are reported by this check: 

 

 

11.2.22: 

• View Layers where a D Code appears 

A new command has been added to the "Setup/D Codes" (F5) dialog that will display the list of layers 

that contain the D Codes currently picked in the dialog. The name of the new menu command is "Layers". 

• Faster Contour Netlist 

The algorithm speed has been improved for jobs with many blind and buried vias. 

11.2.18: 

• Drill Size DFM 

A new DFM check has been added to the drill DFM rules ("DFM/All Violations/Drill"). It checks for holes 

of diameter smaller than a user specified size. 

11.2.8: 

• Excellon Format 1 Import 

An option has been added to the "Options" dialog for "File/Import/Drill & Rout" to allow setting either 

Format 1 or Format 2 as the format of the data to be imported. This is important when the Excellon file 

does not contain a FMAT statement because Format 1 and Format 2 commands have different meanings. 

Previously Format 2 was assumed as the default. 

11.2.1: 

• Editing Layer Names 

New commands have been add to the context menu (mouse right-click) in the "Setup/Layers" dialog 

(F10): "Load layer names from file" and "Store layer names to file". These allow saving the layer names to 

an ASCII text file and also loading the layers names from a file. This can be useful in several ways: 

 To load the names from a fixed template of layers names 

 To edit the names when a large number of names need to be changed. To do this, one can do the 

following: save the current name to a temporary text file, edit the file with notepad or other text 

editor that allows for group replace operations, finally reload the names from the just edited file. 
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• Converting Pads to NC Holes 

There are cases where there is no input drill file, but there is a Gerber or other circuit data pad master. A 

new tool has been added to convert such layers to NC layers that can be exported as drill data. The new 

command is "Tools/Pads To Holes". 

In the layers picked by the users it will transcode any elements mapped to a D Code of shape "C" to a 

new D Code of type "N" (NC hole). These elements can later be used to generate drill files, to extract 

netlists or to use in Smart DFM. This command transcodes traces as well, although that is generally less 

useful. Only visible elements will be transcoded. 

11.0.80: 

• Improved Copy and Paste 

The "Edit/Copy" (Ctrl+C) and "Edit/Paste" (Ctrl+V) commands now use as reference point the position of 

the cursor when the copy command is performed. Previously the lower-left corner of the bounding box of 

the selected elements was the reference point. 

• Break Tabs at Corners 

A new command has been added to automatically insert 4 break tabs at the corners of closed routing 

paths. This is intended to be used with rectangular routing path, but will work with any shape. The com-

mand is "Tools/Routing/Break Tabs at Corners for Selected". It will change only selected routing paths 

and only the ones that are closed. 

• Netlist Extract Improvement 

The contour netlist extract has been improved to better detect midpoints if several pads are overlapping 

and  better handling of obround pads. 

11.0.74: 

• Improvement in Trim Selected Traces 

The "Clip" operation of "Edit/Trim Selected Traces" has been improved. It now clips traces extending by 

small amounts over another trace even at points that are not close to the endpoints of the other trace. Pre-

viously the clipping was done only for situations where traces intersected close to their endpoints. 

This new method is useful to clean up inaccurate polygon fills, such as the one shown in the image that 

follows: 
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The above image is shown at zero-width to expose the nature of the fill. After the trim operation, the re-

sult will look as shown in the next image: 

 

 

 
 

• Automatic Lead-In Generation 

A new command has been added for automatic lead-in/out generation for routing paths in the selection 

that are closed, do not already have lead-in and have compensation set. The compensation setting is used 

to determine the side of the path where the lead-in is generated. The command is "Tools/Routing/Auto 

Lead-In". There is one parameter for this operation that can be set by the user, the offset (height) off the 

path where the lead-in starts ("Tools/Routing/Lead-In Options/Auto Lead Offset From Edge"). 

• Proximity Sort For Routing Paths  

A new command has been added to sort the routing paths by proximity so as to shorten the total distance 
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traveled by the routing tool ("Tools/Routing/Proximity Sort"). This command will change the precedence 

numbers of the routing paths. This sort is also done (automatically) when a rout file is exported, but in 

this case only paths with the same precedence number are sorted. Here is a summary of the export order: 

ascending tool numbers (smaller tool number first), ascending layer number, ascending precedence num-

ber (lowest precedence numbers first, except for precedence 0 which means "don't care" and which is ex-

ported last) and finally (within the same precedence) the order is by proximity. 

11.0.71: 

• Tool For Panelizing 

A new command has been added: "Edit/Layers Stackup/Combine By Board Number". This command op-

erates on all visible layers and, if several layers have the same board layer number, it will combine those 

layers into one (merging into the first layer with that board layer number). Although this is a general pur-

pose command that can be used for other purposes also, its main use it to facilitate panelizing two (or 

more) different jobs. 

The jobs are usually on separate sets of layers but one wants to combine them into a set of panel layers. 

For this one can apply the following steps: 

1. Place the second set of layers at the desired X and Y location by using one of the move com-

mands.. 

2. Set the board layer numbers for each layer in the second set so it matches the board layer num-

bers in the first set. This can be done in the "Setup/Layers" dialog. 

3. Execute the "Combine By Board Number" command. 

• New Global Selection Filter 

A new filter has been added for selecting only paint elements (ignoring scratch elements). It is called 

"Paint Elements". Previously there was only a filter for selecting "Scratch Elements". 

• Improved Routing Path Compensation 

Compensation computation has been improved for paths containing slots (where a path reverts onto it-

self). 

11.0.59: 

• Feedback during Move and Copy 

For operations that move or copy the selection the cursor will drag a box representing the limits of the 

selection (to provide feedback to the user). These operations are: "Edit/Edit Selection/Move", "Edit/Edit 

Selection/Copy" as well as "Edit/Copy" and "Edit/Cut". 

• Shaving Pads 

A new command has been added which activates a tool for shaving pads ("Edit/Shave Pads"). It is a two 

step operation: first click on the pad to shave, then click at the edge of the desired shave (inside the pad). 

The width of the shave can also be typed while in the second step by pressing "X". This tool is useful for 

correcting occasional DRC/DFM errors. 

• Including the Frame in Printed Output 

An option has been added to the printing dialog to include the frame in the printed image. It is "Print 

Frame also". 
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11.0.47: 

• Export of Excellon Format 1 

An option has been added to allow selection of Format 1 or Format 2 export of Excellon files. Previously 

data was exported in Format 2 only. 

• G45-G48 Sieb & Meyer Export 

When exporting rout data, routing paths that are full circles will be exported using the G45 through G48 

commands as  follows: 

 G45 if the path is CCW and compensated Left 

 G46 if the path is CW and compensated Right 

 G47 it the path is CCW and compensated Right 

 G48 if the path is CW and compensated Left 

These commands are designed for exporting Holes (G45 and G46) and Cards (G47 and G48). 

• Netlist Extract and M Pads 

When extracting a contour netlist, custom pads (M shape) are converted to C shape pads before the ex-

tract is computed. This assures better results for midpoint computation and also generates better output 

files for the ETest products. The conversion is the same as can be done manually using "Edit/Edit Selec-

tion/Special/Convert M-type Pads to C-type". 

11.0.42: 

• Large Offsets in Gerber and Drill Files 

There are files where all the data is offset by a very large amount  which violates the CAM data limits of 

1000 inches (or 10m in metric). Now such data can be imported. One needs to use "File/Import/Guess" 

("F4") or "File/Import/Directory" for this purpose. 

11.0.28: 

• Easy Way to Align Reference Layers for NetCompare 

NetCompare works by comparing two sets of layers: the reference (REF) and the data to be tested (NUT). 

Occasionally the REF layers are offset from the NUT layers. There is a new command which aligns the 

REF layers when they are offset ("Edit/Move Layers XY Position/Auto-Align REF Layers"). This command 

will try to match the position of holes in the drill layer of the REF set with the drill layer of the NUT set 

(each set must contain a drill layer). If it finds a matching offset for the drill layer, the REF drill layer and 

all the other layers in the REF set are moved by that amount. This usually results in the data being 

properly aligned. 

11.0.22: 

• Printing in Screen Colors 

A new method has been added to the "File/Print" dialog: "Screen colors". This will print the image the 

same way it is displayed on the screen. Since the background of the image is black, this will waste a lot of 

ink when printing to paper, but it is useful when printing to files, such as PDF files. 

• Display of Rout Path Direction 

One can now visualize the the direction or orientation of routing paths. Arrows will be overlaid over the 

path to show the direction of the routing tool. This can be turned on or off using "Tools/Routing/Show 

Direction and Plunge". There is also a button for this in the routing toolbar. This command replaces the 

existing "Tools/Routing/Display X's at Plunge Points". X markers are still being displayed at plunge 
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points when this command is active, in addition to the arrows showing the direction. 

11.0.14: 

• Improved Computation of Compensated Rout Paths 

The computation of compensated routing paths has been improved. 

11.0.9: 

• Quick Way to Insert Round Polygons 

A new tool is available to insert round polygons It is "Insert/Circle/Polygon" and there is also a button for 

it on the "Insert" toolbar (shown as a filled circle). The operation takes two clicks: one for the center of the 

circle, the other for a point on the circumference. 

When the goal of the operation is to insert round pads, the "Insert/Pads" tool is preferable, but the insert 

round polygon can be useful when making corrections (filling in areas or scratching away unwanted cop-

per). 

11.0.1: 

• New Tool for Selecting a Set of Connected Elements 

“Select/Connected” is a new tool that allows selecting elements that are connected (touch or overlap). 

Once the tool is activated one can click close to an element and that element and all elements in that layer 

which are connected to it (either directly or indirectly via other connecting elements) are selected. This 

command works only on visible elements and ignores scratch elements. 

Possible uses for this command: 

 To generate a board outline. One can click next to one element in the board outline and all 

connected elements will be selected. This is most useful when traces in the outline do not line up 

perfectly on top of each other (they intersect or overlap). If one wants to generate a “correct” 

outline after such a selection is made, the “Edit/Trim Selected Traces” command can be used. 

 To check netlist connectivity. This is not really a netlist, because it only works on one layer and 

ignores scratch elements, but it can be helpful in the case simple designs. 

• Automatic Alignment of Drill Layers 

A new command (“Edit/Move Layers XY Position/Auto-Align Drill Layer”) aligns the drill layer (of type 

DRI or PTH) to a component layer (CPU or CPL). It will attempt the alignment by trying to match all 

plated holes in the drill layer to pads in the component layer. Each hole needs to be matched for this op-

eration to succeed, so the component layer needs to have at least as many pads as the drill layer. Only 

visible elements are considered. 

• Improved Setup of Via Layers for Netlist 

The setup of VIA type layers for Contour Netlist extract has been improved. A via layer needs only be 

present once in the stackup and one can specify which layers it crosses. Previously copies of the layers 

had to be made and placed in between any two circuit layers it crossed. This can save a lot of time when 

setting up jobs for netlist extract. The old method can still be used. There is an application note describing 

this in more detail at: ftp://ftp.pentalogix.com/Documents/AppNotes/Netlist/Via Layers and Netlist.pdf. 

• Netlist Export of Obrounds 

A new option has been added to control how obround pads are exported during contour netlist extract 

and export. These pads are exported as rectangles, but now the user has the option to pick the inscribed 

(smaller) or external (larger) rectangle. 

ftp://ftp.pentalogix.com/Documents/AppNotes/Netlist/Via Layers and Netlist.pdf
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10.6.71: 

• Improved DFM 

A new command has been added to the “DFM” menu: “DFM/All Violations”. This allows for spacing and 

width violations to be run at the same time and also has a new set of rules for drill related violations (an-

nular ring and clearance). 

• A Quick Way To Insert A Rectangular Polygon 

“Insert/Rectangle/Polygon” will insert a rectangular polygon. The user can pick the two corners of the 

rectangle. This can be used as a quick way to make corrections to a design by filling in (inserting a paint 

polygon) or deleting (inserting a scratch polygon). 

• Order of 90-degree Trace Pair 

When inserting 90-degree trace pairs (“Insert/Special Linear Trace/90 Degree Trace Pair”) one can toggle 

the orientation of the first trace with the Shift key. Previously the first trace was always horizontal. 

• Dimensioning Improvement 

When inserting orthogonal (horizontal or vertical) dimensions (“Insert/Dimension”), the choice between 

horizontal and vertical is now made from the location of the third picked point (for the text position). Pre-

viously this was determined from the endpoints of the measurement (the first two picked points). 

• Export Warning for Small Apertures 

A warning will be generated when exporting Gerber 274X files with apertures smaller than a user speci-

fied value. This option can be turned on or off in the export “Options” dialog. It replaces the warning for 

exporting zero-width apertures (one can still get it by setting the “smaller than” aperture dimension to 0). 

10.6.50: 

• Layer Names Shown in Layers Toolbar 

The Layers Toolbar (“View/Toolbars/Layers”) now shows the layer names also in addition to the layer 

number and color. The name appears to right of the color box, so one needs to widen the toolbar to show 

as much of the layer names part as desired. 

One can widen the layers toolbar by dragging the right edge with the mouse. Once set to a new width 

that width will be remembered. It is a user preference as to how much screen space one wants to give up 

to display layer names. 

• Improved Width Violations Detection and Automatic Correction of Slivers 

“DFM/Feature Size Violations” operation has been improved. It is now faster and reports more violations 

(previous algorithm reported only one violation per copper area). 

A new feature has been added as well: if slivers are not being ignored, then one has the option to correct 

them during the review process by pressing “Correct” or “Correct All”. Slivers often appear in negative 

plane layers. A sliver is a small piece of copper for which the maximum dimension is smaller than a user 

specified value. 

• Inserting Arc Chamfers of Given Radius 

A new command has been added to allow inserting arc chamfers of a fixed radius, specified by the user: 

“Insert/Chamfer of Radius”. The chamfer is added at the joining point of two linear traces. After the tool 

is activated, the user needs to click close to this joining point and an arc chamfer is inserted. 
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• Showing Scratch Elements in Contrasting Color 

There is a new command to set the display mode so that is shows scratch elements as paint in a con-

trasting color. This is sometimes useful when trying to understand the paint-scratch setup of a layer. Note 

that this works only on combined (mixed-polarity) layers and not on whole layers that are marked as 

scratch. 

The shortcut to toggle the mode is “Ctrl+H” and the command can also be found in the “Setup/Visibility 

and Display” as “Scratch contrast”. 

• Intersection of Two Layers 

A new command to compute and generate the polygons that result from intersecting two layers. The in-

tersection is defined as the areas where both layers have “copper”. One of the layers (the current layer) is 

replaced with the polygons that result from intersecting it with another layer (the user is prompted for 

the other layer). 

10.6.34: 

• Tool for  Inspecting Net Midpoints / Endpoints 

The tool is “Tools/Netlist/Inspect Midpoint Stackup”. After it is activated, one can click at a pad location 

and the status line will show the midpoint/endpoint state of the pads at that location in the layers CPU, 

CPL and DRI or PAD. The netlist information must have been previously imported or extracted in 

CAMMaster (with the identify midpoints option checked). 

• Marking a Midpoint 

A new tool to insert a marker at the midpoint between two points picked by the user. These two points 

are usually picked by aligning to elements, but the tool is general purpose. It is activated with “Go/Mark 

Midpoint”. It stays active until canceled. Useful for creating reference points when constructing complex 

geometries. 

10.6.30: 

• Comparing Groups of Layers 

The command “Tools/Compare Layers/Find Differences” can now compare two groups of layers (layer 

by layer). Each layer in the first group is compared against a corresponding layer in the second group. 

This makes it easier to compare different versions of the same job. If you need to compare two jobs (or 

two sets of layers) and want the dialog to be set up automatically with the proper ranges, load the first job 

then leave one or more blank layers and finally load (import) the second job after the blank layer(s). The 

layer compare dialog will be set up so that the two ranges to compare will show correctly. 

One can still compare just two layers at a time, like in the past. One can also manually enter the layers to 

compare into the dialog boxes. Note that only visible layers will be compared. 

• Determining Board Area 

The Routing Path Properties dialogs now have a new item called “Enclosed Area”. This is the size of the 

area of the internal region of a closed routing path (the area that is cut out by the path). For the outermost 

path, this is the area of the board. 

Tools that show this dialog are “Tools/Routing/Selection Properties” and “Tools/Routing/Properties 

Tool”. If the data applies to more than one path, then the sum of all enclosed areas is shown. 

• Improved Break Tabs 

Two new features have been added to the routing break tabs setup dialog (“Tools/Routing/Insert Break 

Tabs”). 

1) “Distributed by Distance” as a method for adding multiple tabs in one step: this will compute the 
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number of tabs that fit equally spaced given the user specified “Distance between Tabs” and then 

generate that many tabs. 

2) New way of generating perforations (mouse bites): 

a) The holes are now offset from one of the edges. They used to be situated on the center-

line of the path. The offset distance can be specified by the user and the side is picked by 

clicking close to one of the two sides of the routing path. Negative offsets move away 

from the center-line of the path, positive offsets towards the center-line. 

b) The number of holes that result can be specified one of two ways: 

- by entering it directly as the desired number of holes in the dialog or 

- by entering the desired gap which will result in the number of holes being computed 

from the geometry of the setup. 

Geometries like the one shown below can be easily generated: 

 

• Net Midpoint Info 

The command “View/Info/Elements Overlapping Cursor” (also available in the context menu – mouse 

right click over the view) will now also show the midpoint/endpoint state of a pad (if net info is present 

in the job). This facilitates checking the midpoint/endpoint state in a layer stackup at a given point. 

• Faster Netlist Midpoint Computation 

Contour netlist midpoint computation is now significantly faster, especially for jobs with many inner lay-

ers. 

10.6.0: 

• New Method for Correcting Self-Intersecting Polygons 

When the input data contains self-intersecting polygons, they need to be corrected so that they can be 

used in later steps of the CAM process. This correction can happen when the data is imported (the user is 

prompted for doing the correction during the import) or can be done later on selected polygons (with 

“Edit/Edit Selection/Polygons/Make Well Formed”).  This existed already in previous versions of the soft-

ware. This version adds a new correction method. There are now two methods available, which can be 

picked by the user via the command “Setup/Self-intersecting Polygon Correction”. These two methods 

are called: 

 Even-odd method 

 Non-zero fill method 

It is easiest to understand what they mean by looking at the images in the dialog used to pick the method. 

The most common method (and the only one previously available) is the “even-odd method”. However, 

some software packages generate polygons that need to be corrected using the “non-zero fill method”. 
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• New Command to Select Electrically Connected Elements 

This command is a selection tool. Once active, one can click on an element and all elements that are elec-

trically connected to it, through all layers, are selected. The command to activate the tool is 

“Tools/Netlist/Select Electrically Connected Elements”. When first activated, it will extract the netlist in-

formation for the currently loaded job. All conductive layers will be considered, whether visible or not at 

the time the tool is activated. This means layers of type SIG, CPU, CPL,  all power and ground layers,  

DRI, PAD, PTH, VIA and VID. If you have other layers that should not be considered in the computation, 

you should make sure that they have a different type. If they are “work layers”, map them to OTH or 

NFL. 

Once the netlist info is extracted, the tool can be used repeatedly until modifications are made to the data-

base, when the netlist will again be extracted (automatically) to match the changes made. 

To make it easier to select elements, board layers that are negative or of mixed polarity (paint and scratch) 

will be converted to polygons while this tool is active. They will be restored to their previous state after 

the tool is deactivated. 

An application note describing this command in more detail is at: ftp://ftp.pentalogix.com/Docu-

ments/AppNotes/Select Connected Copper.pdf. 

• Polarity Combine / Separate Improvements 

The operation of the commands which separate layers of mixed polarity or combine layers (“Edit/Paint 

and Scratch”) has been improved. The layer stackup of layers which are not involved in the operation is 

preserved. Previously, empty layers were eliminated during “Combine All”. 

Undo has been added to all the operations in this group. 

10.4.31 

• New Tool Type 

For NC tools (D Codes of shape “N” and “Setup/Tool Codes”). The tool type is “Rout”. It is intended to 

be used for routing paths, to differentiate from other tool types. The other types are: “Plated”, “Non-

plated”, “Tooling”, ‘”Via” and “?”. Note that .bin files containing such tool types cannot be opened by 

older versions of the software. 

• Deleting Holes from D Code Shapes 

A new command has been added to the “Setup/D Codes” (F5) dialog. It is “Operations/Remove Holes”. It 

will remove holes from all D Codes which have holes. This includes standard shapes with holes, like C 

(an annular ring), and custom shapes also (M). The operation works on the D Code (or D Codes) selected 

in the dialog (shown in blue background). 

• Drill Path Sorting and Viewing 

New commands have been added for viewing the path (order of holes) of drill holes in a drill layer and 

for sorting the holes. 

“Tools/Drill/Show Path” will display the path, given the current order of the holes. A dialog is displayed 

that allows navigating the path. 

“Tools/Drill/Proximity Sort” and “Tools/Drill/Serpentine Sort” will sort the holes according to two sort-

ing methods. 

 “Proximity Sort” will start from the lower left corner of each tool area and then continue to the 

next closest hole until all the holes of that tool are visited. 

 “Serpentine Sort” will sort in a serpentine fashion (in bands or strips). 

Usually “Proximity Sort” will generate a better result, but this is not guaranteed. 

Notes on drill holes order: sorting is best done just before exporting the drill files, because the order can 

be disturbed by later editing operations and even by selecting and deselecting elements. 

To specify first and last holes for a tool number the recommended method is to separate the drill holes 

ftp://ftp.pentalogix.com/Documents/AppNotes/Select Connected Copper.pdf
ftp://ftp.pentalogix.com/Documents/AppNotes/Select Connected Copper.pdf
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into adjacent layers and then export with the “Combined” method. 

For instance, if one has holes for tools T1 and T2 in layers 1, 2 and 3, when exporting the three layers to-

gether as “Combined” the order would be: 

holes of tool number T1 from layer 1, then T1 from layer 2, then T1 from layer 3, followed by T2 from 

layer 1, then T2 from layer 2 and finally T2 from layer 3. This way has the additional advantage that one 

can easily see the order of holes via the layer colors. 

If there are routing paths in the layers exported they will be exported after the drill data. The only excep-

tion is when exporting “Combined”. Then one can have routing paths in layers preceding any layers with 

drill data and these will be output first. 

• Perforations for Routing Path Break Tabs 

“Tools/Routing/Insert Break Tabs” has new options for inserting perforations (also commonly known as 

mouse bites). The parameters currently available are shown below: 

 

 

• More Components Information 

A new command has been added to display component related text, when such information is available. 

It is “View/Info/Components Text”. Currently this information is extracted when importing ODB++ files 

(if they contain components information). 

10.4.30 

• Dragging the view 

The view can be dragged by holding the mouse left button down and dragging. This has been available 

for some time in our software but required holding down the Ctrl and Alt keys while dragging. We have 

now changed the code so one can drag without Ctrl and Alt being pressed. This will work only if no com-

mand-tool is active, such as Select or others. If a command-tool is active then pressing the left mouse but-

ton will activate the command and to drag one needs Ctrl and Alt pressed. Note also that if you want the 

view to be dragged in real time, you need to enable it with “Setup/Preferences/Draw View In Real Time”, 

otherwise the view will only be updated at the end of the drag. When there is a lot of data in the current 

job dragging in real time may cause flickering because it takes longer to redraw each intermediate step. 

• Export Rout and Drill combined 

The “File/Export/Rout” commands have been removed. Rout files can now be exported with “File/Ex-

port/Drill & Rout”. Any layers that have rout paths and are exported with this command will generate 

rout data in the output. This allows combining drill and rout data into the same file. 

When files are exported with the “Layer by layer” method, each layer generates a separate output file in 

which drill holes are exported first followed by routing paths. 

When files are exported with the “Combined” method, the data in all the layers is output into one file. 

The following rules apply to the order of the output for the selected layers: 

If some starting layers in the group of layers to output have only routing paths, then those paths are out-

put first. 
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For all the following layers drill holes are exported first. They are ordered first by tool number and then 

(within the same tool number) by layer numbers. This is an easy way to separate (for a given tool) holes 

that one wants to drill first and last. 

At the end come all the routing paths found in all the layers other then the ones from step (1). They are 

ordered by their precedence number. Paths which have the same precedence will be further ordered by 

their tool number and for the same tool number, by the layer number. 

• Improved ODB import 

More support for new features in ODB++ V7.0. 

10.4.0: 

• Copy, Cut and Paste 

The standard Window commands for copy, cut and paste have been implemented, with the usual 

shortcut keys: Ctrl+C, Ctrl+X and Ctrl+V. They are in the “Edit” menu and have buttons in the main 

toolbar. 

Copy and cut work on the selection, so one first needs to select elements. They both copy the selection to 

the Windows clipboard and cut also deletes the selection (similar to “Edit/Edit Selection/Delete”). Later 

on, the clipboard data can be pasted (into the same program or another instance of this program or an-

other PentaLogix CAM package). The data will be pasted into the same layers where it was originally, but 

the location (X, Y) can be different. The rule is that the position of the cursor over the selection when the 

copy was done (copy or cut) will match the position of the cursor when the paste is done. So a cut and 

paste can be used to move selected data from one (X, Y) location to another: select, position cursor, cut, 

move cursor, paste. 

• Pasting CAM Images Into Documents 

The current view can be copied to the Windows clipboard using “View/Copy View To Clipboard”. The 

resulting image can then be pasted in a variety of documents, such as a Word file, an email etc. without 

needing a screen capture program. 

• Button Names for “Favorite Commands” Toolbar 

Buttons in the Favorite Commands toolbar can now be given names in addition to mapping them to bit-

map images. After right-clicking on the button, the new option is called “Change Text”. Another new fea-

ture of the Favorite Commands toolbar is that the first nine buttons can be activated with shortcuts: Alt+1 

through Alt+9. And finally, the button sizes have been increased from 16 by 16 pixels to 24 by 24 pixels to 

make it easier to generate bitmap images for the buttons. 

• Alphanumeric Net Names 

An option has been added to export alphanumeric net names (instead of net numbers) in IPC files 

(“Tools/Netlist/Extract Contour”). The option is in the “Export” tab and is called “Net numbers output as 

N<number>”. This will cause, for instance, net “223” to be output as “N223”. There are apparently certain 

software packages which do not like net names that contain only digits. 

10.2.71: 

• Toolbar for Favorite Commands 

“View/Toolbars/Favorite Commands” displays a customizable toolbar for favorite commands. This is 

useful for often used commands which are nested deep in the menu structure and can be accessed 

quicker this way. The toolbar is described in more detail in the document: “Favorite Commands 

Toolbar.pdf”. Look for it in the installation folder or on our FTP site (ftp.pentalogix.com/Documents/Ap-

pNotes). 
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10.2.45: 

• Routing Toolbar 

A new toolbar has been added with many commands for creating and editing routing paths. 

“View/Toolbars/Routing”. 

• Routing Tabs (Break Tabs) 

A new command to insert break tabs into a routing path (“Tools/Routing/Insert Break Tabs”). It activates 

a tool that can be used to insert one or many break tabs at the spot where the user clicks on a routing 

path. The parameters for this operation are shown below: 

 

 
 

• Short Edges in Routing Paths 

The routing path property dialogs for the “Tools/Routing/Selection Properties” and “Tools/Routing/Prop-

erties Tool” have a new item called “Shortest Edge”. This will display the length of the shortest edge in a 

path or a collection of paths. Short edges (straight or arc) can cause problems with certain routing ma-

chines. 

• Easy Way to Navigate Selected Elements 

A new command (“Select/Navigate Selection”) has been added to allow for easy navigation of the cur-

rently selected elements. It brings up a dialog with the usual “Next” and “Previous” buttons that allow 

for easily stepping over all selected elements. 

Note that if one changes the selection while the navigation dialog is shown, the new selection will not be 

reflected in the dialog (one needs to close and reopen the dialog). 

• Finding Intersecting Traces 

A new command to select traces that intersect at points which are not their endpoints (traces which 

cross). The command is “Select/Intersecting Traces”. Only active elements will be considered, so the 

“Only” check-marks etc. will be taken into account. This command is useful as a DRC check. 

• Shortcut for Selecting Crossing Elements 

A new shortcut has been added for toggling the selection of elements which cross the frame. This shortcut 
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is “Ctrl+Shift+S”. The button is in the Selection toolbar. 

• Stencil Improvements 

The stencil module (“Tools/Stencil Apertures” ) now works on all pad shapes, not only rectangles (except 

for the homebase, which can only be applied to pairs of rectangular pads). 

An example for “Windows” is shown below: 

 

 

• Export NC Rout Files 

 A new option has been added to output F commands. The F command defines the worktable feed 

rate (or routing speed). 

 For export Excellon a new option has been added to turn on or off the output of G90/G91 

(absolute/incremental coordinates) and M71/M72 (metric/English) commands. Some routing 

machines have trouble accepting these commands. 

10.2.18: 

• “Edit/Edit Selection/Polygons/F To Polygons” 

A new user option has been added “Path can continue at overlap”. If checked, will enable special pro-

cessing of overlapping traces, so that a contour can continue at vertices where traces overlap. If not 

checked, will force contours to use the traces as they are. 

10.2.0: 

• New Commands For Trimming Traces 

These are commands for correcting pairs of traces that either are close to each other at endpoints (but do 

not connect) or overlap slightly at endpoints. These situations sometimes arise because of rounding errors 

in the CAD output or inexact manual insertion of traces. 

The two types of problems (“Connect” and “Clip”) and their corrections are illustrated below: 

 

 
 

 

 
 

 
 

These problems can be corrected in one of the following ways: 

by picking the two traces (with a mouse click or the Enter key). This is “Edit/Trim Traces” and acts as a 

tool (it stays active until the user cancels it). 
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by first selecting all the traces that one wants to correct and then issuing the command “Edit/Trim Se-

lected Traces”. A dialog comes up to allow the user to specify which operation is to be done: “Connect”, 

“Clip” or both and a parameter which determines how far apart the endpoints can be for connecting. 

There is a button for the tool version of the command in the “Edit” toolbar. 

Both linear and arc traces can be trimmed. 

• Converting Negative Layers To Positive 

Negative layers can now be converted to positive by using paint and scratch. A paint polygon (or several 

paint polygons) will be inserted before all data to represent the background copper and then the polarity 

of elements in the original negative layer will be changed so that the result looks the same. 

If the data on the negative layer contains the board outline, it will be used to generate the background 

copper polygons. Otherwise the frame will be used for this purpose, so it needs to be positioned before 

the operation to surround all data on the layer. 

This operation is useful if one later needs to combine negative and positive data in a panel. 

The new commands are: 

“Edit/Convert Negative To Positive”: allows the user to specify which layers to convert 

Right click on layer in the Layers Toolbar, then “Convert To Positive”: converts the picked layer only 

• “Insert/Into Layers” 

A new command to allow users to specify the layers where new elements will be inserted using the “In-

sert” commands. The user can pick one of two modes: 

 Active Layers 

This is the same as insert used to work previously. Elements will be inserted in the active layer or 

active layers depending on the state of the “Only” check-mark for the current layer (in the 

Current Element toolbar). 

 Specified Layers 

User can specify the layer (or layers) where elements will be inserted. Changing the current layer or the 

“Only” check-mark does not affect where the elements are inserted. This new mode allows, for instance, 

to insert into one layer while aligning to elements in another layer. 

In both modes, the layers that will receive elements will be marked with a “>” before the layer number in 

the layers toolbar. Since more room is needed now for displaying the layer number text, the color box will 

be narrower, but one can adjust that by widening the layers toolbar (drag the right edge of the toolbar). 

• “DFM” 

New DFM commands have been added. They are in a top-level menu called “DFM”. 

The new commands are for spacing and feature width (copper width) computation. There are commands 

to determine minimum spacing and width and commands to find spacing and width violations. 

All of the commands allow the user to pick the layers which will be inspected and also whether the in-

spection is to be done only inside the frame or in the whole layer. Inspection is done only on visible ele-

ments, so one can further limit the scope of the operation by making certain elements invisible (for in-

stance one can make pads invisible prior to starting one of these DFM operations). 

The commands are: 

 

“Find Minimum Feature Size” 

Will find the minimum width (feature size) of copper on a layer. Only one minimum width will be re-

ported per layer, so, if it appears in several spots on a layer, an arbitrary one will be picked. 

 

“Find Minimum Spacing” 

Similar to “Find Minimum Feature Size”, but will find the smallest spacing between two different copper 

areas in one layer. Spacing between parts of a connected area of copper is not taken into consideration. 
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“Feature Size Violations” 

Checks for feature size (width) violations: locations where the copper width is narrower than a user spec-

ified value (“Feature Size”). There is an optional parameter for dealing with slivers (“Copper Sliver 

Size”). Slivers are narrow copper entities: areas of copper whose width does not exceed “Copper Sliver 

Size” at any point. If one does not want to deal with slivers as a special case, one can set “Copper Sliver 

Size” to 0. 

There are three modes for this DFM check: 

“Check for feature size violations and ignore slivers” 

This will silently ignore slivers and check for width violations only on the remaining (non-sliver) areas. 

“Detect slivers only” 

This will only look for slivers and report where they are. Corrections are provided, which erase the sliv-

ers. 

“Check for both” 

Slivers are detected and corrected (as in the second method) and width violations are reported on the 

other copper areas (as in the first method). 

 

“Spacing Violations” 

Checks for spacing violations: locations where the space between two distinct copper areas or edges of 

one copper area is smaller than a user specified value. 

Violations of the second kind (same copper area) are called acid traps or resist slivers. They are further 

separated into two kinds, open and closed, each with a separate spacing violations distance. Examples of 

the two kinds are shown below: 

 

Open Closed 

 

 

 

 
 

The algorithm will generate a correction for the acid trap which will fill in the opening. 

For open acid traps the user can specify an additional parameter: an aspect ratio. It is a number between 0 

and 1. Making the number smaller (towards 0) will limit the detection to more elongated acid traps. Mak-

ing the number larger (towards 1) will allow less elongated violations to be detected as well. Below are 

examples of corrections (white areas) with various values for the aspect ratio constant: 

 

0.1 
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0.35 

 

 
 

0.8 

 

 
 

 

• “File/Open Options” 

Groups options that apply to “File/Open” (reading in .bin jobfiles). 

“Ignore Preferences From Jobfiles” existed previously but was located in “Setup/Preferences”. 

“Do Not Restore Custom Colors” is a new one and will cause the software to ignore custom color defini-

tions (RGB) from jobfiles. This helps users who want to always preserve their own custom color setups 

(done with “Setup/Layer/Colors” -> “Redefine Color”). 

• New Option For Selection 

A new user-settable option has been added to enable the selection using a frame of elements which cross 

(intersect) the selection frame. When this option is off, only elements which are completely inside the 

frame are selected (this was the previous behavior of the software). 

The option can be found in “Select/Options” and is called “Select also elements that cross the frame”. 

There is also a button for this in the Selection Toolbar (“View/Toolbars/Selection”). It has been added next 

to the “Inside” button. 

• Routing Paths Length 

In “Tools/Routing”: “Selection Properties” and “Properties Tool” will display the length of the routing 

paths in addition to the other information. This makes it easy, for instance, to determine the total length 

of all routing paths. 

• “Tools/Netlist/Find Path Connecting Two Holes” 

A new command to trace the path (through copper) connecting two holes from the drill layer (or padmas-

ter layer). Copper connectivity through all visible board layers is considered. At the end, a dialog appears 

with text that shows how the path goes from the first point to the second point. 

Before activating this command the layers need to be set up as if for a contour netlist extraction, with all 

board layers that are to be considered made visible. Also two holes need to be selected in the drill layer 

(DRI) or padmaster layer (PAD) and the selection must contain only these two pads. The command will 

compute the connecting path between these two points. 

The current implementation does not yet take into account via layers, but that will be implemented in the 

near future. 

This command is very useful for finding where two nets short. Visual inspection is sometimes difficult 

when the net crosses many board layers. 
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When the command is first executed, the algorithm computes copper connectivity for the whole data. 

This can take some time. Once computed, this info is stored and does not need to be recomputed for sub-

sequent invocations of this command (unless the job data is modified). The polygons used in the compu-

tation can be visually inspected by using the command “Tools/Netlist/Import Copper Polygons” (this 

command is also available after a contour netlist extract). 

• “File/Import” (“Guess”, “Directory” and “Zip”) 

 the interpretation of the format of Gerber files has been improved. 

 for Sieb & Meyer drill files: the format guessed (or set by the user after the guess) will override the 

format implied in the Sieb & Meyer file (for instance format %%3000 automatically implies 

metric, trialing zeros, 3.3 and this can now be overridden). 

• “Setup/Frame/Surround All Data” (Ctrl+W) 

State of “zero-width” display (“O”) is taken into account when computing the size of the frame. 

• “Tools/Stencil Apertures” 

The shape computation has been improved. 

• “Tools/Snap To Padmaster” 

Traces could be deleted when both endpoints were snapped to the same point. The algorithm has now 

been changed so in cases like this only one of the endpoints will be snapped. 

• “File/Export/Rout” 

Compensation commands (G40, G41 or G42) are now output before each path. They were previously out-

put only when the compensation kind changed, but the Excellon G00 command turns compensation off, 

so that compensation needs to be re-output after each G00. 

10.0.30: 

• “Tools/Netlist/Extract Contour” 

An option has been added to allow the user to pick how the midpoint state of drill holes is computed. 

This only applies to drill holes which have covering pads on both the CPU and CPL sides. First the mid-

point state of the CPU and CPL pads is computed and then the midpoint state of the drill hole is deter-

mined based on the user picked choice: 

 “Drill hole is mid when BOTH are mid”: the drill hole will be marked as a midpoint only when 

both the CPU and CPL pads are midpoints. 

 “Drill hole is mid when ANY is mid”: the drill hole will be marked as a midpoint when either the 

CPU or the CPL pads are midpoints. 

10.0.26: 

• “Tools/Convert Drawn Pads/Global” 

The algorithm has been improved. 

10.0.10: 

• Shortcut keys for Layers Toolbar 

An option has been added to enable shortcut keys for the layers toolbar. This is in the layers toolbar con-

text menu and is called “Shortcuts enabled”. Shortcuts were removed a few versions back because they 

were deemed dangerous, as they have a different meaning than the same shortcuts in the main view. 

However, some users complained and wanted them back so now they are restored (if enabled by the 
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user). 

The shortcut keys available are the same as in the past: “V”, “N” and “S”. Note that “V” and “N” work on 

the whole board layer, just as in the past. 

10.0.1: 

•  “Edit/Move Layers XY Position/Move Layer Tool” 

A new tool has been added to facilitate layer alignment. The command will activate a tool which consists 

of two steps: 

First the user picks an element in the layer that he desires to move. This is done by moving the crosshair 

close to the element and then clicking (or pressing Enter), similar to how one selects an element. 

Next the user picks the corresponding element in another layer the same way as in the previous step. 

At this point the layer of the first element will be moved so that the first element is now on top of the sec-

ond element (and hopefully the layers are aligned).  The whole cycle can then be repeated again for mov-

ing another layer. When done, press Escape to cancel the move layer tool, or deactivate it by clicking on 

its menu entry.  This command has the shortcut key combination Ctrl+Shift+Q. 

• Explicit Units 

All the dialog items that refer to a coordinate or a dimension now accept numbers followed by optional 

units, independent of the current units in use.  For instance in the “Move Cursor To” dialog box one 

could enter “2.3cm” for X, even though the current units may be “inch”. This would cause the cursor to 

move to 0.905512 inches. The acceptable values for the units are the same as the ones shown in the “Coor-

dinate Units” box: “inch”, “mil”, “cm” or “mm” or any prefix of them which is unambiguous (for in-

stance “in” or even “i” will work instead of “inch”). 

• “Setup/Preferences/User Confirmation For” 

Confirmation for dangerous operations.  A new group of preferences that can be turned on or off. When 

on, they will cause the corresponding operations to prompt for user confirmation before they are done. 

Currently two such operations covered: 

 Delete Selected: will prompt for “Edit/Edit Selection/Delete” 

 Drag And Drop Layers: will prompt during a drag and drop in the layers toolbar 

These are intended as a safety feature to protect against unintended operations, especially since “delete 

selected” has a shortcut key (Delete) which can easily be pushed by accident. 

More such operations can be added in the future. Please let technical support know which you would like 

added. 

• “Setup/Preferences/Wheel Forwards Decreases Zoom” 

User preference For those who are used to have the zoom decrease when the mouse wheel is moved for-

wards and increase when the mouse wheel is moved backwards. 

• “File/Export/Drill” and “File/Export/Rout”, G93-type offsets 

A new option has been added for Excellon export to cause the software to output a G93 (Zero Set) com-

mand at the beginning of the file (or the equivalent M49,FA for Sieb and Meyer). It is in the “Options” 

dialog, under “Output Options” and it is called “Offset”. When turned on, a G93 will be output at the be-

ginning of the file. The value of the offset is taken from the current cursor position, so if you want accu-

rate values, best to disconnect the mouse from the crosshair cursor when activating the dialog. Note that 

the G93 will be output even if both the X and Y are 0. 

• “Tools/Clip Silkscreen Traces”, new method 

A new method has been added for correcting silkscreen clearance errors. This method inserts scratch pol-

ygons into the silkscreen layer to scratch away from interfering silkscreen elements. The old method, 

which clipped the traces, is still available. The method can be selected by the user in the operation dialog. 
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• New Shortcut Key (Ctrl+Shift+U) 

To return to last selection criterion picked previously. This is most often picked from the droplist in the 

Selection Toolbar (“Any”, “Pads”, etc.). There are many different criteria in that list and many times one 

wants to alternate between having one particular criterion picked, say “Polygons” and not having any-

thing picked (“Any”). With this new shortcut one can do this from the keyboard only. After picking a cri-

terion ,“U” will pick “Any” and “Ctrl+Shift+U“ will bring back the criterion picked before. 

• “Edit/Move Layers XY Position/Move By Displacement” 

This command has been improved to make it easier to align layers. Previously the command dialog in-

cluded only the X and Y displacements and it moved the “active layers” (as determined by layer visibility 

and by the “Only” button next to the current layer in the Current Element toolbar).There are two im-

provements to this command: 

 One can now pick the layers to move in the dialog. There is a text box where one can type in a 

comma separated list of layer ranges, such as “3, 7-9, 15” (one can also type “All” here). This list 

is initialized to the currently active layers, so that the command acts as before if the user leaves 

the layers text box alone. 

 The X and Y displacements in the dialog are initialized to the result of the most recent distance 

measurement command (if any). This allows the user to previously do a distance command (“D”) 

to set the move displacement. 

• “Tools/Netlist/Extract Contour”, improved midpoint algorithm 

The algorithm for determining midpoints has been redesigned. The new algorithm is both significantly 

faster and also more accurate in determining midpoints and endpoints. 

• “Setup/D Codes” (F5), custom shapes 

Custom shapes (M-type) setup dialog: now has two added buttons, “Import” and “Export”. These will 

import/export to/from Gerber the current custom shape. These commands were available previously as a 

separate step in the “Custom Apertures” menu of the main dialog, under “Import From File” and “Ex-

port To File”. The addition of the new buttons saves some operator steps. 

• “Select/By Intersection”, new option 

A new option has been added: “Check only elements at the same polarity level”. When on, only elements 

that are of the same polarity (paint or scratch) are checked against each other and also only when they are 

at the same level in the paint/scratch sequence. So, for instance, an element in the second paint group of 

the destination is only checked versus elements in the second paint group of the reference. When one 

wants all elements checked against all other, this option should be left unchecked. 

• “Edit/Edit Selection/Polygons/F To Polygons”, algorithm improved 

Three options have been added for handling polygon holes (when nesting is requested). 

“Holes cannot overlap”: if two holes overlap one of them becomes a container 

“Overlapping holes are merged”: two overlapping holes are merged to make a larger hole 

“Overlapping holes not merged”: the overlapping area of two holes becomes a new container 

• “Edit/Edit Selection/Special/Convert M-type Pad to C-type”, improved 

The placement of the resulting C-type pads has been improved. When possible, they will be placed at the 

center of the M-type pads. 

• “File/Import/Netlist” 

When the “Add feature (if present in 317)” is checked the feature pad will be added to the CPU and CPL 

layers. Previously they were added to the DRI layer. 
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• “File/Import/Guess-Directory-Zip” 

 Now supports the Excellon format for decimal placement (000.000).  

 The results dialog has been changed. 

 The leading, trailing, all present, decimal present radio buttons will enable/ disable the ‘m’ and ‘n’ 

labels in a similar way that the Import/Drill & Rout/ options  dialog behaves. 

 If the size the user selects creates a coordinate value outside the 1000 inch, 1000 cm limit, an error 

is reported and the “OK” button is disabled. 

 Files with no data (drill with tool sizes but no drill data) will now report the board size as “0 x 0” 

instead of “No Data Found”. 

9.8.70: 

• Drag and Drop in Layers Toolbar 

One can now drag and drop layers to reposition them. In the layers toolbar click on a layer and drag it to 

the desired spot. The insertion mark will be shown before the layer where the drop will occur. The num-

ber (and name) of the layer being dragged can be seen in the status line. 

• New shortcut keys (accelerator keys) 

 Ctrl+Space: for the main view context menu (or mouse right-click) 

 Ctrl+Shift+F10: for “View/Visibility/Layers/Only Visible”. This is a command that allows making 

visible just a group of layers (a comma-separated list of ranges). 

• “File/Import/Gerber” – “Options” 

A new option has been added to the “File Interpretation” tab: “If data follows M02”. It has two possible 

options: “Make new layer” and “Same layer”. 

This applies to the (rare) cases where a file has a Gerber M02 command (End Of Program) followed by 

more Gerber data. If “Make new layer” is picked, the data that follows is put into a new layer. This is the 

more common setting (and the behavior of previous versions of the software). Sometimes, when the data 

that follows belongs to the same layer (and perhaps starts with scratch elements), the “Same layer” set-

ting gives the desired results. 

• D Code Size Rounding 

In “Setup/D Codes” (F5), the “Operations” menu has a new rounding item. In addition to the existing 

“Round to closest mil” (or “Round to closest 0.01 mm” in metric mode) there is now “Round to closest 0.1 

mil” (or “Round to closest 0.1 mm” in metric). 

•  “Select/Large Pads” 

Will selects pads (in visible layers) which have at least one dimension larger than a user given value. This 

is useful for selecting pads that are really large copper areas (not component landings). These pads can 

then be replaced with polygons so that they do not interfere with netlist export and other commands that 

work specifically on pads (like delete unused pads). 

• “Edit/Edit Selection/Paint And Scratch/Raise To Top” 

A new command that deals with the paint/scratch order of the selected elements. This command will 

change the polarity order so that the selected elements will be above (on top of) all the unselected ele-

ments (layer by layer). All paint elements in the selection remain paint and all scratch elements remain 

scratch, just that they will come earlier in the paint/scratch order when all elements in a layer are consid-

ered. They will be “promoted” on top of everything else and hence guaranteed to be visible. 

• “Edit/Edit Selection/Polygons/F To Polygons” 

A new option has been added to facilitate processing of complicated drawings. It is “Allow Intersecting 
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Holes”. This option is only relevant when “Nest Polygons” is checked. It allows for intersecting holes and 

will merge them to make combined holes. 

• “Tools/Netlist/Import Copper Polygons” 

This command is available only after a contour netlist extraction has completed. It will import (into 

empty layers) polygons for the relevant copper layers used in the netlist extract. The polygons will have 

the correct net numbers. It is often more convenient to examine connectivity using these polygons (espe-

cially for negative layers and layer with filled areas) because there are fewer elements to consider and (in 

the case of negative layers) elements do not represent copper and so will not get net numbers. 

• “Setup/Frame/Surround All Data” (Ctrl+W) 

A new option has been added “Consider scratch elements also”. When unchecked, scratch elements will 

not be considered in the computation. When checked, scratch elements are considered the same as if they 

were paint (this was the previous behavior of this command). 

• Mapping D Codes to N-type shapes 

The user interface for re-mapping non-N shapes to N-shapes in “Setup/D Codes” (F5) has been improved. 

•  ”File/ Import/ ODB++” 

Importing component and Netlist data has be re-enabled. 

•  “Tools/Netlist/Extract Contour” 

The adjacency computation is now significantly faster. 

9.8.50: 

• New Layer Types 

The following new layer types have been added: 

PTH Drill – Plated Through Hole 

NTH Drill – Non plated Through Hole 

BLI Drill – Blind vias 

BUR Drill – Buried vias 

ROU Routing – generic 

RPE Routing – external plated 

RNE Routing – external non plated 

RPI Routing – internal plated 

RNI Routing – internal non plated 

PLA Plating 

SCG Scoring 

• “File/Import/Gerber” - “Options” – “File Interpretation” 

 “Zero-Length Draws”: an additional option has been added: “Ask”. Previously there were only 

two possibilities: “Make pads” and “Ignore”. Now there are three: “Make pads”, “Ask” and 

“Ignore”. 

“Make 

pads” 

A pad will be generated to replace the zero-length 

trace 

“Ignore” Zero-length draws will be ignored 

“Ask” The user will be prompted and given one of the 

above choices 

 “End of Block Characters”: an additional option has been added: “Auto”. When “Auto” is 

selected, the software will try to determine which the proper setting is for the file being 
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imported. 

• “View/Grid/Display Grid” (G) 

The grid points are now rendered with 5 pixels. The previous 1-pixel grid was difficult to see on high res-

olution monitors. 

•  “File/Import/Guess- Directory- Zip” 

 HPGL- recognition has been improved. 

 IPC-D350/ IPC-D356 – now searches in the comment areas to determine type. 

 “Tool diameters use opposite units”- check-box has been added to the results dialog for drill 

files. When checked, the tool codes will use the opposite UOM than the data (inch – mm, mm – 

inch).  To use this feature in import directory and Zip, highlight the file in the scan results then 

press “Edit Format”. 

• “Tools/Convert Drawn Pads/Single Shape” (Ctrl+Shift+P) 

Polygons are now supported. They will be interpreted as zero-width contours for the draw to flash opera-

tion. 

• “Tools/Netlist/Extract Contour” 

The two separate dialogs (extract and export) have been combined into one tabbed dialog. 

9.8.20 / 25 

• New Selection Criterion 

A new entry has been added to the selection criteria in the Selection Toolbar. It is called “Scratch Ele-

ments” and, when active, will only select/pick elements that have scratch polarity inside a layer. Note that 

if the whole layer is set to scratch, that will not cause elements in it to be picked. 

• “Setup/Preferences/Splash Screen” 

Allows enabling or disabling the display of the splash screen at program startup. 

• “Tools/Compare Layers/Save Differences To File” 

The coordinates where differences were detected are saved to a text file. 

• Character Coding for Import and Export 

The character coding (ASCII, EBCDIC, EIA) is now separate for import and export. Previously changing 

one would also change the other. 

• “File/Import/Guess Directory Zip” 

 TAP format drill files with T-Code definitions in the header section will now use the T-Code value 

rather than the hole size number.  The ‘n’ value still defaults to three.  The ‘m’ value is now 

calculated by subtracting the ‘n’ value from the total number of digits in the coordinate data. 

 The results dialog now resizes better. 

 Gerber files that use CR/LF instead of ‘*’ are now recognized. 

 Recognizing HPGL and HPGL/2 files has been improved. 

9.8.5: 

• ”Select/Covered Active Elements” 

Now handles zero-width elements also. This includes traces mapped to F-type D Codes. 
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• “Edit/Edit Selection/Polygons/F To Polygons” 

Algorithm has been improved. 

9.8.0: 

• Inserting Scratch Elements Directly 

One can now insert scratch elements into any layer. 

Previously, if one wanted to add new scratch elements, one needed to add them to a scratch layer (the 

whole layer was marked as scratch). While that is still possible, there is a new way to insert scratch ele-

ments: the commands “Paint” and “Scratch” in the “Insert”menu. There is also a “scratch” button on the 

Insert toolbar, which will cause scratch elements to be inserted when the button is depressed (active). 

While scratch mode is active using any of the above commands, any of the elements inserted with the 

normal insert commands (“Insert/Pad”, “Insert/Trace”, etc.) will be scratch elements.  More precisely, 

scratch elements will be inserted into positive layers and paint elements into negative layers, the end re-

sult being that they will scratch away from copper. 

Note that the “Only” selector next to the layer box in the “Current Element” toolbar will be taken into 

account (as always the case with insert operations). So, if you want to insert into one layer only, make 

sure that the “Only” selector is checked. 

• Selecting A Particular Element When There Are Multiple Stacked Elements 

Sometimes there are multiple stacked elements in the same layer. Often this is the case with stacked pads 

(perhaps a scratch pad to created a clearance and then a paint pad). Since they have the same center, it 

was previously difficult to select a desired element (just the scratch or 

just the paint in the example above). 

There is now a new way to do this. By executing the select command repeatedly, the selected element will 

cycle through all candidates in order and one can stop when the desired element is selected. This means 

double-clicking repeatedly (or single-clicking repeatedly when the selection tool is active). 

• Routing Paths Compensation 

Compensation is now supported for open paths also. Previously only closed paths could be compen-

sated. 

• Layer Colors 

There are new commands for saving and restoring the layer color setup. The color setup consists of the 

color index for each layer (a number between 1 and 15, which maps to one of the 15 colors that can be set 

at any time) and the color composition (RGB) of each of these 15 colors. 

These commands are “Setup/Layer Colors/Save To File” and “Setup/Layer Colors/Restore From File” 

and they allow saving and restoring the configuration. 

To make such a setup the default setup (loaded when the program starts) the command “Setup/Layer 

Colors/Save As Default” should be used. 

Also, the complete color setup is now saved in .bin files. Previously only the layer indices were saved. 

• Distance Measurement 

There are several changes and new features in the distance measurement commands (“View/Distance”). 

 The distance is now displayed only in the view (next to the cursor). The Screen Toolbar will 

display relative X and Y displacement from the start of the distance measurement. The screen 

display also includes the angle from the start of measurement. 

 The “distance from edge” measurement has been merged into the distance tool. Is it now an 

option that can be turned on and off (“View/Distance/From Edge”), so there is only one distance 

tool with two modes. 

 The command to measure the edge-to-edge distance between two selected elements has been 

replaced with a tool (“View/Distance/Edge To Edge Measurement Tool”). While this tool is 
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active one can click on two elements (click on first, then click on second) and the edge to edge 

distance between these two elements is displayed in the status line. 

• Transcoding NC Tools By Descending Size 

The tools setup dialog (“Setup/Tools Codes” or “Shift+F5”) had two buttons for transcoding tools by as-

cending size. These have been combined into one button “Transcode By Size” with two more methods 

added to allow transcoding by descending tool sizes also (previously only ascending order was imple-

mented). 

The four methods are: “Ascending”, “Ascending By Type”, “Descending” and “Descending By Type”. 

• “Setup/Preferences/Center On Wheel Zoom” 

Controls how the zoom happens when zooming with the mouse wheel. When this option is active 

(checked) the zoom is combined with a pan so that the position where the zoom started becomes the new 

center of the view. 

• “View/Coordinates Origin/Set Relative Origin” 

This is a newly added command that sets the relative origin at the current cursor position. It takes the 

name of the previous “set relative origin tool” (and also the shortcut Shift+R) which is now renamed “Rel-

ative Origin Tool” and has no shortcut key. However, it keeps its button on the Screen Toolbar. 

• “File/Import/File Path Options/Current Directory Is Set On Import” 

This is an options that can be turned on or off. When on, the current directory is set to the path of the file-

name imported. This can be desirable if one imports files by dragging and dropping (rather than using 

the File/Import dialog). 

• “File/Import/Drill” 

A new option (in the “Options” dialog “Data Format” tab) called “Tool diameters in opposite units”. 

When checked, the tool diameter values read in will be interpreted in the opposite units from the ones 

specified in “Units”. The value in “Units” will be used to interpret coordinates. If the file contains unit 

directives, such as M71, M72, INCH or METRIC, they will of course override any settings from this dia-

log. 

This is useful for importing files which have the header and the rest of the data in different units, such as 

diameters in metric and coordinates in English or vice versa. 

• “File/Export/Gerber Extended” 

Two new options have been added in the “Options/RS274-X Options” tab. These will warn the user when 

the file to be output will contain apertures that are either zero-width or wider than a user specified value. 

This is useful when outputting to photoplotters (such as the Gerber Crescent) which have aperture size 

limitations. These options are: “Warn for zero-width D  Codes” and “Warn for D Codes of diameter 

larger than”. 

• “File/Export/Drill” 

A new option has been added for exporting Sieb & Meyer files. It is in “Options/Output Options” and is a 

pair of M commands that can be output at the top and bottom of the file. These commands are for ma-

chine specific M commands, such as M38 (jam) and M39 (loosen), but any numbers can be entered. Sieb & 

Meyer describes the “Machine Function” commands as being M22 through M27 and M34 through M41. 

If a box is left empty, then no extra command will be output at that level (top or bottom of the file). 

• “Tools/Design Rules Check/Add Errors From File” 

New command similar to “Load Errors From File” but does not clear the existing errors first. This way 

one can merge the results saved in several error files into one combined set of errors. 
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• D Code rotation 

The operation to rotate a group of D Codes, available in the “Setup/D Codes” (F5) table, has been 

changed to allow for a user specified angle of rotation. Previously only a rotation of 90 degrees was avail-

able. The command is now “Operations/Rotate” (was “Operations/Rotate 90 Degrees”). 

•  “View/Distance/Edge To Edge” 

Has been changed from a command to a tool. See description under “Distance Measurement” in the 

“New” section below. 

• “View/Coordinates Origin/Set Relative Origin” 

This command has been renamed “Relative Origin Tool” and has lost its shortcut (Shift+R) now linked to 

a new command that sets the relative origin but is not a tool (immediate action). See below under “New” 

commands. 

• Improvements In Contouring Algorithm (Polygon Merging) 

This algorithm is used in many places, but most importantly in Contour DRC and Contour Netlist extrac-

tion. The speed of the algorithm has been dramatically improved for cases where the data to be merged 

results in a crosshatch. This can often happen in plane layers. Previously such layers were best handled 

with Raster methods, but now Contour methods can be used throughout. 

• “File/Save Options/Preferences” 

The “Include Net Info” option has been removed from the dialog. Now net info is always saved in a job-

file (.bin file), if it is present (if there are elements in the job which have a net info value different from 

“?”). 

• “File/Import/Gerber/Options” 

The “Data Format” tab items “Left of decimal” and “Right of decimal” are selectively grayed out to con-

vey to the user when they are irrelevant. “Left” is irrelevant in “Leading” omit zeros mode and “Right” is 

irrelevant in “Trailing”. 

• “File/Import/Guess” 

The Import Guess results dialog has changed for setting m and n.  It now uses two buttons to shift the 

decimal point instead of dropdown boxes.  Also the “Apply” button has been removed as the board size 

is automatically recalculated whenever a parameter is changed. 

• “File/Import/Apertures” 

When importing Pads aperture files, German headers will be recognized.  Also the units will default to 

mm. 

• “File/Import/ODB++” 

 The ODB++ layer name value will be used during import to set the layer name in the F10 menu. 

 ODB++ will now tag the first copper layer as CPU, last copper layer as CPL. Any layers before the 

CPU that are silk, soldermask, or solderpaste will be marked as ‘U’pper.  If these files are listed 

the CPU layer, they will be marked as ‘L’ower.  Drill layers are now DRI instead of PAD.  

9.6.91: 

• “View/Visibility/Layer/Board #0 Always Visible” 

A new option for controlling the behavior of the commands that step the visibility of layers. These are in 

“View/Visibility/Layer”:  “Next Layer”, “Previous Layer, “Next Board Layer” and “Previous Board 

Layer”. 
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When “Board #0 Always Visible” is checked, then these commands will always cause board layer #0 to 

stay on (visible) together with the next board layer in the sequence (next or previous). 

• “File/Import/Net” 

Better handling of IPC-356 “307” records (blind and buried via). 

• “Edit/Edit Selection/Polygons/Make Well Formed” 

The algorithm has been improved to handle a larger variety of malformed polygons. 

• “Select/Duplicate Active Elements” 

Elements that have no width will now be processed by this command also. Previously they were ignored. 

This includes pads and traces mapped to D Codes that have zero width or of shape type “F”. 

• “Tools/Netlist/Netcompare” 

The comparison algorithm has been improved. 

•  “File/Import/DPF” 

Now uses the Windows temp directory for temporary files during import. 

9.6.81: 

•  “File/Import/Apertures” 

A new aperture type: Proteus.inf is now supported. 

•  “File -> Import -> Directory/ Zip” 

A new button has been added to the scan results dialog, “ReScan”.  When pressed, the user can change 

the import option settings and rescan the files.  In the past the user had to start the import over from the 

beginning. 

9.6.78: 

•  “Edit/Edit Selection/Special/Convert Routing Paths To Traces” 

This command replaces the selected routing paths with traces, one trace per edge. Previously this com-

mand was available only in CAMMaster (and higher) as “Tools -> Routing -> Ungroup To Traces”. 

• “Edit/Edit Selection/Special/Convert M-type Pads To C-type” 

This command acts on the selection and replaces each M-type pad in the selection with a pair consisting 

of a polygon and a C-type pad. The polygon has the same shape and position as the original M-type pad 

so that the copper is preserved. A C-type pad is also placed on top of it, within the bounds of the poly-

gon. 

The main use for this is for preparing data for netlist generation and for software that cannot deal with 

custom (M-type) pads. 

• “File -> Import -> Apertures” 

ApSource7 now imports diamonds. 

• “File -> Import -> ODB++” 

Import time has been greatly improved. 
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9.6.69: 

• Drag The View Using Scrollbars 

When “View->Preferences->Drag View In Real Time” is checked, dragging the scrollbar boxes will also 

drag the view in real time. Note that the “Drag View In Real Time” also controls the behavior of dragging 

the view with Ctrl+Alt+Left Mouse button (this was present in previous versions also). 

•  “Setup->Tool Codes” (Shift+F5) 

A new command has been added for transcoding tool numbers. It is called “Transcode Selected” and will 

transcode all the selected tools (which can be contiguous or not) to a contiguous range of tool numbers 

specified by the user. Of course one can transcode just one tool number, for instance T4 to T9, but also 

sets like T1, T4, T7 to start at T10, which will cause the transcoding: T1 toT10, T4 to T11 and T7 to T12. 

• “File->Import->”From Layers”  Uses Cur Dir” 

A new setting which applies only to the command “File->Import->From Layers”. This command imports 

several files using the layer names as file names. For names that are not full paths, it is not obvious how 

to complete the path (which directory they are in). Previously the directory was assumed to be the direc-

tory of the jobfile. When this new option (“From Layers” Uses Cur Dir) is checked, the “current direc-

tory” is used instead. The current directory is an operating system dependent concept and it is changed 

when file browsing dialogs are used. It is usually the last place where a file was saved/exported or 

opened/imported. 

• “Paint And Scratch->Expose Scratch” 

Command available in the context menus in the layer toolbar and layer setup dialog (F10). Will correct 

layers that start with scratch elements (which are invisible). It will add a covering paint rectangle in front 

of them so as to expose the scratch elements. 

9.6.53: 

• Layers Toolbar 

A new way to quickly turn on or off a range of layers has been added. 

This is done by clicking the right mouse button and pressing either the Shift or Control keys at the same 

time. If neither of these keys are pressed, then the normal context menu is displayed. However, if any of 

these keys is pressed, this action will cause instead to change the visibility of the layers ranging from the 

current layer to the layer on which the right button is clicked. Shift will cause the range to be made visi-

ble, Control will cause the range to be made invisible. 

• “Help/User ID”  

Shows the current User ID for this product and allows the user to enter a new one (in case the existing 

one is incorrect). Previously the User ID could be only set during installation. 

9.6.43: 

•  “File/Import/Drill & Rout” 

A new option has been added for importing Excellon files. It is in the “Options” tab of the “Options” dia-

log. It is called “M00” and controls how M00 statements are interpreted. 

There are three possibilities: 

 “Treat as end of program”. This will cause the current program to be terminated and any 

following data will appear on a new layer. 

 “Ignore”. The statement will be completely ignored. 

 “Increment tool”. The statement is interpreted as a tool change to the next sequential tool number. 
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• Crash Report Generation 

If the software crashes, a dialog will come up asking whether to email a crash report to PentaLogix tech-

nical support. These reports will be investigated by technical support and they help to find and fix the 

source of the problem. 

• ”File/Import/Aperture” 

A new aperture type “Metric Source” has been added.  This aperture type recognizes files that use com-

mas instead of decimal points and has special conversions for an aperture named “SYMB” to targets. 

• “File/Import/Guess” (also, Directory and Zip) 

Gerber extended (RS-274X) files with incorrect format statements (FS) are now easier to import. 

Hard to believe, but some Gerber files have format statements which are incorrect. Previously the only 

way to correct this was to edit the file and change or remove the statement. 

Now one can use “Import/Guess” (or “Zip” or “Directory”) which will guess the format and will allow 

the user to override it in the dialog that appears (check-box item “Override parameters”). 

• Pads / Traces Contrast 

Contrasting pads and traces with different colors in the same layer is not guaranteed to display correctly 

when the board layer contains paint and scratch. However, certain users need this feature so much that 

they would rather use it on such layers also, even if the display is not guaranteed to be correct. 

This version enables them to do so, by checking the option “Allow contrast on paint/scratch also” in 

“View/Visibility/Element/Options”. This is a “use at your own risk” kind of option. The data will always 

be correct, but the paint/scratch rendering may be incorrect when pads contrast is on. 

• “Edit/Paint And Scratch/Optimize Selection” 

The optimization operation has been improved to pair scratch and paint polygons. Polygons with holes 

are often represented via paint and scratch because some of the import languages do not have ways of 

representing polygons with holes directly. Gerber is such an example where holes are represented as 

scratch polygons. 

The optimization operation will now detect such situations and add the scratch polygons as holes of the 

corresponding paint polygons. This results in fewer scratch elements and sometimes in the complete 

elimination of scratch elements. 

• “File/Import/Apertures” 

If the aperture import encounters problems, an error file is generated.  When the dialog box appears to 

report that errors have been encountered, a button has been added to view the error file. 

• NC Tool Sizes 

Tool sizes are now saved in jobfiles (binfiles) even if they are not mapped to any D Codes. This facilitates 

using common setups of NC tools. One can set up the tools, then save an empty (no circuit data) binfile, 

which can later be opened or imported to restore the settings. 

9.6.17: 

•  “File/Import/Gerber/Options/RS274-X Options” 

 The handling of “IPNEG” commands has been improved. 

These are used to define a layer as a negative layer. “IP” stands for “Image Polarity”. The issue is 

how to treat subsequent “LP” commands (“Layer Polarity”). These can be “LPD” or “LPC”. 

Some files assume “LPD” to be the paint polarity, some “LPC” (“LPC” seems to be more 

prevalent). 

Previously there were only two modes for this option. Now a third one, called “Automatic” has 
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been added that will try to guess the correct setting. 

9.6: 

• “Edit/Move Layers/Align Visible Layers” (Ctrl+Q) 

A new command to facilitate aligning layers has been added. It incorporates the methods that were avail-

able in the old “Edit/Move Layers/Align” (which it replaces) and it adds more methods. 

This command works on all visible layers and will try to move some of them so they align with the oth-

ers. The following methods are available: 

 

Pad or trace in a corner of a layer. The corner to be considered can be specified by the user (upper-right, 

lower-right, upper-left or lower-left). The software will pick (in each visible layer) the element (pad or 

trace) closest to the corner in that layer and will use them as reference elements. The layers will be moved 

so that the reference elements end up on top of each other. 

 

One selected element in each layer. The selected elements will be used as references in each layers. The 

layers will be moved so that the selected elements end up on top of each other. If more than one selected 

element exists in a layer, an error will be reported and the operation aborts. Layers which have no se-

lected elements will be ignored. To select elements, one can use the selection tool (S) or simply double 

click on an element. Remember that to add to an existing selection one needs to keep the Shift key 

pressed while selecting. 

One selected pad whose type is used as a guide. This is the old “Edit/Move Layers/Align” that has been 

around for quite a while. It requires the selection to consist of just one pad. If pads similar to it (using the 

additional rules of “D Code Number Only”, “Shape Type Only” or “Shape Type And Size”) are found in 

the other layers, the closest to the selected one is picked in each layer and used as the reference for that 

layer. The layers are then moved so that all these pads end up on top of each other. 

This works well only for cases where the layers are not offset by much and there are distinguished pads 

(such as targets). If all layers have targets, aligning targets is an easy way to do the job. 

In each of these cases some layers will be moved and others not. One layer (at least) is always left where it 

is. For method (3), that layer is the layer that contains the selected element. For methods (1) and (2), the 

largest number of layers that already match are left standing. If no layers match already or the operation 

is done on only two layers, then the “current layer” is left standing. 

For many cases more that one method needs to be used. Pads can very often be used for alignment, but 

some layers have no pads (such as silkscreen layers) and so a second step to align them may be necessary 

(using traces, or selected elements). 

• “Select/Covered Active Elements”  

A new command that will first clear the selection and then select only the active elements that are com-

pletely covered by other elements. These are usually redundant, garbage elements and can be discarded. 

Note that if two (or more) identical elements are superimposed in the same layer, all will be selected, ex-

cept one, so that deleting the others does not modify the copper of the layer. Candidates for selection are 

only active elements, so they must be visible and also all the “Only” buttons and controls are taken into 

account. One could, for instance, apply it just to pads. 

• “Select/Duplicate Active Elements”  

A new command that will first clear the selection and then select only the active elements which are iden-

tical (geometrically) to others. These are usually redundant, garbage elements and can be discarded. Note 

that of two (or more) identical elements all will be selected, except one, so that deleting the others does 

not modify the copper of the layer. Candidates for selection are only active elements, so they must be visi-

ble and also all the “Only” buttons and controls are taken into account. One could, for instance, apply it 

just to pads. 

This replaces the older command “Select/Duplicates” which acted a bit differently, working only on the 
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elements already selected. 

• “File/Import/Drill & Rout” 

Added support for importing Excellon commands G32 and G33 (“Routing Circle Canned Cycle”) and 

Sieb & Meyer commands G45, G46 (“Rout A Hole”), G47, G48 (“Rout A Round Card”) and G49, G50 

(“Rout a Hole (Rectangle)”). 

• “Setup/D Codes” (F5) 

A new command for selecting elements mapped to a set of D Codes. It is in the menu of the “D Code Ta-

ble” dialog under “Operations/Select Pads And Traces”. For all the picked D Codes in the table (which 

are highlighted in dark blue) the elements mapped to those D Codes, and in visible layers, will be se-

lected. This allows selecting elements mapped to more than one D Code.  

• “Tools/Netlist/Select Net”  

A new selection tool that facilitates selecting all elements having the same net name (or number). This 

was possible previously also, but required a sequence of keystrokes to do, as the “Only” button next to 

the Netlist box in the Current Element toolbar needed to be turned off then on repeatedly. 

This is no longer needed with this new tool. Once activated, one can click (or hit Enter) to select the active 

element closest to the cursor and, together with it, all the other active elements which have the same net 

number. This tool acts like the selection tool in the sense that the Shift and Ctrl keyboard keys change the 

meaning of the selection: if Shift is pressed while clicking, then the operation will add to the selection, it 

Ctrl is pressed, than it will remove from the present selection and if neither is pressed, then it will make a 

new selection. 

• “File/Export/Rout/Options” 
A new page has been added to the options dialog which allows arcs to be converted to chords for export 
purposes. This is for routing machines which cannot handle arcs. The routing paths in the database are 
not modified. 

• “Tools/Routing/Display X’s At Plunge Points” 
When turned on, will display an X over the plunge points of currently visible routing paths. These are the 
points where the routing paths start. 

• “Setup/Preferences/Only One Tool Can Be Active” 

This is a new preference, but it modifies a behavior that existed previously. Certain user tools: zoom 

(“View/Zoom/Tool” (Z)), select (“Select/Selection Tool” (S)), distance (“View/Distance” (D)) and others 

are considered “helper” tools in the sense that it is sometimes useful to activate them while another (per-

haps multi-step) tool is active (in dormant state). When the helper tool is canceled (by Escape or other-

wise) the dormant main tool is reactivated. 

Some users do not want this behavior, because they would rather have just one tool active. For those user, 

this new option has been introduced. When checked and a helper operation is activated, any previous 

operation is canceled. 

• “File/Import/ODB++” 

 Improved import algorithm is much faster. 

 The import process has been streamlined by importing according to the ODB matrix rather than 

requiring the user to select import order.   

 Step and repeat, rotations, and offsets are now imported correctly.  

 The profile step is now imported as a BOL type. 

 When running in Batch mode, all menus are suppressed. 
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• “File/Import/DPF”  

When importing files in metric, the conversion is now much more accurate by using a conversion factor 

to eight decimal places. 

•  “File/Import/Gerber” 

 The settings in a Gerber extended “FS” statement (Format Statement) will not change the user 

settings in File/Import/Gerber/Options. They will of course apply to the current plot, but will not 

affect later files. This allows the values set by the user to persist. 

 Improved handling of approximate arcs (when the radius at one endpoint is different from the 

radius at the other endpoint). 

 The “AM” Rotation modes for “Rotate around” have been expanded to three. Previously there 

was “Rotate around center of each primitive” and “Rotate around aperture center”. Now a new 

mode has been added, called “Automatic”. This will pick one of the two previous modes, 

depending on the type of primitive.  

This has been determined after examining a number of sample file, some of which needed both 

types of rotation in the same file. 

The auto mode seems to be working well with all the sample files examined, but the other two 

modes have been left in the user interface as a fallback position, to account for different types of 

Gerber files that the user may encounter. 

• Selection Toolbar 

There are several new options to specify elements to select or pick (in the dropdown list): 

 “Open Paths”: picks open routing paths only 

  “Closed Paths”: picks closed routing paths only 

 “No Lead-In”: picks closed routing paths which have no lead-in 

 “Net Midpoints”: picks elements which have a net number (or name) and have been marked as 

net midpoints by a previous net import or net extract operation. 

 “Net Endpoints”: picks elements which have a net number (or name) and have not been marked 

as net midpoints by a previous net import or net extract operation. 

•  “Edit/Break Traces And Clip Polygons” (Ctrl+B) 

This command was called “Break Traces” before. Now polygons are included in the operation also (when 

a frame is used for clipping). Any polygons that touch the frame will be clipped by it and subdivided into 

several polygons, similar to the way a trace is clipped. This provides a powerful new way to manipulate 

polygons. 

Note that this operation is affected by the state of the “Inside” button on the “Selection” toolbar. 

• “File/Import/Guess-Directory-Zip” 

 The import options now has check-boxes to include/ exclude certain file types. The file types are: 

 Scan for Data Files 

Scan for Aperture files. 

Scan for Netlist files 

 The default import order has been changed.  Drill files are placed near the bottom of the list; and 

drill files with tool definitions but no data, immediately precede the drill files.  Netlist files are 

placed last.  This is to accommodate net lists with ‘T’ codes. 

 Certain file types are filtered from scanning to prevent crashes.  Files ending in “PDF”, “DWG”, 

and DXF” are ignored.  Other files are scanned to detect binary data and will be ignored if 

appropriate. 

 Zip now has the same options button found in import directory. 

 Tap files without format data will default to the most common parameters.  This file format will 

now be identified as three possible types: 
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Tap definitions without tool changes will be treated as an aperture file, no drill data imported. 

Tap files with Excellon tool definitions will be treated as Excellon drill files. 

TAP files with TAP tool definitions and with tool changes will be identified as a new type, 

NC_TAP.  Tool definitions and data imported. 

 Imports both the tool and drill data if present.  The file type is called “NC-TAP/ Excellon”.  When 

the format isn’t provided, default settings will be used that seem to work in most cases. 

 Recognition of Excellon format improved handling of ‘T’, ‘F’, ‘C’, ‘S’ commands.  Metric 1, 2, 

formats recognized. 

 Gerber files with large AM (Aperture Macros) import quicker. 

• “File/Import/Apertures” 

 Valor aperture files now import diamonds, thermals, obrounds, and octagons. 

 LAV501 apertures now supports octagons and tool definitions. 

• “View/Distance” 

The distance measurement tools now display the current distance next to the cursor in the main view, in 

addition to the X box in the “Screen” toolbar. 

• “Help/Check For Updates” 

The user can now specify an interval of time for automatically checking for software updates from the 

PentaLogix website. This check will be done in the background and the user will only be notified if there 

is a new version available. 

• “Tools/Snap To Padmaster”  

The “Snap Settings” tab has a new option “Select result”. This determines whether the elements that were 

snapped are selected or not at the end of the operation. The previous behavior was that they were always 

selected. 

• “Tools/Compare Layers”  

The speed of the algorithm has been improved. 

• “Tools/Netlist/NetCompare”  

The “Select” button has been removed from the errors display floating dialog. 

Selection is now done automatically. When a new error is examined all the nets that appear in that error 

will be selected. Further selection refinement can then be done by the user, by clicking on the net names 

in the NUT and REF lists. The Ctrl and Shift keys can be used to change the selection in the normal Win-

dows convention, to modify an existing selection or to select ranges. 

9.4.73: 

• Unmapped D Codes 

Unmapped D Codes (of shape type “?”) and N type D Codes for which the corresponding tools are un-

mapped (of type “?”) will be displayed as a question mark inside a doughnut. This is to make them easy 

to recognize when looking at the display. Previously they were displayed as rounds. 

• “File/Import/Zip” 

Now has the options button available when selecting a file to import.  This is the same options button 

found in Import Directory.  

• “File/Import/Directory” and “File/Import/Zip” 

The options dialog now has three new check-boxes When selected, File import will scan files for these 
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data types:  

 Scan for Data Files. 

 Scan for Aperture files 

 Scan for Netlist files 

•  “File/Export/Drill”: 
A warning is issued when trying to export data that contains unmapped tools (of type “?”). 

9.4.66: 

• “Tools/Compare Layers” 

The “Comparison Method” options have been implemented. There are two methods for comparing two 

layers: 

 “Element by element” 

Each element in the first layers is compared with a corresponding element in the second layer. 

Where differences are found, elements are selected. 

 “Copper area” 

The copper are of the first layer is compared with the copper are of the second layer and a 

marker will be displayed at spots where there are differences (copper in one layer but not in the 

other). These differences can be navigated via a dialog. If one closes the dialog the markers will 

be removed, but they can be brought back again with (“Tools/Compare Layers/Show 

Differences”). 

This method is also different from the “Element by element” method in that it handles 

composites (step and repeat blocks and text blocks). 

9.4.6 - 65: 

•  “File/Import/Discard Path In Layer Names” 

Controls how layers are named from file names during import operations. 

When checked, only the file name part will be stored as the layer name and the path part of the file name 

will be discarded. 

When unchecked, the hole path name will be used, unless the file is in the same directory as the currently 

loaded jobfile. 

• “Setup/Visibility and Display” 

“Step & Repeat Blocks”. New options have been added for the display of step and repeat blocks. The 

two options are “Display all details” and “Display outlines only”. The new one is the second option. If 

selected, it will cause all step and repeated data to be displayed on the screen as a boxes, without the de-

tail of the circuit elements inside. This saves time when examining large panels with a lot of panelized 

data. Note that this applies only to “blocked” step and repeat data. If the data was step and repeated us-

ing copying, this option does not apply, as the step and repeat information is not recorded in the data-

base. 

• “Setup/Layers” (F10) 

New commands to save/restore the default color setup for layers display. The commands are available 

from the context menu (right mouse click) under “Colors Setup”. There are three commands: 

 “Save Current As Default”: the current setup of layer colors and color definitions (RGB content of 

colors) becomes the default. The next time the software is started, it will display these settings as 

the default. 

 “Restore From Default”: layers colors will be set to the default settings. 

 “Restore From Factory Settings”: layers colors will be set to the PentaLogix default values. 
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• “Edit/Edit Selection/Move By Displacement” 

A new command to move the selection by user specified X and Y displacement values. 

• “Insert/Pad” 

During the insert operation an outline of the shape to be inserted is dragged along with the cursor, giving 

better feedback as to what the result will be. This includes outlines of complex shapes also. 

• “View/Distance” 

The distance measurement tools (“From Point (D)” and “From Edge”) now stay active until explicitly 

canceled. So they will stay active when starting other tools, such as the insert trace and pad tools. This is 

useful for accurate positioning during such insert operations. 

• Pad outline mode (O) 

Custom apertures (shapes of type M) will be showed outlined with primitives displayed individually 

(both paint and scratch primitives are shown). This allows for a better understanding of the components 

of a custom shape. 

•  “File/Import” 

 “Gerber” 

“AM” rotation. It has been determined that both interpretation for the rotation of AM apertures 

exist in Gerber files. The two possibilities are: 

- rotate each primitive individually around its center or 

- rotate the whole aperture (around the aperture center) 

In versions previous to 9.4, the second method was used, then in the early 9.4 releases it was 

change to the first method. We have now seen files that assume one or the other, so the decision 

was made to add a user setting, so the user can pick which one to use. It is in “Options/RS274-X 

Options” and it is called “Rotate around”. 

 “Bitmap” 

Better handling of color bitmaps based with a color palette. 

 “Directory/ Zip/ Guess” 

Recognition of Excellon format has been improved.   

The Excellon format statements Metric 1-3 is now recognized.   

Adobe Acrobat .PDF, Illustrator .AI, AutoCAD .DXF and certain .DSN files will be ignored for 

import. 

The import order has been changed.  Netlist files will be listed last.  Drill files will be listed before 

the Netlist files.  If a drill file does not contain coordinate data, it will be the first drill file listed.  

These changes will help drill sizes to be properly imported. 

  “ODB” 

ODB import is now much faster.  Step and Repeat as well as rotate is now handled properly.  

Profile layer is now imported as BOL.  The menu to arraign layer order has been eliminated.  The 

layers will now import in the order defined by the ODB file. 

•  “Setup/D Codes/Operations/Unique Shapes” 

A new option has been added called “Shape types to consolidate”. This allows handling N-type shapes 

differently. One can apply the operation only to N-type shapes, only to non-N type shapes or to all 

shapes. 

• “Tools/Compare Layers” 

Two new options have been added: 

 “Stop after … errors”. Allows the user to specify a number of errors after which checking should 

stop. 
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 “Tolerance”. Differences smaller than this will be ignored. 

9.4.1: 

• “File/Import” 

 “Gerber” 

The extended Gerber command “IR’ (Image Rotation) is now supported. 

 “Drill & Rout” 

Sieb & Meyer rout data is now supported. Previously only drill data was supported for Sieb & 

Meyer. 

• “File/Export/Rout” 

Sieb & Meyer rout data can now be exported via the “Sieb & Meyer” command. 

• “Insert/Arrow” 

A tool to insert arrows made out of traces, similar to the arrows generated by “Insert/Dimension”, except 

that there is no dimensioning. These arrows can be used to mark locations of interest. The height of the 

arrow is derived from the “Text Height” parameter in the “Inset/Loc and Dim Setup” dialog, similar to 

the “Insert/Dimension” tool. Once the tool is active, you need to click first at the position of the head of 

the arrow and then at the position of the tail of the arrow. 

• “Select/Layers” 

A new command to select all elements in a group of layers, specified as a comma-separated list of layer 

ranges (for instance “3-5, 12, 14-22”). This will make a new selection, any previously selected elements 

will be deselected first. 

• “Tools” 

 “Stencil Apertures” 

A new set of tools for creating stencil apertures. The commands and features are described in a 

separate document: “Stencil Apertures”. 

 “Routing/Arc Chamfers” 

Acts on selected routing paths. Adds arc chamfers of the specified radius to vertices where two 

straight edges meet. 

•  “Netlist/Extract Contour” 

 Polygon Output  

Polygon data is now output in F04 netlist files.  This allows polygons to be displayed in the test 

programs to improve viewing/ inspection. 

 Adjacency and Shielded Adjacency 

Option to find shielded adjacencies for faster testing using flying probe testers as defined in the 

IPC-356B standard.  You can choose to determine shielded adjacency for all nets or to ignore 

blobs (large drawn areas).  If “ignore blobs” is selected, the blobs will be treated as normal 

adjacencies.  The shielded adjacency is only exported in F04 format. 

 New midpoint algorithm 

Option to identify midpoints.  You can choose to identify midpoints on all netlists or to ignore 

blobs (large drawn areas).  The latter option is recommended for faster completion and if it is 

alright to treat all the pads on the blobs as endpoints. 

 F04 C$J record  

A new record C$J for the adjacency threshold is output for the F04 netlist output format.  The 

format is: C$JXXX where X is the distance in 10th mils. 
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•  “AOI/CAMTEK” 

The output of data to CAMTEK AOI inspection machines has been finalized and tested. 

Please see the document “CAMTEK Interface” for a description of features and procedures. 

• Component Information 

Component information is now stored in the database when available from the input files. Currently 

component information is imported from netlist files (columns 21-31 of IPC-356) and ODB++ files. 

It is stored as system custom properties called  “_Component_Name”, “ _Component_Type” and  

“_Component_Pin”. These can be used via the custom properties toolbar and the new “Select/Compo-

nents” command and can be qualifiers in selection operations. One can, for instance, select all elements 

that have a given component name. More information on this can be found in the “Stencil Apertures” 

document, although component information can be used independent of stencil apertures. 

• “View/Distance” 

The distance measurement tools (“From Point (D)” and “From Edge”) now stay active until explicitly 

canceled. So they will stay active when starting other tools, such as the insert trace and pad tools. This is 

useful for accurate positioning during such insert operations. 

• Pad outline mode (O) 

Custom apertures (shapes of type M) will be showed outlined with primitives displayed individually 

(both paint and scratch primitives are shown). This allows for a better understanding of the components 

of a custom shape. 

•  “Setup/D Codes ” (F5 dialog) 

 The dialog has been redesigned to allow for column resizing. One can do this in the usual way by 

dragging the gridline that separates two headings in the headings row, for instance between “X” 

and “Y”. 

 One can sort the table by values in a given column. This can be done by clicking on the heading of 

the column. For instance, clicking on “X” will sort the table by the X dimension of the D Codes 

(ascending or descending). 

 The dimensions of the D Code (in the X and Y columns) are displayed at their highest accuracy. 

Previously, only 6 digits were displayed and the value was rounded if it needed more that 6 

digits (including the decimal point). 

 The shape of the current D Code is displayed in the dialog. 

 The whole table can now be printed: “Operations/Print”. 

 The “similar shapes consolidation” command “Operations/Unique Shapes” will now consolidate 

two D Codes of N-type that are mapped to different tool codes but the same diameter. 

• “Remember Directory for Import” 

Has been replaced with “Remember Directories”. When checked, separate directory names are remem-

bered for import, export and macros. 

• “View” 

 “Visibility/Layer/Toggle Layers”: 

A comma separated list of layers or layer ranges can now be entered. Previously only a single 

layer could be toggled. 

 “Toolbars/Macro/Custom” 

The maximum number of buttons has been increased from 20 to 30. 

• “Insert” 

 “Loc and Dim Setup” 
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A new option has been added for the “Insert/Location” and “Insert/Dimension” tools: “Append 

Units”. When checked the text for the units (“inch”, “mm”, etc.) will appear after the dimension 

number, otherwise only the number will appear by itself. Previously the text for the units was 

always present. 

 “Pad” 

During the insert operation an outline of the shape to be inserted is dragged along with the 

cursor, giving better feedback as to what the result will be. This includes outlines of complex 

shapes also. 

•  “File/Import” 

 “Zip” 

Now reports CRC errors when attempting to unzip files.  Also applies to TGZ files for ODB++. 

  “ODB++” 

The net information will now also be imported, if present in the ODB file.  If multiple netlists are 

available, the user will be prompted to choose the appropriate netlist. PentaLogix layer type 

recognition has been improved. ODB can now be imported with messages suppressed for batch 

mode operations 

 “DPF” 

TEXT commands are now handled. Nested blocks now supported.  Rotations, scaling, etc. are 

supported. 

 “Netlist” 

Board outline records (389) are now recognized and are imported as “F” shape traces. 

  “Apertures” 

Added a new GAPFile type.  Supports the following string types: 

!GAPFile Version 3.0 

11 Round d:8.0 

309 Oblong w:13.0 h:48.0 a:0.00 

310 Rectangle Sq w:84.0 h:76.0 a:0.00 

•  “File/Export/Rout/Excellon” 

A “Data Format” tab has been added to be “Options” dialog. This allows setting the format of the output 

file. Previously the data was always output in “Absolute” with “Explicit decimal point”. 

• “AOI/Lloyd Doyle/Contour” 

Lloyd Doyle now outputs the max X and Y scan coordinates instead of the can area.  This will correctly 

place the test data on the tester.  The Lloyd Doyle dialog now allows the user to enter values in Inch, Mil, 

CM, or MM. 

•  “Tools” 

 “Generate Polygon Outlines/Vector” 
A new selection has been added to the “Outline Settings” tab. It specifies what the resulting 
outlines will be: polygons or contours made of “F” shape traces. In older versions of the software 
“F” shape contours were generated, then this was changed to polygons in more recent versions 
and finally now both methods are available, as many users seem to prefer the “F” shape 
contours. 

 “Netlist/Extract Contour”  
Vias are marked with a ‘P’ plated in the Hole Definition Field (column 38) for both F04 and IPC 
netlist file formats. 

 “Routing” - Display of NC routing paths  

The display of the plunge point in a routing path has been modified. Previously a marker was 

displayed when a path was selected, but that led to confusion as the marker could be left behind 

without any direct connection to newly displayed data. Now the plunge point is showed as a line 
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perpendicular to the path and surrounded by a circle of diameter equal to the tool size for any 

displayed path. This display exists only in outline (zero-width) mode (which can be toggled with 

“O”). 

9.2.41: 

• “Tools/Routing/Set Precedence” 

A new tool to allow quick setting of routing path precedence for the selected routing paths. While this 

tool is active a blue box will be displayed at the plunge point of all paths currently in the selection, with 

the precedence numbers displayed inside the boxes. The precedence numbers of this group of paths can 

be modified by clicking over the boxes in the desired order. The starting precedence number (the one as-

signed on the first click) is the smallest number existing in the group when the tool is activated. If Ctrl is 

pressed while clicking, the numbers are decremented rather than incremented. This allows for quick cor-

rection of inadvertent clicks. 

• “File/Export/Rout/Excellon” 

An Options dialog has been added. There is currently one option which controls how compensated paths 

are exported. The user can choose whether the export is done using Excellon G commands (G41 and G42) 

or whether the path is displaced by the compensation amount and G commands are not used. 

• “File/Print” 

The print dialog has two new items: a “Font” button and a “Raster” check-box 

“Font” allows selection of the font for the header. Previously a default font was used and will still be used 

if no new font is picked. 

“Raster” picks which printing method is used: raster bitmap based or Windows GDI based. Note that for 

Windows ME and lower only the raster method is available. For the other Windows versions the user can 

pick the preferred method. The Windows GDI based method is faster and works with all printers, 

whereas the raster method (which sends a potentially large raster bitmap to the printer) is more similar to 

the screen display (in color mode) as translucency of colors is supported (although the colors may be dif-

ferent on screen and on the printer). 

•  “Tools/Routing”  

 “Properties Tool”: If Shift is pressed when the tool is activated (via mouse click or pressing 

Enter), instead of having the properties dialog pop up, only a message describing the path is 

displayed on the status line. This is intended to allow quick inspection of a number of paths 

without having to dismiss the dialogs that pop up. 

 “Properties Tool” and “Selection Properties”: a diameter box has been added to the dialogs so 

that the diameter of the tool can be quickly viewed and changed. 

• More robust handling of network (floating) licenses.  

• Import Apertures / Netlists 

 In any dialog where the user has the option to view a file, the users’ defined viewer will be used.  If the 

file type doesn’t have a viewer assigned, wordpad.exe will be used.  

9.2.27: 

• “File/Import/ODB++” 

By selecting “From Dir”, the user can now import ODB jobs directly from the directory without having to 

create a TGZ or TAR file. 
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• “Edit/Edit Selection/Polygons/Separate Holes” 

The holes that result from the separation will be selected, whereas the containers will be unselected. This 

makes it easy to further process holes if desired. Previously both the holes and the containers where se-

lected. 

9.2.21: 

• “Tools/Routing” 

The properties for routing paths have an added element: compensation. It can have three states: None, 

Left and Right. With no compensation (None), the path is viewed and exported in its present form. When 

compensation is on (Left or Right), then the path will be offset by the radius of the tool so that the original 

path represents what is left after cutting. Currently only closed paths can be compensated. 

• “Layers Toolbar” 

When a layer contained only scratch elements inside (although the layer as a whole could be marked as 

paint) it was difficult to figure out what was going on, as the layer would be invisible when viewed by 

itself. Now, layers of this kind are marked with a “+” (instead of the “*”) to draw attention that something 

unusual is going on. Then the right click context menu command “Paint And Scratch/Force Inner Polarity 

To Paint” (which replaces “Separate Layer…” in this case) will make all the inside elements paint and 

also flip the polarity of the whole layer (if it was paint it becomes scratch and vice versa). At this stage, 

the data is equivalent to what was there before, but now the polarity can be easily manipulated (via the 

“Scratch” check-mark).   

• Mouse Wheel Behavior 

Moving the mouse wheel scrolled up and down when the scrollbars were visible and zoomed in and out 

otherwise. The behavior when the scrollbars are off is unchanged. However when the scrollbars are on, 

moving the wheel will scroll up and down when no other key is pressed, scroll left and right when the 

Shift key is pressed and zoom in and out when the Ctrl key is pressed. 

9.2.2: 

• “Select/Duplicates” 

Looks for duplicates among the currently selected elements. Only the duplicates will remain selected 

while all the other elements are deselected. Duplicates are elements that are geometrically identical and in 

the same spot (on top of each other) and of the same shape (although not necessarily the same D Code). 

Currently only pads and traces are checked for duplicates (polygons and routing paths are not). 

• “Edit/Edit Selection/Special/Merge Colinear Traces” 

Looks for linear traces in selection that continue each other and are colinear (on the same line) and re-

places them with one trace which spans the whole extension. 

• Layers toolbar context menu (right-click) 

Five more commands have been added under “Select”: “All”, “Traces”, “Pads”, “Polygons” and “Routing 

Paths”. These commands will select only elements from the layer that was picked and the selection is 

made independent of the other criteria (the “Only” buttons etc.) as well as independent of element visibil-

ity. It is always a “new” selection, meaning that all other previously selected elements will be deselected. 

The previously existing commands “New”,  “Add” and “Remove” are preserved and work the same way 

as before (they are affected by the normal selection criteria. 

The new commands give a quick way of selecting a whole layer or just some particular element type 

within a layer without worrying about the other settings in the software. 
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9.2: 

• Paint elements and scratch elements can now coexist in the same layer. 

Previously a layer was paint or scratch and all elements inside were of the same polarity (paint or 

scratch). However, because some import files contained many polarity switches (from paint to scratch 

and from scratch to paint) each requiring a new layer, the result was a large number of layers. It could 

even happen that the maximum number of 255 layers was exceeded and so the file could not be im-

ported. Starting with this version, a polarity change in the input will not require a layer change as paint 

and scratch elements can now coexist in the same layer. 

To see how many polarity changes there are in a layer, make that layer the current layer and then do 

“File/Properties” or Alt+Enter. The number of polarity changes is one of the information lines in the dis-

played dialog. Multi-polarity layers are also marked with a ‘+’ in the layers toolbar (instead of the ‘*’ for a 

single polarity layer). 

One can still set the polarity of a whole layer as paint or scratch (same as before). If the whole layer polar-

ity is scratch then the polarity of elements inside will be reversed: paint elements will act like scratch and 

scratch elements will act like paint. 

A layer which contains both paint and scratch elements can be separated into an equivalent sequence of 

layers which contain only one polarity. This makes it easier to edit the data (if necessary) and also con-

forms to how the software acted in previous releases (for users who prefer it that way). Note that for each 

polarity switch an extra layer is required. This can be done using commands in the “Paint And Scratch” 

submenu which appears in several places: 

 in the main menu under “Edit” 

 in the layers toolbar context menu (right-click of mouse) 

 in the Layers Table dialog (F10) context menu. 
There are two commands for separation: 

  “Separate Current Layer” 

 “Separate All”. This separates all layers that have mixed polarity. Note that for users who prefer 

the old way of storing paint and scratch, the operation to do is “Separate All” after each import. 

The reverse operation also exists, to combine a sequence of layers which belong to the same board layer 

(and perhaps have different polarities) into one layer. Commands for this are in the same “Paint And 

Scratch” submenus: 

 “Combine Layers” 

 “Combine All”. This looks for adjacent layers that belong to the same board layer (and are visible) 

and combines them into one layer. The operation is then repeated for all the layers in the job. 

The only way to change the polarity of elements is by setting the layer polarity. So if one needs to change 

the polarity of only a group of elements inside a layer, one needs to transfer them to an empty layer im-

mediately following the layer in question, set the board layer number to be the same, then change the 

layer polarity to the desired value and finally combine the two layers into one layer again. 

• A new version of binfiles is also introduced with this version (V10 of binfiles) 

This is only needed when saving jobs that have mixed polarity elements in the same layer. Note that 

older versions of the software will not be able to read/open these binfiles. 

• “Paint And Scratch” 

The menu under “Edit” has one more command that acts on the selected elements only: “Optimize Selec-

tion”. This command will examine the selection, layer by layer, and within each layer will attempt to re-

duce the number of polarity switches. Sometimes input files contain a lot of polarity switches that are un-

necessary because later paint and scratch elements do not interact (overlap) with previous ones, so it is 

possible to merge them into fewer polarity groupings. This can be useful when one needs to edit the data 

and also makes the export/output more efficient. 
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•  “Insert/Chamfer” 

Activates a tool to insert, move (slide) or delete a chamfer trace. This tool is a combination insert and edit 

tool. While the tool is active, pressing “Shift” puts it in the insert mode, while pressing “Ctrl” puts it in 

the remove mode. If none of the keys are pressed, it is in edit (move) mode. 

A chamfer trace is a trace connected at both endpoints to other linear traces which act as “rails”. The 

chamfer can be moved parallel to itself while being guided by the rails. It can be a linear trace or an arc 

trace. In the edit/remove mode this is determined by what trace is picked for editing, in the insert mode 

this is determined by “Insert/Arc Chamfer Mode” (once set, it will be remembered for future operations). 

Note that when picking (either the chamfer to edit, or the junction of the rails where to insert) only active 

elements will be considered (this means all the “Only” buttons are active). 

The insert operation will create a new chamfer starting at the joint of the two rails, while the remove op-

eration will delete an existing chamfer and extend the rails so that they meet. 

These operations can be used to rearrange circuits so that they provide more clearance spaces where 

needed. 

•  “Edit/Edit Traces” 

A new group of operations to edit traces. They affect up to three traces at a time. The traces can be 

straight (linear) or arc traces. The following table provides a summary of the operations. 

 

Name Of Opera-

tion 

Action Traces 

affected 

Move Trace Picks closest trace. The trace then follows the cursor by moving par-

allel to itself. 

1 

Move Endpoint Same as “Move Trace”, but operation starts by picking trace at clos-

est endpoint only. 

1 

Move Vertex Picks closest junction (vertex) of two traces. Both traces then follow 

the mouse by moving parallel to themselves and staying connected. 

2 

Move Chamfer Picks closest trace. Each endpoint of the trace needs to be connected 

to another trace. All three traces then follow the cursor by moving 

parallel to themselves (as a group). 

3 

Drag Trace Picks closest trace and traces connected to each of its endpoints. The 

picked trace follows the cursor by moving parallel to itself while the 

connected traces will be stretched (the other endpoints of the con-

nected traces will stay unchanged). 

3 

Drag Endpoint Picks the closest trace endpoint. The endpoint then follows the cur-

sor while the trace is stretched (the other endpoint stays un-

changed). NOTE: this is the same as the older “Edit/Stretch Traces”. 

1 

Drag Vertex Picks closest junction (vertex) of two traces. This vertex then follows 

the cursor while the traces are stretched (the other endpoints stay 

unchanged). 

2 

Drag Chamfer Picks the closest trace and the two guiding rails attached to each 

endpoint. The trace then follow the cursor while guided by the rails. 

NOTE: this is similar to the “Insert/Chamfer” tool in edit mode. 

3 

The shortcut key for the whole group of commands is F8. Pressing F8 will activate (or cancel) the last 
used “Edit Traces” command. Pressing Shift+F8 and Ctrl+F8 will step to the next  or previous tool (up or 
down through the menu listing). 

• Viewing of selected elements: 
Two new ways of visualizing selected elements have been added to the two that existed. They can be 
picked from “View/Visibility/Selected”, “Setup/Visibility” or the Visibility Toolbar. 
The four modes are: 



©PentaLogix, Inc., 1985-2023.  All rights reserved Page 96 of 135 

Mode Name Color For Unselected Color For Selected 

Display In White Layer color Bright white 

Display In Contrasting Color Layer color Color that contrasts with layer color 

Display By Dimming Unselected Dimmed layer color Layer color 

Display Unselected In Gray Dark gray Layer color 

 

The last two modes are the new ones. In both of these modes the selected elements are displayed in the 

layer color (both traces and pads, even if contrast is turned on). This is meant to help in cases where the 

continuity of the selected elements across layers is important to visualize, such as when examining 

netlists. In the last mode the unselected are displayed in one color independent of what layer they belong 

to. This color defaults to dark gray but can be set by the user to any other color using the “Set Layer 

Color” dialog that can be reached from several places (“Setup/Colors”, right-click on the Layers Toolbar 

or from the “Setup/Layers” dialog). 

• “Edit/Edit Selection”: 

 “Replace With Polygons”  

Replaces all selected elements with equivalent polygons. This is similar to the existing 

“Tools/Generate Polygon Outlines” (“/Vector” for CAMMaster) except that it acts on the 

selection only and does not swell the resulting polygons during the operation. 

 “Polygons/Replace With Overlaps”  

A new command that acts on the selected polygons (other elements in the selection are ignored). 

This operation takes every pair of polygons in the selection and replaces them with their overlap 

(or intersection), which is the copper area common to both polygons. 

Note that if two polygons do not overlap, there will be nothing to replace them with, so polygons 

in the selection which do not overlap any polygons will be deleted. Please see the document 

“Polygon_Intersection.doc” for more information.  

 “Special/Replace M-Type Pads With Primitives” 

This is a new command which works on the selection. It will replace all pads in the selection that 

are of shape M (Custom) with the primitives that make up the shape. The result will look exactly 

the same, but will contain no custom shapes. This can be useful when data needs to be exported 

to devices (or software) that have trouble understanding custom shapes (photoplotters etc.). 

A similar command already existed in the software, but was only accessible from the D Code 

Table (F5) and did not act on the selection, but rather on the D Codes that were picked from the 

table. That command was “Custom Apertures/Replace With Primitives” and is still there in this 

version as well. It has been improved to handle custom shapes that contain scratch primitives. 

Previously such shapes were not processed. Now, these shapes are converted to polygons and 

then the pads are replaced with these polygons. 

“Replace M-Type Pads With Primitives” works the same way: shapes with scratch primitives are 

replaced with polygons and shapes without scratch primitives are replaces with the constituent 

primitives (pads, traces, polygons).  

• “File/Import/Drill & Rout” 

Support for FMAT command in Excellon program header.  

• Blankouts 

Blankouts (also known as Exclusion Zones) are a set of rectangles that can be specified by the user. They 

are not part of the database and will not be exported or imported and in that way are similar to the frame. 

The main purpose of blankouts is to mark areas that will be excluded from certain operations. Currently 

they only apply to netlist extraction, Lloyd-Doyle AOI output and CAMTEK AOI output, but may in the 

future be used for other operations as well. 

The “Blankouts” menu appears in several places: in “Setup”, in “Tools/Netlist” and in “AOI”.  
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When “Blankouts/Insert” is selected, the user can add new blankout rectangles by clicking and dragging 

with the mouse or using the “Tab” key from the keyboard (same as one would operate for selecting). 

Blankouts can be saved and read from  files. Two formats are available: the PentaLogix format and the 

CAMTEK format. Blankouts are also saved in jobfiles (.bin files). 

They can be turned on and off with the “Blankouts/Show” command. Blankouts affect the netlist and AOI 

operations in the following way: 

 Contour netlist (“Tools/Netlist/Extract Contour”): blankouts act as scratch elements during netlist 

extraction. They will erase anything that they cover. This can be useful when extracting a netlist 

after certain fabrication artifacts have been added that would alter the connectivity information 

in undesired ways. Plating bars across fingers is an example. One can tell the netlist extract to 

ignore them by placing blankouts over them. 

 Contour Lloyd-Doyle (“AOI/Lloyd Doyle/Contour”): blankouts will act as described above, but 

only when “Blankouts/Treat As Scratch” is checked. Otherwise (if unchecked) the blankouts will 

have not effect during netlist extraction. 

In both cases, whether checked or unchecked, if blankouts exists and are visible (“Blankouts/Show” is 

checked) then the blankout info will be output to the Lloyd-Doyle file and will be available at the Lloyd-

Doyle workstation. 

• “Setup”: 

 “Layers” (F10) Context Menu: a new command has been added – “Compact”. The purpose of this 

command is to eliminate any empty layers from within the sequence of layers in a job. Layers 

will be transferred so that the relative layer order is the same, but there are no intervening empty 

layers. 

  “Visibility: 

All the global visibility settings for elements have been assembled into this dialog. All these items 

exist as other menu entries or dialogs, under “View/Visibility/…” but have been assembled here 

for quick access. 

 “Colors”: 

To set the color of the current layer. 

• Context Menu (mouse right click): 

Added a new command: “Draw To Flash” which will perform the same operation as “Tools/Convert 

Drawn Pads/Global” with the currently set parameters (it will not display the dialog for the parameters). 

The method used is “standalone”.  

• “Tools/Delete Pads”: 

The “delete unused pads” part of the “Delete Pads” module has been significantly improved. The new 

code uses contouring methods to find the unused pads, whereas the old method used vector methods. In 

addition to being more accurate, the new method handles: arcs, polygons, custom shapes (M-type D 

Codes), paint-and-scratch and negative layers. None of these were handled by the old method. The old 
method is still available under “Tools/Delete Pads/Vector”. The new method is “Tools/Delete Pads/Se-

lect Unused Pads”. 

It works on the selection only, so you need to select all the elements (both pads and non-pads) that you 

want considered. In addition, as for all other operations, only visible parts of the selection are processed. 

Within the selection, the processing is done one board layer at a time, with proper consideration for pain-

and-scratch as well as negative layers. 

Unused pads are those pads that are electrically connected only to other pads (or are completely isolated). 

Used pads are those that are electrically connected to traces, polygons or to negative copper areas.  

At the end of the operation the selection will consist of the unused pads ONLY. If there are no such pads 

then the selection will be empty. At this point these pads can be easily deleted (by pressing the Delete 

key) or they can be further processed as desired. 
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• “Tools/Routing”: 

Two new commands have been added which operate on selected routing paths: “Arcs To Chords” and 

“Chords To Arcs”. They are similar to the commands which operate on polygons, but work with both 

open and closed routing paths. The “Chords To Arcs” command which will try to approximate sequences 

of edges with arcs, can be used indirectly to convert to arcs chains of traces also. Several operations are 

needed in this case: select the traces in the chain, do “Tools/Routing/Group To Paths” to convert to rout-

ing paths, then “Tools/Routing/Chords To Arcs” and finally “Tools/Routing/Ungroup To Traces” to get 

back the traces. 

• “Layers Toolbar” 

Two buttons have been added to facilitate access to two frequently used commands from  “View/Visibil-

ity/Layer”: “Next Layer” (Shift+Equals) and “Previous Layer” (Shift+Backspace). 

•  “File/Import”: 

  “Excellon”: Files with ‘T’ codes that also have ‘Feed or ‘Speed or ‘Diameter commands on the 

same line will be recognized as Excellon. 

 “Apertures”: TraxMaker apertures are now supported using the same algorithms as Protel.  

  “Directory- Zip- Guess”:  

Gerber files that use CR/LF as a block delimiter.  Dialog boxes now have radio buttons for 

Asterisk or CR/LF block delimiters. 

G70/71 (inch/mm) will be recognized in extended Gerber files.  

Will now gray out parameters defined in files so that the user cannot change things like the 

Inch/MM. 

Will gray out Quadrant and 360 arc buttons only if G74/ G75 have been found, and G74/ G75 

appear in the file before the arc commands (G02/ G03). 

Excellon files in inch will be set to 2,4 but won’t be grayed out in the view format dialogs. 

When “Format unknown files to known files” is checked in the options box; if the unknown file 

had m,n or in/metric defined, the algorithm will not change those values. 

•  “File/Print” 

A new item has been added for the “Content” box: “Visible layers (combined)”. This will print on one 

page all visible layers. 

• “Swell”:  speed has been improved, especially for swelling large polygons. 

• “Polygons”: “Make Well Formed” and “Chords To Arcs”: More accurate results are computed. 

• “Setup/Layers” 

The height of the rows in the layers dialogs is now remembered and restored. The height can be adjusted 

by moving the cursor to the border of two rows, waiting for the cursor shape to change, then dragging 

the border to the desired position. 

• Visibility Toolbar 

A new button has been added for the visibility of polygons. A group of four buttons have been added to 

control how the selected elements are displayed (two of these modes are new in this version, see below). 

• Insert Toolbar 

A new button has been added for the new “Insert Chamfer” tool. 

• “AOI/Lloyd Doyle” 

Blankouts are supported. See the description of blankouts under “Added features”. 
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In addition the frame interacts with the export of Lloyd-Doyle data in two ways: 

 The lower-left corner of the frame will be the origin (0, 0) of the exported data. 

 Only elements inside the frame will be exported. Elements that are completely outside will be 

ignored and elements crossing the frame will be clipped at the frame border. Note that 

connectivity will be computed considering all elements (even the ones outside the frame). It is 

only at the export stage that the frame interacts with the data. 

• “Tools/Netlist/Convert Netlist File/To IPC” 

 PADS Netlist Import now recognizes drawn pad shapes such as circle, square, and rectangle.  The output 

will now generate all square and rectangle shapes rather than outputting those shapes as circle.  Inner 

layers are now included in the output. 

9.0.50: 

• Context menu (the right-click menu over the view) 

The most recently used command will appear as the first entry of the context menu, to facilitate repeating 

the same command. 

• “Edit/Edit Selection/Arcs/Break Into Quadrants” 

Same as “Tools/Convert Arcs/Break Into Quadrants”, but works on selected arcs. 

• “File/Import/Drill & Rout” 

“Options/Options”: new options added for importing Excellon files. 

The purpose of this new option is to specify the user desired handling for the “Block Delete” command 

(the slash (“/”)) at the start of a  block. There are now three possibilities in the new “Block Delete” box: 

(1) Follow BLKD command: the BLKD command in the header of the file will specify whether blocks 

marked with slash will be read in or ignored. The two forms of the BLKD command are “BLKD,ON” and 

“BLKD,OFF”. 

(2) Read in always: BLKD commands in the header are ignored and blocks marked with slash are always 

imported. 

(3) Delete always: BLKD commands in the header are ignored and blocks marked with slash are always 

deleted (ignored). 

Note that the last two options will override any BLKD setting in the header of the Excellon file. 

•  “File/Save Options” 

The two options: “Include Net Info” and “Step And Repeat Blocks” have been moved to a new dialog: 

“Preferences”. This dialog also has a new item, the desired version number of the jobfile (.bin file). 

With newer versions of the CAM software, as more features were added, the jobfile format needed to be 

updated. The current version of the jobfile format is 9, but it is in general not directly related to the ver-

sion number of the software. Older versions of the software can of course not read these new jobfiles, so 

the option has now been added to save older version jobfiles when needed. 

When a user chooses for output an older version jobfiles and the job contains elements and features that 

cannot be represented in that version, those elements will be dropped or converted (if possible). The user 

will be prompted before the output. 

For a short history of jobfile version numbers press the “Info” button in the “Preferences” dialog.  This 

feature is especially useful when saving files for the Pulsar photoplotters.  The Pulsars cannot accept files 

newer than version 6. 

• “File/Export/Cutter Code (HPGL)” 

There is now an “Options” dialog that allows specification of whether to output pads and the manner in 

which they are output. There are three choices: pads are not output, they are output as a “Pen Down” or 
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they are output as a small circle. Previously pads where always ignored. 

• “File/Import/Guess or Zip or Directory” 

 Filenames with the extension of “.err” will be ignored.  Files that have import parameters defined in the 

file, will be displayed with those parameters grayed out (cannot be changed). 

9.0: 

• Basic support for routing 

New data structures have been added to represent NC routing paths. Simple rout files can be exported 

and then processed further in RoutMaster. The new commands are found under “Tools/Routing”. Excel-

lon rout files can be imported. For more information on this topic please see the document “CAM Sup-

port for Routing”. 

• Custom Properties 

These are properties that can be attached to the database elements: pads, traces etc. They have the form 

“Name=Value”, where Name and Value are arbitrary. Their greatest use is as a selection criterion. That 

way one can first select (and then operate on) elements that have certain custom properties. 

There is a new toolbar “View/Toolbars/Custom Properties” and a new command which appears in two 

places: “View/Selection/Custom Properties” and “Select/Custom Properties”. For a more detailed descrip-

tion please see the document “CAM Custom Properties”. 

• A new layer type has been added 

The new type is a generic plane layer type. Previously there were five power layer types (PW1-PW5) and 

five ground layer types (GD1-GD5). In addition to these, there are now 99 generic plane layer types (P01-

P99). They can be used for netlist extraction for either ground or power plane layers. 

• A new navigation aid has been added 

One can now drag the view by dragging the mouse (with the left button pressed) while both the Ctrl and 

Alt keys are pressed. Since redraw times can be long when a lot of data is loaded, the drag can be done in 

real time or not. This real time feature can be enabled or disabled via “Setup/Preferences/Drag View In 

Real Time” or “View/Preferences/Drag View In Real Time”. 

• Area Computation. 

One can now compute the copper area of the selection with a command that appears in two places: 

“View/Selection/Area” and “Select/Area”. It is similar to the “Tools/Calculate Copper Area” in that over-

lapping elements will be counted as combined and that scratch elements will subtract from the area com-

putation. It acts only on the currently selected elements and will display the result of the computation in a 

dialog so that the resulting number can be pasted into other documents. 

Similar to other tools and commands it currently operates only on primitive elements. This means that 

composites: step-and-repeat blocks and text blocks are not counted. 

• Commas as decimal separators 

In the case of numbers typed into dialogs: commas can now be used as decimal separators (as well as 

points) to facilitate data entry in countries where the point is not the decimal separator. So the numbers 

“1.2345” and “1,2345” will be considered the same. 

• “File/Import”: 

 “Guess”: a new command for importing files of unknown type or format. The software will 

attempt to guess the type (Gerber, DPF, Excellon, netlist, etc.) and (where applicable) the format 

(Leading/Trailing etc.). The file is then imported into the current layer. 
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 “Aperture”: the wizard now has an additional radio button: “TCodes”.  When selected, only a tool 

code and a drill size need be identified. The wizard will translate the codes into Tool codes rather 

than D codes. 

 “Directory” and “Zip”  

Now recognizes bitmap files (.BMP), and netlist files. 

•  “Insert/Text” 

 A new check-box has been added to the “Add Text” dialog called “Grouped”. This will determine 

whether the newly inserted text will be grouped or ungrouped. It was done so that users who 

prefer the old (ungrouped) way of storing text do not need to do an “ungroup” after the text is 

inserted (one can always do an “ungroup” after the fact using “Edit/Edit 

Selection/Text/Ungroup”). 

 A new font has been added: ODB Standard. 

• “Edit”: 

 “Edit Selection”: 

“Replace Arcs With Chords”. Same as “Tools/Convert Arcs/Approximate By Chords” but works 

on the selected elements only. Note that the “Tools…” function works on all active elements that 

are inside the frame.  

 “Polygons/Replace With Skeleton”:  

Each selected polygon will be replaced by a set of F-Type traces and pads which constitute the 

“Medial Axis” or “Skeleton” of the polygon. The skeleton is the set of all points inside a polygon 

such that a “clearance disk” centered at such a point touches the polygon at two (or more) 

distinct places. Note that pads can also be part of the skeleton: the skeleton of a polygon that is a 

circle will be just one point and so a trace cannot be used to represent it (it would be zero-length). 

There are three methods for generating the skeleton: 

Complete: the whole skeleton is generated 

Backbone only: small details around junctions points are eliminated. 

Endpoints only: this is not really a skeleton, but pads are generated at the “endpoints” of the 

selected polygons. 

The last two methods use a parameter called “Brush Width” which specifies the width of the 

details that can be ignored. A brush of the given width, painting along the backbone, should 

never paint outside the boundaries of the polygon. 

 “Polygons/Replace With Inscribed Pad”:  

Each selected polygon will be replaced by a circular pad, such that the circle that the outline of 

the pad represents is the largest possible inscribed circle in that polygon. A larger circle cannot be 

fitted inside the polygon without crossing the edges. 

 “Step And Repeat”: A new way to load the step distance. There is now a button to the right of the 

Step X and Y fields (labeled “<”). When pressed it will load the step fields from the current 

values of the X and Y boxes in the “Screen” toolbar. Most useful when the display is in relative 

mode or distance measurement mode. 

•  “Setup/Preferences”: 

 View In Real Time”: see the “drag the view” item above. 

 “Ignore Preferences From Jobfiles”: affects the processing of user preferences and 

parameters when job files (binfiles) are opened. When checked, these preferences will be ignored 

(the data in the job files is of course read in). Some users prefer to have the preferences set a 

certain way and do not want them changed by opening a job file. One example of a set of such 

preferences are the Gerber import options (from “File/Import/Gerber/Options”). 
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• “Setup/D Codes” 

A new command to quickly go to the first unused D Code following the current D Code (“Goto/Next Un-

used”). 

• “Setup/Frame/Visible” 

Command to turn frame visibility on or off. 

• “Setup/Advanced/Intensity Contrast By RGB” 

This defines how the color intensity contrast is done for the following commands: “View/Visibility/Ele-

ment/Options/Show Pad-to-Trace Contrast As Contrasting Intensity” and “View/Visibility/Selected/Dis-

play In Contrasting Intensity”: 

When unchecked, the contrasting color is taken from the table of fifteen defined colors. The table is con-

ceptually divided in two halves, where the lower half (colors 1-7) is usually the “low intensity” half and 

the upper half (colors 8-15) is usually the “high intensity” half. The contrasting color will be the corre-

sponding spot in the other half (so 1 and 9 are contrasting, 2 and 10 etc). 

Note that the actual colors in the table of 15 can be redefined by the user in an arbitrary fashion, so the 

two halves may not really reflect the “low intensity”/”high intensity” division, but the contrasting mecha-

nism will stay the same. 

When checked, the contrasting color will be derived by flipping the high order bit of each R,G,B compo-

nent of the layer color. For instance, the color that is normally color “1” in the fifteen color table (Dark 

Blue) has R=0, G=0, B=127 (7F hex), so the contrasting color will be R=128, G=128, B=255 (a color that is not 

in the default fifteen color table). 

Some users prefer this mode, although it can be problematic. For instance: a color very close to the Dark 

Blue from above, for instance R=0, G=0, B=128 (80 hex) will contrast to R=128, G=128, B=0, which is quite 

different to the previous contrasting color. 

• “Location and Dimensioning Tool Setup” dialog 

A new mode for the number of digits after the decimal point has been added: “Exact”. When this option 

is chosen, that exact number of digits will appear after the decimal point including any trailing zeros. 

This is useful when the number of digits after the decimal point imply a tolerance for the drawing. The 

old mode of “Maximum” still exists and works the same way – at most that many digits will be gener-

ated, but trailing zeros are dropped. 

• “Go/Favorite Positions” 

A new command has been added, “Remove All”, to clear the current list of favorite position (leaves the 

list empty). 

• “Help”: 

 “Check For Updates”: Checks the PentaLogix website and reports if there are newer versions of 

the software available for downloading. 

 “Release Notes”: To read the release notes for the current version. 

• New accelerator keys (shortcut keys): 

 

File/Import/Drill Shift+F2 

File/Import/Guess F4 

File/Import/Directory Ctrl+F4 

View/Toolbars/Navigation Shift+F12 

• “View”: 

 “Toolbars/Editing”: the “Delete” button has been moved to the end of the toolbar.  Some users 
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have complained that it was too easy to press it by mistake.  

• “Edit/Edit Selection/Swell” 

Previously, if N-type D Codes were in the selection, an error message was displayed and the swell was 

not done. Now, N-type D Codes in the selection can be swelled, but only if all of the D Codes of that tool 

number are in the selection (otherwise a transcoding of the tool number would be necessary and this is 

currently not supported). 

• “Insert”: 

 “Text”: the font of the dialog has been changed to Courier, which is a fixed width font. This 

facilitates entering tabular data into the “Text” box (columnar text where the columns need to 

line up). Note that for this to work the chosen CAM software font should also be of fixed width 

(one of: DMPL, Uppercase, ODB, 4X7 or 5X7). 

 “Location”: the coordinates that are inserted will be relative to the “Relative Origin” when in 

“Relative” mode. 

• “File/Import”: “Directory” and “Zip” 

the transcoding report (if there is one) is written to the directory of the imported file(s), with name 

“Transcode Report.txt”. Previously the user settable report file path was used (from “File/Report/Set 

Name”). 

• “Tools”:  

 “Generate Outlines/Vector”: 

All D Code shapes are now processed correctly. In the past, more complex shapes were 

approximated by rectangles. 

The result of the outlining operation is polygons, instead of F-type traces. If the F-type traces are 

the desired result, the polygons can be converted to that by using the “Edit/Edit 

Selection/Polygons/Polygons To F” command. 

Important note for those who use the Macro command “.GenerateOutlines”: you will need to 

change your code to convert the polygons to traces (as mentioned above) after calling 

“.GenerateOutlines”. 

 “Convert Drawn Pads/Global”: 

speed has been improved and results are more accurate. 

8.4.50 

• Layer Visibility: 

”View/Visibility/Layer” Two new commands have been added to facilitate turning ON and OFF groups 

of layers: 

  “Make Visible” - Shift+F10  

  “Make Invisible” -  Ctrl+F10 

One can type a list of layer range, such as “2-4, 14, 20-23” and this list can be interpreted as either 

layer numbers or board layer numbers (determined by the “Board Layer” item in the dialog). 

• High Resolution Only 

“File/Save Options”: The “High Resolution” option has been removed. Binfiles are now always saved in 

high resolution. Low resolution is only needed for versions 6.0 or earlier of the CAM software. 

• Scroll Bars Changed 

“View/Scroll Bars”: the scroll bars now scroll over the loaded data rather than over a user defined work-
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space (“Setup/Preferences/Workspace”). For instance: moving the horizontal scroll bar to the leftmost po-

sition will place the view over the left margin of the loaded data. 

• Contour Netlist Enhancements 

“Netlist Extraction/Contour” IPC and F04 output files have been enhanced: 

 Net name (fields 4-17) are now left justified  

 Board Outline is now included: 

 as 389Board_EDGE (board outline record).  Any trace data in CAMMasters’ BOL layer will be 

transferred. 

8.4.10 

• Custom Toolbar for Scripts: 

For user scripts (Sax Basic macro files) “View/Toolbars/Custom” 

Each button is mapped to a file, which must be a Sax Basic compatible Basic file (“.bas” extension). The 

buttons will display a bitmap or a button number. A bitmap will be displayed if a “.bmp” file exists in the 

same directory as the “.bas” and has the same name as the “.bas” file. These files can be made by the user 

using Microsoft paint or some other application that handles Windows bitmap files. The dimensions of 

the bitmap should be 16 by 16 pixels.  One can add buttons to the toolbar by right-clicking on the toolbar 

and selecting “Add A New Button” or by selecting one or more “.bas” files in the Windows Explorer and 

dragging and dropping them on the toolbar. With the second method several buttons can be added at 

once.  One can delete buttons unless the toolbar has only one button (there is always at least one button 

on the toolbar).After adding buttons to the toolbar, it may need to be resized so all the buttons are show-

ing. 

•  Elements Overlapping Cursor : 

“View/Info/Elements Overlapping Cursor”: A new command to provide information about elements cov-

ering the cursor. A list of all the elements (pads, traces etc.) which cover the cursor will be displayed. 

This is useful when investigating pad stacks, as it is difficult to know how many pads there are on top of 

one another. It can also be used in troubleshooting connectivity as one can see the net names of all ele-

ments that connect at a certain point.  

• Exporting Polygon Data: 

“File/Export” Gerber varieties: Improved rounding of polygonal data when exporting to lower resolu-

tions (lower than .6 in English or .5 in metric).  

8.4 

• Navigation View:  

A navigation view has been added to show an overview of the relative positions of the current view and 

the visible data and to allow quick modifications of the view (“View/Toolbar/Navigation”). The current 

view is represented as a black rectangle and the extents of the visible data are shown as a filled green rec-

tangle. 

As opposed to the other toolbars, the Navigation View is not dockable, as its square nature would cause it 

to take up too large an area of the screen. However its size and position can be modified by the user and 

it is remembered and restored at the next activation of the software.  The input focus can be shifted to the 

Navigation View by clicking on it or by pressing Ctrl+PgUp. While in the Navigation View Ctrl+PgUp 

will transfer control back to the main view.   

The Navigation View window responds to the following user interaction: 

 Left mouse button drag-and-draw: 

 the view will match the user drawn rectangle. 

 Left mouse button click: 
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 will center the view at the spot of the click (at the current zoom level). 

 PgUp: 

 zoom up (same as pressing PgUp in the main view). 

 PgDn:  

zoom down (same as pressing PgDn in the main view). 

 Arrow keys:  

pan the view in the direction of the arrow. 

 Home:  

Same as pressing Home in the main view. 

• Wheel Mouse Support 

Added support for navigation with a wheel mouse and support for the middle button of three-button 

mice: 

 Rolling the wheel 

 zooms in and out. Rolling forward zooms in and backwards zooms out. Each click zooms the 

same amount as a PgUp or PgDn would do. This mode is only active if the scrollbars are off. 

When the scrollbars are on, rolling the wheel will normally scroll up and down. 

 Clicking the wheel  

(or middle-button of a three-button mouse) will pan the image so that the spot where the click 

happened will end up in the center of the screen. This is similar (though not identical) to using 

the End key. One can pan repeatedly in one direction by making sure that the arrow and crosshair 

cursors are not joined, then moving the arrow cursor close to one of the window edges and 

clicking the wheel repeatedly. 

Notes about setting up the mouse: Mouse button actions and properties can be set up in the Windows Con-

trol Panel. The wheel is often set up to cause a scrolling action and pressing the wheel (or middle button) 

is sometimes set up to simulate a left button double-click. These are user preference that can be changed if 

desired. This is how these settings interfere with the new features introduced above: 

 Scroll: 

If the wheel is set to scroll (in the Control Panel) and the CAM scrollbars are visible, then moving 

the wheel will scroll vertically rather than zoom. This action was present in older versions of the 

software as well. Note that if the scrollbars are not visible (“View/Scroll Bars”) then the setting in 

the Control Panel does not matter. 

 Middle Button: 

If the wheel (or middle button) click is set to some other action (other than “Middle Button” or 

default), the panning described above will not work. Instead, pressing the wheel will activate 

whatever action it has been programmed to generate in the Control Panel. 

So, if the new functionality is desired, one must make sure that the mouse is set up as desired in the Win-

dows Control Panel. In certain cases (depending on the type of mouse) the action of the buttons can be 

programmed per application, so one could have a particular setting for the CAM software and a different 

one for other applications.  

•  “Setup/Layers” (F10): 

By layer or Board Layer:  These two views of this setup dialog are now available. The first:  By Layer  

is the same as the operation of this dialog in previous versions.  By Board Layer shows only board layers 

(one entry per board layer). 

When one changes a setting for an entry in this mode, all layers in that board layer will be changed. For 

instance, changing the color of a board layer will cause the color of all layers in the board layer to be 

changed.  

• Mouse Right Click 

The context menu (right mouse click) has several new commands. Two commands that previously 

showed up only when clicking on top of the “B Layer” column heading now appear at all times. The new 
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commands are 

 “Move Up”,  

 “Move Down”  

The “Move” commands will move (up or down) by one position a sequence of layers starting 

from the layer that one clicks on and continuing with all successive loaded layers (until the next 

empty layer is reached). This is useful (for instance) for making an empty spot to insert a VIA 

layer. 

 “Insert Selection” 

”Insert Selection” will move a selected layer (or range) to the location where one clicks. Loaded 

layers in the destination range will be moved up to make room for the inserted layers. This 

command is useful for rearranging the order of layers. 

The previously existing commands that now always appear on the context menu are “Renumber 

board layers” and “Order layers by B Layer”.  

• Layers Toolbar: 

 Context menu (right click). Two menu entries have been added:  

 “Board Layer ON”  

 “Board Layer OFF” 

 These will turn the visibility of a whole board layer ON or OFF that is for all the layers that are 

part of that board layer.  

• Remember Directory for Import 

“Setup/Remember Directory for Import”: If set, the File/Import dialog will open in the directory last used 

for a File/Import operation.  

• Import Files 

 “File/Import” has new features: 

 “Bitmap”: Reads Windows bitmap files (.bmp) and converts them to polygons. This is useful 

mostly for generating CAD data for legacy designs (for which only film exists). The fist step is to 

scan the film and convert it to a bitmap file. The bitmap file is then imported into CAMMaster. 

The ideal input file has one bit per-pixel, where black pixels represent copper and white pixels 

are the background. CAMMaster will accept other types of bitmap files as well and will attempt 

to separate copper from background using the color (or gray scale) value of the pixels. The 

following bit-per-pixel values are supported: 1, 8, 16, 24 and 32. 

Ideally, the scanned image should be first pre-processed (using image processing software), to 

sharpen edges and convert the image to black and white (preferably 1 bit-per-pixel). If that is not 

possible CAMMaster has two parameters users can set (in the Options dialog): 

Treat Dark or Light pixels as copper (basically whether the image is positive or negative). 

How to separate Black from White in a grayscale or color image (this only applies to images that 

have more than 1 bit-per-pixel). The user can specify the intensity of the pixel above which it will  

be considered white. For RGB images, the intensity is the average intensity of the red, green and 

blue components. 

  “Drill”: 

 added support for the following Sieb & Meyer format commands: 

M97, M98 (Drill Plain Text),  G84 (Nibble Hole),  G85 (Nibble Slot). 

• Export Files 

“File/Export” has these features: 

 “DPF”: export in Barco DPF format as documented in “DPF Format Description”, DPF Version 5, 

November 1998, Barco Graphics.  

 “Drill”: 

For Excellon format: a new option for exporting Step & Repeat blocks: “R Repeat Blocks”. If 
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checked, repeat codes (R#) will be used when possible. If unchecked, repeat codes will not be 

used and each M02 block will be output by itself. This is useful for machines that do not support 

the R codes and to minimize the number of M01 (End of Pattern) commands, as there is a 

limitation of at most 3 nested M01s (Excellon spec). 

For Sieb & Meyer format: support for G84 (Nibble Hole) and G85 (Nibble Slot).  

• Polygons with Holes 

The ability to replace polygons with holes with a set of polygons without holes. This is useful for many 

reasons. One is that the Gerber syntax for polygons (G36/G37) does not allow specification of certain pol-

ygons as being holes inside other (containing) polygons. As a result, in order to represent polygons with 

holes in Gerber one has two options: 

Make the holes scratch entities (on a separate layer) 

Decompose the polygons with holes into a set of polygons without holes (which fit together similar to a 

jigsaw puzzle). 

Method (2) has been added in this release. In appears in two places: 

 “Edit/Edit Selection/Polygons/Decompose Into Strips”: 

Will replace any selected polygons that have holes with a number of horizontal polygonal strips 

without holes, such that the result will represent the exact same copper (same image).  

 New Tab: 

A new tab in the “File/Export/Gerber” Options dialog called “Polygons”: 

It has two choices for exporting polygons with holes: “Put holes in scratch layer” and 

“Decompose into strips”. Note that this does not modify the database itself, it just controls how 

the polygons are exported. Also note that this tab does not appear for exporting MDA Gerber 

data, as polygons with holes can be represented using POIN/POEX D Codes.  

• Custom Shapes - Polygons with Arcs 

 (D Codes of type M) can now contain polygons with arc edges. Previously only polygons with straight 

edges were stored and arcs were replaced with approximating straight edges.  

These types of shapes can be generated from several sources: 

 File import 

  D Codes table/Dimensions/Build Shape: 

 when the frame includes polygons with arcs 

 Tools/Convert Drawn Pads/Global:  

when the convert pads included polygons with arcs Note that if these shapes exist in the data 

and a binfile is saved, a new version of the binfile will be written (version 7) which will not be 

accepted by older versions of the software. 

For exporting Gerber extended variants: The standard Gerber extended does not have a polygon 

primitive with arc edges (for custom shapes). When exported these edges will be replaced with 

chords. The MDA extended Gerber format allows arc edges for the polygon primitives.  

• New Edit Selection Features 

“Edit/Edit Selection” has these new features: 

 “Swell”: 

 a new option has been added - “Transcode all swelled D Codes”. If checked will force all D 

Codes that are swelled to be transcoded even when no unselected elements of that D Code exist. 

This is useful when preserving the integrity of the original D Codes is desired.  

 “Match Two Points”:  

This is a general purpose transformation which combines translation (move), rotation and scaling 

in one step. The user picks two pairs of points. The transformation is done so that the first point 

in each pair is transformed into the second point. 

Note that although all elements in the selection are transformed, the D Codes with which they 

are drawn are not. Because of this, it is most useful for transforming polygons.  
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 “Step And Repeat”:  

added the ability to edit and change step-and-repeated data. The procedure is the following: 

(1) Select the step-and-repeated data. 

(2) Do “Edit/Edit Selection/Step And Repeat/One-up”. This will remove the step and repeat from 

the selected data and make the result ordinary data that can be edited and modified. Up to this 

point all of the above was available in previous versions. What we have added is that after “One-

up” is done the “Step And Repeat” menu will show the step-and-repeat parameters that have 

just been removed (counts and displacements) at the bottom of the menu (in  a list of up to 5 

recent step and repeat parameters). These parameters can later be reapplied by just selecting the 

menu item. 

(3) Edit the one-up data as desired. 

(4) Select the data for which the step-and-repeat needs to be restored, then pick the step-and-

repeat parameters from the bottom of the “Step And Repeat” menu. 

When step and repeat blocks are nested, this procedure may need to be repeated several times if 

the data to be edited is in some inner step-and-repeat block.  

 “Polygons” 

“Separate Holes”:  

For all polygons with holes in the selection: remove the holes and add as separate polygons.  

“Group Holes”: 

 Group all the contours in the selected polygons and attach as holes contours that are included in 

others. A contour is defined as a closed path component of a polygon and could be a container or 

a hole. 

Note that for polygons that do not overlap a “Separate Holes” followed by a “Group Holes” will 

reconstruct the original polygons. 

 “Replace With Fill”:  

Selected polygons will be replaced with filled areas using traces of a D Code specified by the 

user. This D Code must be of shape “C”. Note that to achieve the same result in the past, the 

polygons had to be converted to F outlines and then one could use “Tools/Fill Polygons/Solid”.  

• Insert Text Spacing 

Extra Spacing -  items added for extra character and line spacing. Character and line spacing can be in-

creased by entering the desired values in the dialog boxes. Use 0 for default spacing.  

• “Go”: 

 “Center Of Selection”:  

moves the cursor to the center of the bounding box of the currently selected elements.  

 Center of Element: 

“Active Element/Center of Closest”.  Similar to “Active Element/Closest” except that the cursor is 

moved to the center of the element. Most useful for polygons. Shortcut is Ctrl+Shift+A.  

• Shortcut keys: 

 Layers greater than 9: 

To make active a layer number larger than 9. It was previously not possible to quickly set active a 

layer number that had more than one digit. Pressing any of the digit keys would make the 

corresponding layer active. 

To set higher numbered layers the Ctrl+Shift modifier has been added. So to set the active layer 

to 24 and should do the following: 

Press Ctrl+Shift, while keeping Ctrl+Shift pressed press 2, then 4, then release Ctr+Shift. This 

would be 3 keystrokes. 

Note that this does not save many keystrokes over the already existing way (“Setup/Layer/Active 

(L)”), which would have required: 

L, 2, 4, Enter (4 keystrokes). 
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However, some people seem to prefer the new method.  

 Dimensioning Tool: 

For the dimensioning tool (Insert/Dimension): Ctrl overrides the “Extended bars” setting in the 

setup dialog.  

• View Loaded Data From 0,0 

“View/Zoom/…Include (0,0)” This affects the operation of the “View/Zoom/To Show All” (Home) com-

mand. If “…Include (0,0)” is set then the origin (coordinates X=0, Y=0) is always included in the data dis-

played even when it is outside the loaded data (this is how to Home command worked until now). Some-

times it is desirable to only display the loaded data, as the origin can be far away from it. The user has 

now the option to pick the preferred mode of operation for this command.  

• New Contour DRC Features 

“Tools/Design Rules Check/Run Contour DRC”: 

 "Check Gaps with Same Nets":  option has been added. 

 “Soldermask Gap”: 

 “Mask to mask”, new rule added.  This will check the pad to pad air gap in the soldermask layer 

(when set to a non-zero value – when set to zero this rule is not used). Previously the check was 

done by using the “Trace to mask” rule.  

• New Netlist Features: 

”Tools/Netlist” now has the following new features: 

 Extract Contour and Extract Raster: Blind vias are output as 317 records 

 Extract Contour: If a through hole has no round covering pad, one will be automatically generated 

for it by picking the largest noncircular SMD (with same coordinate) as its covering pad. The 

SMD would still be output in the netlist 

• Changes to Printing Routines 

“File/Print”: The graphics rendering routines for printing have been changed. Windows GDI routines are 

now used instead of rendering to a bitmap and then sending the bitmap to the printer (as was done previ-

ously).  As a result, printing should now work for all printers. Previously some printers did not work 

properly because of memory limitations (the bitmaps were too large) or raster operation limitations.   

This change should also allow capturing the image in a PDF file (with Adobe Acrobat Distiller) or a Post-

Script file.   

Note: This new method does not work on Windows 98 or ME, in which case the old method (bitmap 

based) will still be used. It does work on Windows NT, 2000, XP, 2003 Server. 

The color output options have been reduced to two: “black on white” and “colors on white”. Note that 

colors will not be translucent when printed (this is different from how the colors show on the computer 

screen).  When running under Win98 or ME an additional check-box is shown called (“Negative”) which 

will cause the bits in a “black on white” output to be inverted (this is needed on some printers).  

• “File/Import/Job/Options” 

Origin selection has been removed. Origin is now always at (0,0). Allowing to set the import origin in a 

sub-dialog was confusing and dangerous. The imported data can always be moved later if that is desired. 

•  “File/Import/Gerber”: 

The user is warned if a self-intersecting polygon is encountered in the input.  

The "Full circles in polygons" settings has been removed from “Options/File Interpretation”. The “Ignore” 

choice caused full circles to be silently ignored, which was a problem for many users.  
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•  “File/Import/Netlist” 

Misaligned X and Y coordinates in the “Feature Location” field (columns 42-57) are now accepted. The 

IPC spec states that they should be right justified, but we have seen files where they are left justified. Pre-

viously this was considered an error. 

• “File/Import/Directory/Zip” 

 Files that contain all the necessary format information such as Extended Gerber will be displayed in 

“blue”.  The options menu now has a check-box “Format unknown files to formatted” If selected, files 

that do not contain all of the format information (such as drill files) will be formatted/scaled to  fully for-

matted files (such as Extended Gerber).  These files will be displayed in green and can still be edited. 

• Aperture Wizard 

A new check-box has been added in the third menu titled “Treat commas as decimal ex: 1,00 = 1.00” This 

will allow the  aperture wizard to import files using the European style of decimal identifiers. 

•  “File/Export”: 

 Gerber Extended:  

Custom apertures that contain arcs cannot be exported in Extended Gerber because there is no 

corresponding command to represent them. Previously this caused error 115 and the export 

aborted. The user then could have converted the custom aperture to replace the arcs. In this 

version arcs in custom apertures will be automatically exported as sequences of chords.  

 Gerber Varieties:  

Improved rounding of polygonal data when exporting to lower resolutions (lower than .6 in 

English or .5 in metric). 

• Setup Layer Improvements: 

“Setup/Layers” (F10): Position and size of the dialog as well as the widths of columns in the table are now 

saved in the registry and restored next time the program is started. Note that the width of the columns 

can be modified by the user by dragging the column separators.  

• Replicate to Non-Contiguous Layers 

In the Layers Toolbar; layers can now be replicated to a number of layers that need not be contiguous. 

Previously only a range of contiguous layers was allowed as the destination.  

• “Edit”: 

 Chords to Arcs: 

“Edit Selection/Polygons/Chords To Arcs”; improved detection of arcs.  

 Transcoding: 

“Edit Selection/Transcode”; The “First Unused” option has been changed to “First Unmapped”. 

This will pick the first D Code that is either not present in the D Code table or has shape of type 

“?” (unspecified).  

 Aligning Layers: 

“Move Layers/Align”; the guide element needs to be selected and to be the only selected 

element. Previously the guide element was the one from the last “element align with properties” 

(Shift+A) operation. The new method makes the identity of the guide element clearer.   

Also, previously the guide element was only matched against elements of the same D Code. 

There is now a new setup command “Move Layers/Align Method” that allows the user to pick 

the method to be used: same D Code (as before), same shape type and same shape (shape type 

and shape dimensions).  
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• TEXT is now Grouped 

The internal representation of text has been changed.   

In previous versions text was stored as a sequence of strokes (traces or pads) which were not distinguish-

able from other (non-text) traces and pads. With this new implementation text is a separate entity (a com-

posite element) so that it can be modified later (by editing the text string, changing the font, rotation etc.) 

This modification can be done with “Edit/Edit Selection/Text/Change” after selecting one (or more) text 

blocks. When selecting only one text block, all parameters of the text (including the text string) can be 

changed. When more than one text block is selected, only parameters that have the same value can be 

changed (the others are grayed out). An exception to this rule is the font, which can be changed even if 

the selected blocks have different fonts.   

Note that there are other methods to change parameters that are not common to all blocks. For instance 

one can change the D Code of a group of text blocks by using “Edit/Edit Selection/Transcode” (as one 

would for other elements).   

One can ungroup text by using “Edit/Edit Selection/Text/Ungroup”. This will transform the selected text 

blocks into their stroke representation (normal traces or pads).  

• Select Text: 

The Selection Toolbar criterion dropbox has a new added item called “Text” which can be used to select 

or navigate over text blocks.  Text blocks can only be edited with operations that would result in another 

text block. So, for instance, moving, rotating and mirroring are allowed, whereas scaling can preserve text 

blocks only if the two scale factors (X and Y) are the same. If there are not the same, scaling will be done 

but the text will be ungrouped before the scaling operation.   

For other commands, if one finds that they do not affect text blocks in the desired fashion the worka-

round is to ungroup the text blocks first.   

Text blocks will be ignored by most of the commands under “Tools”, except Netlist, DRC and “Generate 

Soldermask”. Note that for netlist extraction the copper of text blocks is taken into consideration when 

computing connectivity (of other circuit elements), but no net numbers are ever assigned to text blocks.   

Binfiles that contain blocked text will not be readable by older versions of the CAM software. If you need 

to send such data to users of older versions make sure to unblock all text blocks before saving the binfile.  

•  “Insert/Loc and Dim Setup” 

a new parameter has been added: “Max digits to the right of decimal”. This can be used to control the 

precision of the inserted text for location or dimension. Possible values are from 0 to 6 inclusive.  

•  “Tools/Design Rules Check/Load Errors from File ” 

More than one file can be loaded at the same time (with the same load operation). This allows the display 

of the contents of several files simultaneously. One example where this would be useful is for viewing 

together the results of several different DRC operations done with per layer rules.  

•  “Tools/Netlist/Extract Contour”: 

 Improved handling of paint and scratch layers  

 The method for determining covering pads has been improved 

 Pads with holes are not output 

 Lloyd Doyle layer-by-layer export: N/C drills are not output for each layer (other than drill layer) 

 Thru holes with no round covering pad will have one automatically generated by picking the 

largest noncircular SMD.  The SMD will be output in the netlist.  When the file is imported into 

Probe or Fix, the user can choose to test for hole or pad (Setup/Configuration/ Operations/ 

Remove Padstack - Keep Hole - Keep SMD) 

• Netlist, Extract Contour and Extract Raster 

 Endpoints identification has been improved 
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 Blind vias – are now outputted as a record 317 (thru hole) with the relevant access code set as well 

as drill and covering pad sizes 

•  “Convert Drawn Pads/Global” 

The algorithm for detecting and converting the pads has been improved  

8.2.21 

• Auto-Snap to Elements: 

“Go/Closest/Auto-Snap”.  When activated, will cause the cursor to snap to the closest active element be-

fore certain operations: element insertion, move etc. These are the same operations that cause the cursor 

to snap to the closest grid point when the grid is on. Auto-Snap uses the same criteria as Go/Closest/Align 

(“A”) except that a tolerance is in effect: elements that are farther than the tolerance will not be consid-

ered. 

When both the grid is on and Auto-Snap is active, Auto-Snap is tried first. 

One example when this is useful is when inserting traces that need to align with existing traces or pads.  

• Dimension Tool: 

”Insert/Dimension” 

New dimensioning tool (similar to the “Insert/Location” tool). 

Will insert dimensioning text and arrows. It is a three-step operation: 

(1) Pick the point to measure from 

(2) Pick the point to measure to 

(3) Pick the desired location of the dimensioning text, arrows and bars 

There is a separate setup dialog (Insert/Loc and Dim Setup) for specifying the text size and font as well as 

various options. This dialog is common to this and the Insert/Location tools. It can also be activated using 

a context menu (right click) while any of these two tools is active. The options that are specific to the di-

mensioning tool are: 

 Forcing Measurements  

to always be horizontal or vertical (depending on whether the vector from step (1) to step (2) is 

closer to the horizontal or vertical). Note that this setting can be temporarily overridden by 

pressing the Shift key while picking point (3). 

 Extending the Bars  

to reach close to the step (1) and (2) points. 

• Polygon Features 

”Edit/Edit Selection/Polygons” 

 “Make Well Formed”: 

Replaces any malformed polygons in the selection with well formed ones. Well formed polygons 

have no intersecting edges (except at vertices) and no overlapping edges. 

 “Chords To Arcs”: 

Approximates sequences of chords with arcs for polygons in the selection. The user can specify a 

tolerance. The new selection will consist of the changed polygons. If none were changed, the 

selection remains as before.  

 “Arcs To Chords”: 

Replaces arcs with sequences of chords that approximate them. The resulting polygons will 

contain no arcs. The new selection will consist of the changed polygons. If none were changed, 

the selection remains as before.  

• Convert Drawn Pads to Flash 

”Tools/Convert Drawn Pads/Global” 

This is a new way of converting drawn pads to flashed pads that uses contouring methods and acts on 
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selected elements. Drawn pads in the selection will be replaced with flashed pads and the resulting selec-

tion will be the newly generated flashed pads. There are two methods available: “standalone drawn 

pads” and “using a guide layer”. 

The standalone pads method should be used when the drawn pads are not continued with traces (or 

when such traces have been removed from the selection). 

The guide layer method uses elements in a different layer (the guide layer) to pinpoint the location of the 

desired drawn pads. Only those elements in the selection that are completely covered by drawn areas in 

the guide layer will be used for finding drawn pads. For the purposes of this computation the drawn ar-

eas in the guide layer can be inflated or deflated by a “Margin”, if desired. Usually the guide layer is the 

soldermask layer, but it could be any other layer chosen by the user. 

Once blobs have been isolated (in either of the two methods) only those whose max dimension is within 

the user specified min and max (“From” and “To”) will be considered.  The resulting contours are 

checked against the following standard shapes: C, S, R, O, D, E and Q using a user specified “Tolerance”. 

If none of these standard shapes match and the “Generate custom shapes” check-mark is set, then M type 

D Codes will be generated for these shapes. There is a sub option to this for allowing for concave custom 

shapes. Normally such shapes are undesirable as flashed pads. An example of a concave shape is a cross, 

whereas an octagon is a convex shape. Holes are only allowed in C and S shapes. Note that M shapes will 

contain a polygonal outline. Since the extended Gerber specification does not allow for arcs in custom 

shape outlines, all arcs will be converted to approximating chords.   

The elements in the selection that have been matched will be deleted and replaced with flashed pads. 

Note that if selection already has a pad that covers the whole area at a conversion spot, that pad will be 

preserved (existing D Code preserved) and any elements covered by it will be deleted.   

The starting D Code for the newly generated pads can be specified by the user, as well as the resolution of 

such shapes (all newly generated shapes will be rounded to the specified resolution).  

• Select by Intersection 

”Select/By Intersection”. Narrows an existing selection depending on the intersection of elements in the 

selection. The selected elements in the reference layer will be checked against the selected elements in the 

destination layer. Only those elements in the destination layer selection that satisfy the intersection crite-

ria are preserved in the selection (all other elements are removed from the selection, even from other lay-

ers). For the purposes of computing the intersection, the elements in the destination layer will be consid-

ered inflated/deflated by a given margin (which can be 0). 

The destination layer and the reference layer can be the same in which case the selection will be tested 

against itself (all elements in the selection versus all others). 

Elements that have zero width either as they are in the database or after being deflated by the margin will 

be ignored during this operation. 

• DRC Enhancements 

“Tools/Design Rules Check” now has these new improvements: 

 Polygons and Contour DRC:  

”Run Contour DRC” is now handling polygons. Previously polygons were ignored. To control 

what rules apply to polygons there is a new setting in the “Options” tab called “Treat Polygons 

As” with two possibilities: “Traces” and “Pads”.  

 Gaps within Same Net: 

New in “Options” tab: “Check gaps within same net”. When ON, gap errors will be checked 

even for elements that are in the same net (electrically connected).  

 Display Errors with ‘X’: 

”Display Errors” has an added option “X marker for all”. When ON, an X marker will be 

superimposed over the display of all errors. This is to facilitate finding errors for which the 

display vector is short. These are hard to see unless one is zoomed in on them. Previously the X 

marker was only displayed for errors that had a vector of 0 length. 

  Saving Errors to a File: 
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Commands to save/restore the error information to/from a text file: “Save Errors To File”, “Load 

Errors From File”. 

This is useful as a way to communicate this info to coworkers or save the information for future 

examination. Previously the DRC error info was lost when the job was closed. In addition, the 

resulting files are text files and could conceivably be used for further processing by custom 

software.  

• “Edit/Insert”: 

 Menu Location Has Moved: 

The position of the menu  has been move to “Insert” (top-level menu), because this is a very 

commonly used submenu. Note that the shortcut key (Insert) still works even with the new 

location. 

 Insert: 

When inserting a trace-type (linear or arc), the outline of the shape to be inserted will be 

displayed around the cursor as a guide to the user.  

• Setup Selected Tools: 

A new group has been added: Setup/Tool Codes (Shift+F5) with two buttons:  

 “Type + Diameter”  

Same as double clicking on the selected tools and will set the type and diameter of the selected 

tools. 

 “Type Only”  

Sets only the type of the selected tools, keeping their diameters.  

• Malformed Polygons in Contour Operations 

All contour-based operations: contour netlist, DRC etc. will now properly handle malformed polygons 

(see “New Features” for definition). Previously the operations would abort when such polygons (self-

intersecting) were found. 

• Extended Gerber Parsing 

Changed to where LP (layer polarity) commands do not reset pending G36 (polygon area fill) commands. 

We have seen customer files of the form: 
G36*%LPD*%X-1757Y13D02*…G37* 

Previously the LPD command would reset the G36 and the polygon would be lost (replaced with outline 

traces). 

• Compare Layers Supports Polygons 

 “Tools/Compare Layers”: support for polygons has been added. Previously polygons were ignored dur-

ing this operation. Also the option to transfer to another layer has been removed and the results are al-

ways returned as the new selection. If so desired, the user can always transfer the result after the compar-

ison is done.  

• Transcoding D Codes 

“Edit/Edit Selection/Transcode” (Ctrl+T): When the user is prompted for the D Code to transcode to, a 

choice is given between the current D Code and the first unused. Previously only the first unused would 

appear. Some users preferred the current D Code as they have just set it up in the D Code table in prepa-

ration for the Transcode operation. 

8.1 

• Save File (Crtl+S) 

Normal Windows shortcut for File/Save (Ctrl+S) has finally been implemented. We had postponed the 
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implementation of this shortcut because Ctrl+S used to have a different meaning in our DOS products.  

• BMP File Export 

“File/Print to .bmp File”: a way to generate standard Windows bitmap files from the currently loaded 

data; either the current view or what is inside the frame. The image can be combined layers or one board 

layer at a time (with one .bmp file per board layer). Besides other uses, this can be another way of print-

ing in cases where direct printing (to printer) does not produce the desired results. 

• File Import Enhancements 

“File/Import” now has the following: 

 Inexact Arcs: 

“Gerber/Options”: added an option in the “File Interpretation” tab called “Inexact arcs”. This 

controls how inexact arcs (arcs that have different radii at the two endpoints) are interpreted. 

One can pick one of two ways to deal with these arcs (as they are illegal as presented): 

  “Move center”  

If selected then the center of the arc will be moved to make the two radii the same. This is 

sometimes dangerous as the guessing for the arc orientation can be wrong resulting in “Mickey 

Mouse ears” (large multi-quadrant arcs where short single-quadrant arcs were intended by the 

user). 

 “Add connector” 

If selected then the center is preserved and one of the arc endpoints is moved to be closer to the 

center. A connecting linear “bridge” is added to go to the original endpoint (so that electrical 

connectivity is not lost). This would cause an arc to be replaced by an arc and a (short) linear 

trace.  

 Ignore G92/93: 

Added an option called “Ignore Excellon G92/G93” in “Drill/Options”. When set causes G92 and 

G93 commands to be ignored. These are “Zero set” commands that change the origin. 

• DRC Violation Colors 

DRC violation errors display colors are now saved in the .cfg file.  

• Net Compare Enhancements 

“Tools/Netlist/Netcompare/Compare Two Netlists”: 

 Mismatched N/Cs: 

A new option has been added: “Mismatched N/Cs”. If checked will flag as errors nets in REF and 

NUT that are N/C on one side but not N/C on the other. In previous versions N/Cs in NUT that 

were matching a non-N/C in REF were flagged as “NC Open” and there was no way to disable 

this behavior. Now this will be flagged only when the above option is checked. In addition 

(when the option is checked) nets that are N/C in REF but non-N/C in NUT will be flagged as a 

new error type: “NC short”.  

 Inconsistencies: 

The REF netlist can be checked for inconsistencies before processing starts (turned on or off via a 

newly added check-box).  

• Define Report Filename: 

“File/Report/Set Name”: to set the report file name. The report file is used in many operations where the 

name cannot be set, such as for generating D Code transcoding reports while importing Gerber files.  

• Screen Toolbar Display Boxes Widened 

Widened X and Y coordinate display boxes in Screen Toolbar to allow the display of all the digits. 
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• Individual User’s Preferences 

The product configuration files (*.cfg, for instance CAMMaster.cfg) are now stored in a different directory 

to facilitate per user configurations. They used to be stored in “Windows directory” (normally C:\Win-

dows). Now, if the environment variable “HOMEPATH” is defined, that directory will be used instead. 

This variable is automatically set in certain versions of Windows, such as XP, but can be set by the user 

otherwise. 

If you want to preserve you’re your old settings, please move the .cfg file to the HOMEPATH directory. 

To determine the setting of HOMEPATH or to set it to a different directory, use “set” from the command 

prompt.  

• Move to Cursor has Independent Relative/Absolute Mode 

In the “Move Cursor To” dialog, the type of move (Absolute, Relative, Incremental) is now set separately 

depending on the coordinate display mode (Absolute, Relative), that is once set in Absolute display mode 

it will stay the same even if changed while the display mode is Relative. The two settings will be remem-

bered independently. 

• Report Files List Both Import and Export Formats 

The report file will now separately list the Gerber import and export formats, as well as the Drill import 

and export formats. Previously only the import formats were reported.  

• Custom Apertures with Polygons 

“Setup/D Codes” (F5): “Custom Apertures/Replace With Primitives”: primitives that are polygons will 

now generate polygons rather than F-type outlines.  

• A.O.I. Export 

A.O.I. International and Lloyd Doyle netlist export is now standard in CAMMaster. 

8.0.X 

• Contour DRC now Available: 

(Tools/Design Rules Check/Run Contour DRC). This method has the advantage over Raster DRC that it is 

accurate and resolution independent. 

• Import Gerber via File/Open: 

One can now import Gerber files using the File/Open dialog. This has the additional benefit that one can 

associate a common Gerber file extension (such as .ger) with these executables, so that double-clicking on 

that file would launch the executable. The .bin extension is automatically associated with the PentaLogix 

CAM products (excluding ViewMate).   

To create the association: right click on the desired file and select “Open With”, then choose the executa-

ble.   One more step is needed to make sure that path names that have spaces in them are handled cor-

rectly.  Open Explorer, then “View/Folder Options/File Types”.   

Pick the type you just added and click on Edit, then “open”, “Edit”. In the "Application used to perform 

action", add “%1” after the name of the executable. The double quotes around %1 are needed to make 

sure that the entire path name is passed to the executable.  

• “File/Import Enhancements” (Gerber) 

 Mirror Image: 

Support for “MI” (mirror image) RS-274X parameter. 

 Padstacking: 

A new option in “Options/File Interpretation”. “Consecutive flashes at same position”. This has 

two options: “Keep only one” and “Keep all”. The previous versions would always “Keep only 

one”, but apparently some users need these padstacks preserved. 
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• Drill Import Options 

“Setup/Layers” (F10): added a button to bring up the drill import options.  

• Messages Mode – Background 

“Setup/Messages Mode”: new state added “Background”. This is the “quietest” one (more so than 

“Batch”). When in this mode, error messages will be displayed in the status line rather than via a dialog 

box and as such will require less user interaction. Also the graphics view is not refreshed in this mode, 

layers toolbars are not updated etc.  This is only useful for CAMMaster scripting. 

• Goto Favorite Position 

 “Go/Favorite Positions”: a quick way to go to a favorite (X, Y, Zoom) triplet that one can previously rec-

ord.  

• Gerber IPNEG Followed by IPD or IPC 

For both import and export of Gerber Extended files: a new option in the “RS274-X Options” tab. The op-

tion is “Negative layer is IPNEG followed by:” and the two possibilities are “LPD” and “LPC”. It appears 

that various plotters and CAM packages expect different commands to render a negative layer: either 

“IPNEG” followed by “IPD” or “IPNEG” followed by “IPC”. As usual, the Gerber manual is no help, as it 

does not elaborate as to what the correct combination should be, so we decided to let the user pick one or 

the other (separate for import and for export). Previously “IPNEG” followed by “IPD” was the only inter-

pretation.  

• MDA Output – Unique Layer Names 

“File/Export/MDA Autoplot/Options/MDA Options”: a new check-box called “Force unique layer 

names”. This is only relevant when “Merge paint and scratch “ is also checked and will append 

“.L<layer_number>” to each layer name to insure that the individual files generated have distinct names.  

• Select Invalid Polygons 

A new selection criterion in the “Special selection” droplist called “Invalid Polygons”. This will select pol-

ygons that are invalid as far as the PentaLogix CAM software is concerned (for instance self-intersecting 

polygons are invalid). The intention is to replace this command in the future with one that can “fix” the 

invalid polygons. 

• Handling of negative and scratch layers 

Layers that were set as both negative and scratch (NS) were handled differently in the contour methods 

versus the raster methods. A unified way of handling them has been implemented following the rules 

below: 

 A scratch layer cannot be the first layer in a board layer.  

Such a situation will be flagged as an error during processing of connectivity information. We 

have sometimes seen the first layer set to both negative and scratch. If the user’s intention was to 

have it as a paint layer then both the scratch and negative settings should be removed. If the 

user’s intention was to have it as negative, then the scratch setting should be removed. 

 If an NS layer follows a negative layer  

(N = Negative set, but not Scratch), then the NS elements will be scratched from the N elements 

and then the whole image will be inverted (to make it negative) 

 If an NS layer follows a non-negative layer 

(P=Negative not set), then the NS layer will be first inverted (to make it Negative) and then the 

result will scratch P. This will make an NS following a P act as scratching everything except 

where there are elements of NS.   

This will affect Raster and Contour netlist as well as Raster and Contour DRC as well as AOI 

tools.  
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• Layers Toolbar is Longer 

The layers toolbar is now longer.  

• Floating License Manager 

The floating license manager now correctly administers number of seats allowed. 

• Loading 10,000 D-Codes 

All possible D Codes (10000) can be loaded at the same time (previously there was a limit of 2000 simulta-

neously loaded D Codes).  

• 255 Layers 

The number of layers has been increased from 99 to 255.  

• Save in High Resolution 

“File/Save Options/High Resolution” is now set by default. Previously the setting was remembered be-

tween software activations.  

• Faster Contour Netlist Extraction 

This was done by algorithmic improvements as well as special handling for crosshatched plane layers 

(these used to take very long to process in previous versions). To take advantage of this new feature, the 

user needs to mark layers that have crosshatch plane patterns as “Fill” (check-mark present) in the 

“Setup/Layers” (F10) dialog.  

• Negative and Scratch Rendering 

The rendering (display on screen) of negative and scratch layers has been improved. For the case of nega-

tive layers: when more than one negative layer existed the rendering was sometimes incorrect in the past, 

since it did just one negative operation on the merged negative layers.  For scratch layers: they will auto-

matically be displayed in the color of the immediately preceding paint layer, so that manually setting the 

layer color to match is no longer necessary.  

• License String Improved 

License string installation is now done with an external executable (InstLicense.exe) and the pesky 

“0001.tmp” files are deleted when application closes.  

• G75 and G74 Gerber Export 

When exporting Gerber files, G75 or G74 is output only once per layer.  

•  “File/Import”: 

 “HPGL”:  

“PG” command (“Advance Full Page”) will cause step to next layer. Previously it was ignored.  

 Excellon: 

For Excellon drill files; user overridden format settings (m.n, metric, English, etc) will be 

preserved. Previously they reverted to the settings in the drill file itself.  

 ODB++ 

File import of ODB++ is now supported.  

• Distant Measurement Handles All Types 

“View/Distance/From Edge”: distance measurement tool from edges of elements now handles all element 

types. Previously it only handled linear traces and certain pads (of simple shapes).  
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• Sum of all trace lengths 

“View/Selection/Properties”: a new item has been added – “Sum of all trace lengths”. This will appear 

when traces are part of the selection. When nets are made of chains of head-to-head traces, this will also 

be a good approximation for the length of the part of the net that is selected.  

• “Setup/Layers” (F10):  

 Paths: The “Path” button has been expanded to give a choice of 3 operations: 

- Strip path  

- Make relative to current directory 

- Fill in full path.  

• Viewing Text Files 

The application used to view text files (such as by File/Report/View) used to be “notepad.exe”. It has now 

been changed to use any application that the user registered for opening a “Text Document” (.txt exten-

sion). This is usually done with “Explorer/View/Folder Options/File Types”. 
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Bugs Fixed 

11.22.23 

• Incorrect rendering of small polygons at certain zoom levels 

11.22.21 

• Convert Layer to Positive 

Used the frame instead of board outline layer. 

11.22.16 

• Import ODB++ 

s_ths iimport problem. 

• Polygon Merging 

Took a long time when scratch polygons involved. 

11.22.12 

• Component Layers 

Some mirrored and rotated components were displayed incorrectly. 

• Gerber Export or Rotated Rectangles 

Rotation was lost in certain cases. 

11.22.10 

• Stencil Homebase 

The facing out option was ignored. 

11.22.2 

• D Code mirror 

Failed on rotated D Codes. 

11.20.25 

• Gerber X2 import 

TO and TD directives misinterpreted. 

11.20.22 

• Import > Directory 

Failed on certain data 
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11.20.19 

• Bug in Paint and Scratch > Optimize 

• DFM > Feature Size Violations 

Some bugs fixed. 

11.20.16 

• Import ODB++ 

Some step-and-repeated ODB files were imported incorrectly. 

11.20.12 

• Tools > Stencil Apertures 

V Homebase did not work. 

11.20.11 

• Feature Size Violations 

Reported incorrect results. 

11.20.10 

• Import DXF 

Some arc edges were imported as straight. 

11.20.7 

• Import ODB 

Some component files were imported incorrectly. 

• Stencil Homebase 

Generated incorrectly oriented parts. 

11.20.4 

• Netlist Extract and Plated Slots 

Plated slots now add connectivity info. They were previously ignored. 

• Import ODB 

Some component files were imported incorrectly. 

11.20.2 

• Bugs in Import IPC-2581 fixed 

11.18.52 

• Stencil Apertures 

Custom apertures from model files were processed incorrectly.. 
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11.18.51 

• Stencil Windows 

Some irregular shapes were processed incorrectly. 

• Import Gerber X2 

Component and net info was imported incorrectly. 

• View > Selection > D Codes 

Only one D Code of the same size was shown. Same for View > Selection > Tool Codes 

11.18.46 

• Import DXF 

Some files with splines were imported incorrectly. 

• Rout Path Compensation 

Connector arcs checkbox ignored for certain closed paths. 

11.18.40 

• Move (Shift+M) Reference Frame Disappears When Zooming 

11.18.37 

• Setting Max Undo Memory 

11.18.36 

• Swell Polygon Bug Fixed 

11.18.33 

• Fix ODB++ import bug 

• ActiveX GetSelectionDCodes Did Not Work 

11.18.31 

• Fix ODB++ import bug 

11.18.28 

• Routing Path “Break Tabs” 

Sometime generated incorrect results. 

• Trace Stretching 

Some trace editing command generated incorrect results.. 
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11.18.26 

• Routing Path “Ungroup To Traces” 

Caused a crash. 

11.18.22 

• ODB Import 

Component information was sometimes imported incorrectly. 

Octagon shapes were rendered incorrectly 

• Stencil/Windows 

Caused a crash 

11.18.19 

• Fixed ODB Import Crash and Bugs 

11.18.10 

• Fixed ODB Import Bug 

11.18.7 

• Pocket Routing 

Outline was not routed in certain cases. 

11.18.3 

• Some Gerber X2 Layer Types were Misinterpreted 

Copper layers. 

11.16.78 

• Netlist Computation 

Export of phase nets was incorrect. 

11.16.73 

• Transcoding Tool Sizes by Dimension 

Generated incorrect results. 

11.16.66 

• Expand Closed Trace Contour 

Did not allow for negative values, so contract was not possible. 

11.16.64 

• Mirror Thermals 

Some thermals were mirrored incorrectly. 
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11.16.63 

• Script Recording 

The “ExportFiles” parameter was not recorded when” Macro/Record” was turned on 

11.16.62 

• Polygon merging failed on certain data 

11.16.61 

• ODB export failed on certain large files 

11.16.60 

• Some rotation operations generated incorrect results 

• F to Poly failed on certain data 

11.16.58 

• Restored Windows 7 Compatibility 

11.16.56 

• Export Gerber 

Custom apertures that contained arcs were approximated incorrectly (too coarse). 

• Convert Units from metric to inch 

Very short arcs were converted to full circles. 

11.16.54 

• Import ODB++ 

Tool sizes were sometimes imported incorrectly on step and repeat steps. 

11.16.53 

• Import ODB++ 

Some polygons were imported incorrectly. 

• Custom DFM / Find Minimum Feature Size 

Sometime computed incorrect results. 

11.16.46 

• Guess 

File/Import/Guess on “tar” files caused a crash. 

• Polygon Merging Bug Fixed 
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Scripting 

11.22.23 

LayerOr, LayersAnd, LayersMinus 

11.22.12 

DcodeShapeAndAngle 

11.22.1 

GetLayerElementCountsEx 

GetLayersWithData 

RestoreParametersFromFile 

11.18.46 

GetSelectedElementsCenters 

11.18.44 

ImportDXFUnits 

11.16.34 

NanometerResolution 

OffsetSelectedPolygons 

MirrorSelectedEx 

RotateSelectedEx 

11.16.12 

ImportGDS_TXT 

ExportGDS_TXT 

DisableApplication 

CombineShortStraights 

11.16.7 

SelectEx 

11.14.59 

Undo 

11.14.35 

SetLayerColorsFromLayerType 

LoadLayerTypeToColorMap 

CreatePackageFromCAMData 

CreateCAMDataForPackage 

ImportPackages 

ExportPackagesPentalogix 

ExportPackagesODB 

ImportComponents 

ExportComponents 
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11.14.10 

PrintToSVG 

11.12.54 

About 

11.12.9 

ConvertPadsToHoles 

SortDrillHoles 

11.10.79 

SmallestCoveringRectangle 

11.10.69 

SplitSelectedRoutingPathAtLength 

11.10.44 

AlignToActiveElement 

11.10.43 

InsertThreePointArc 

PolySkeletonBrushWidth 

PolySkeletonMethod 

11.10.40 

BreakIntersectingTraces 

PolygonsToSkeleton 

SelectChainEx 

SelectedRoutPathLength 

11.10.21 

SetRoutPlungeClosestToPoint 

11.8.24 

ViewCenter 

DFM_Drill 

11.8.1 

ImportDXFOverrideUnits 

SelectionDisplayMode 

11.6.35 

SelectTouching 

11.6.26 

AreaAndCircumferenceOfSelection 

StencilDCodeNumber 

StencilComponent 
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11.6.18 

StencilWindows 

StencilHomebase 

StencilInvertedHomebase 

StencilFromModel 

GetWindowHandle 

11.4.0 

LastItemCount 

11.2.58 

CombineLayersByBoardNumber 

TransferLoadedLayersRange 

11.2.47 

RoutingUngroupToTracesEx 

11.2.35 

ClipToPoly 

11.2.22 

SelectClosestEx 

11.0.80 

BoardRoutIsOK 

CancelUserOperation 

CSVSeparator 

GetInfoForSelectedPolygons 

GetSelectionToolNumbers 

RoutingAutoLead 

RoutingSort 

SelectElementsOfToolNumber 

SetFocus 

11.0.74 

RoutingChamferRadius 

RoutingChamfers 

11.0.71 

• New: 

 CenterSelectedToFrame 

 InsertFrameSizedContour 

 InsertFrameSizedPolygon 

 MToCSelected 

11.0.42: 

• New: 

 ImportGuessEx 
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 IsBusy 

11.0.9: 

• New: 

 ExportRoutOptions 

11.0.1: 

• New: 

 AutoAlignDrillLayer 

 ExportGBXOptions 

 SelectIntersectingTraces 

10.6.50: 

• New: 

 IntersectLayers 

10.6.34: 

• New: 

 DeleteDCodesIfUnused 

10.6.0: 

• New: 

 Color 

 ColorsSetup 

 CompactLayers 

 SetupLayerColorDialog 

 WellFormedMethod 

10.4.30: 

• New: 

 DrillPathLengthInLayer 

 SaveJobData 

 ToolCount 

10.2.45: 

• New: 

 ConvertNegativeToPositive 

 DFM_FindMinimumSpacing 

 DFM_FindMinimumWidth 

 DFM_SpacingViolations 

 DFM_WidthViolations 

 GetCopperAreaValues 

 RoundDCodeSizes 
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10.2.18: 

• Changed: 

 FtoPolygons 

10.2.0: 

• New: 

 ImportGuess 

 GetLockingCode 

 GetStepAndRepeatIDs 

 LayersForInsert 

 SelectionCrossing 

 SelectStepAndRepeat 

• Changed: 

 PentaLogix geometry files are now at version V2. The only change is that the arc representation 

includes the center of the arc also (as an information only item, since the arc is uniquely 

determined by the other three points given). So the syntax for an arc is now: 

P1, P2, P3, (Center) 

Where P1 and P3 are the arc extremes, P2 is a point on the arc (preferably the midpoint) and 

Center is the center of the arc (for information only). 

10.0.10: 

• New: 

 ToolNumbersTranscode 

10.0.0: 

• Changed: 

 FToPolygons 

 SelectByIntersection 

• New: 

 ClipSilkscreen 

9.8.70: 

• New: 

 GetLayerDimensionsEx 

9.8.50: 

• Changed: 

 ImportZeroLengthDraw:  new possible value “Ask”. The two previous values “Pads” and 

“Ignore” are still valid. 

• New: 

 PolarityCombineAtLayer 

 PolaritySeparateLayer 
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9.8.20: 

• Bugs fixed: 

 GetSelectionTools: did not correctly interpret the tool type argument. 

• New: 

 SaveCompareLayersErrors 

9.8.5: 

• New: 

 AlignToEndpointsOnly 

 BuildCustomFromFrame 

 RoutingArcsToChords 

 RoutingChordsToArcs 

9.8.0: 

• New: 

 GetDCodeElementCounts 

 InsertAsPaint 

 PolygonsToStrips 

 RoutingConnectorArcs 

9.6.91: 

• New: 

 ExePathName 

9.6.43: 

• New: 

 OptimizePaintScratch 

9.6: 

• Changed: 

 .ImportAMRotation 

A new item has been added to this property  (in addition to “CW” or “CCW”). The new item can 

take one of three values: “Primitive”, “Aperture” or “Automatic”. These set the option found in 

“File/Import/Gerber/Options/RS274-X Options/Rotate around”. The “Automatic” setting is 

recommended. Existing scripts should not be affected by this change. 

• New: 

 .SelectCoveredElements 

 .SelectDuplicateElements 

Scripting 9.4.73: 

• Changed: 

 ImportZip 
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Scripting 9.4.6-65: 

• Changed: 

 CalculateCopperArea 

• New: 

 CAMTEKINI 

 CAMTEKParameters 

 CAMTEKWriteReference 

 CompareTwoLayersEx 

 DragFrame 

 DrillImportOptions 

 ImportDiscardPaths 

 LastWarningNumber 

 Marker 

 OnDone 

Scripting 9.4.1: 

• Changed: 

 Import and Export. 

A new file type has been added: “PentaLogix”. This is a new ASCII format for transfer of 

geometrical information about elements in the database. The new format is described in 

Appendix A of the “CAM_ActiveX” manual. 

• New: 

 CreateRaster 

 CursorRelative 

 PolaritySeparateAfterImport 

 SelectClosestAndInfo 

 SelectLayers 

 ToolNumbersTranscodeAscending 

Scripting 9.2: 

• New 9.2.41: 

 GetProcessID 

 MergeColinearTraces 

 RoutingGroupToPaths 

 RoutingUngroupToTraces 

 SelectedRoutingPaths 

• New 9.2.27: 

 GetLayerPolarityChanges 

 PolarityCombineAll 

 PolaritySeparateAll 

• New 9.2: 

 ReplaceSelectedPolygonsWithOverlaps 

 SelectUnusedPads 

 ConvertSelectionToPolygons 
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 ReorderLayers 

Scripting 9.0.50: 

• New: 

 SelectedArcsToQuadrants 

 SetupDCodesDialog 

 Changed: 

 SetSaveOptions 

Scripting 9.0: 

 A new way to load and run a script file when starting CAMMaster has been added: 
CAMMaster /run <name of script file> 

where “<name of script file>” is the path of the script that you want loaded and executed. If 

“/run” is omitted, the script file will be loaded but not executed. 

• New: 

 CopperAreaOfSelection 

 CurrentCustomProperty 

 CustomProperties 

 CustomProperty 

 FrameVisible 

 OnlyCurrentCustomProperty 

 SelectArc 

 SelectTrace 

• Changed: 

 GenerateOutlines: now generates polygons rather than F-type trace contours. 

 StepAndRepeatUngroup returns TRUE or FALSE depending on the outcome of the operation. 

Scripting 8.4.10 

• New: 

 ZoomShowAll_Include0 

Scripting 8.4 

• New: 

 AddSnowmanFilleting 

 AddTeardropFilleting 

 ChordsToArcs 

 ClipSilkscreenTraces 

 DisplayFilledElements 

 DRCErrorsFile 

 DRCMaskToMask 

 FillSolid 

 GerberOutputSplitPolygons 

 PointIsInsideSelection 

 SelectedText 

 UngroupSelectedText 
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Scripting 8.2.21 

• New: 

 AutoSnapToElement 

 CompareTwoLayers 

 ConvertDrawnPads 

 ConvertStandaloneDrawnPads 

 MakeSelectedPolygonsWellFormed 

 SelectByIntersection 

 SnapTolerance 

 StatusLineMessage 

Scripting 8.1 

• New: 

 ImportMoveArcCenter 

 NetCompare 

 PrintToBMPFile 

 REFStartLayer 

• Modified: 

 GetLayerElementCount: added count of polygons at end of string 

Scripting 8.0.X 

• New: 

 HighestPossibleLayerNumber. For this version it will return 255 

 ImportKeepAllFlashes 

• Bugs: 

 The Swell Selected method appeared as SwellSelection in the type library. Also it did not work for 

negative swell values. 
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Release History 
NOTE: Not all released versions are listed below 

 

Version Release Date 

11.22.1 Jan 26, 2023 

11.20.1 Nov 10, 2021 

11.18.1 Sep 17, 2020 

11.16.53 Mar 28, 2020 

11.16.1 Jun 10, 2019 

11.14.59 May 10, 2019 

11.14.1 Jun 6, 2018 

11.12.52 Feb 6, 2018 

11.12.1 Dec 14, 2016 

11.10.80 Nov 15, 2016 

11.10.9 Sep 29, 2015 

11.8.24 Aug 12, 2015 

11.8.1 Feb 11, 2015 

11.6.26 Jun 21, 2014 

11.6.0 Aug 14, 2013 

11.4.45 Jun 24, 2013 

11.4.0 Feb 14, 2012 

11.2.78 Nov 30, 2011 

11.2.74 Sep 19, 2011 

11.2.22 Nov 17, 2010 

11.2.1 Sep 10, 2010 

11.0.80 Aug 1, 2010 

11.0.1 Dec 10, 2009 

10.6.71 Sep 28, 2009 

10.6.0 Apr 28. 2009 

10.4.32 Mar 17, 2009 
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10.4.0 Jan 24, 2009 

10.2.71 Jan 10, 2009 

10.2.0 Oct 3, 2008 

10.0.30 May 30, 2008 

10.0.1 Mar 17, 2008 

9.8.70 Dec 31, 2007 

9.8.0 Sep 10, 2007 

9.6.91 May 31, 2007 

9.6 Jan 2, 2007 

9.4.1 Mar 3, 2006 

9.2.41 Jun 30, 2005 

9.2 Apr 5, 2005 

9.0 Aug 5, 2004 

8.4.50 Dec 17, 2003 

8.4 Oct 27, 2003 

8.2.5 Feb 26, 2003 

8.1 Oct 23, 2002 
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